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重要安全資訊

本手冊包含使用者必須遵循的資訊和警告，以確保操作安全並使產品保持在安全狀態。

為安全維修本產品，請參閱＜一般安全摘要＞之後的＜維修安全摘要＞。

一般安全摘要
請僅依照指示使用此產品。請檢視下列的安全警告以避免傷害，並預防對此產品或任何相連接的產品造成損
害。請仔細閱讀所有指示。請保留這些指示以供日後參考。

必須根據地方和國家準則使用此產品。

為正確及安全地操作產品，除本手冊中所指定的安全警告外，請務必依照一般可接受的安全程序進行操作。

本產品設計僅供經過訓練的人員使用。

僅有經過訓練並瞭解所涉及危險的合格人員，才能移除機蓋進行修復、維修和調整作業。

使用之前，請務必連接已知電源檢查產品，以確保機器能正確運作。

本產品不適用於偵測危險電壓。

請使用個人防護設備，以避免當危險的導體露出時受到電擊和電弧爆破的傷害。

使用此產品時，您可能需要操作較大系統的其他部分。請閱讀其他元件手冊的安全章節，了解操作系統的相
關警告與注意事項。

當本設備與系統結合使用時，系統安全由該系統的組裝人員負責。

避免火源或身體傷害

使用適當的電源線。 僅可使用本產品所指定以及該國使用認可的電源線。請勿使用其他產品所提供的電源
線。

將產品接地。 本產品是透過電源線的接地引線與地面連接。為了避免電擊，接地引線必須連接到地面。在與
產品的輸入與輸出端子連接之前，請確定產品已正確地接地。請勿中斷電源線接地的連接。

電源中斷連接。 電源線中斷電源與產品的連接。請參閱指示以確定位置。請勿將設備放置在不便操作電源
線的位置；電源線必須隨時維持於可存取狀態，以便於必要時能夠快速中斷電源。

正確地連接與中斷連接。 當探棒或測試線與電壓來源連接時，請勿連接它們或中斷與它們的連接。務必使用
產品提供或 Tektronix 表示適用於產品的絕緣電壓探棒、測試線與轉接器。

觀察所有的端子功率。 為了避免火災或是電擊的危險，請注意產品上的功率及標記。在與產品連接之前，請
先參閱產品手冊以便進一步瞭解有關功率的資訊。

請勿將電壓加至任何端子，包括共同端子，這會超過端子的最大功率。

本產品上的量測端子不可用於連接至主要或類別 II、III 或 IV 電路。

請勿在機蓋未蓋上之前即進行操作。 當機蓋或面板被取下或機殼打開時，請勿操作本產品。否則可能會發生
危險電壓外洩。

避免電路外露。 當有電流通過時，請勿碰觸外露的連接器及元件。

懷疑有故障時，請勿操作。 若您懷疑此產品已遭損壞，請讓合格的服務人員進行檢查。

請停用已損壞的產品。請勿使用已損壞或未正確操作的產品。如果對產品的安全有疑慮，請關閉機器並請拔
掉電源線。清楚標示產品以避免進一步操作。
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使用前，請檢查電壓探棒、測試線和配件是否有機械性損壞，並在損壞時更換。如果探棒或測試線已損壞，
或是有金屬外露或指示器磨損的情形，則請勿使用。

在使用產品之前，請仔細檢查產品外部。查看是否有缺少零件的情況。

請務必使用指定的替換零件。

請勿在潮濕的狀態下操作。 如果將裝置自寒冷的環境移至溫熱的環境，可能會發生水氣凝結的情況。

請勿在易燃易爆的空氣中操作。

請維持產品表面的清潔與乾燥。 清理產品前請先移除輸入訊號。

保持空氣流通。 請參考手冊中的安裝說明以瞭解有關如何安裝產品並保持良好通風的詳細資訊。

產品上的插槽和開口是做為通風之用，請勿將其覆蓋以免阻礙通風。請勿將物件推入任何開口中。

請提供安全的工作環境。 請隨時將產品置於方便檢視顯示器及指示器的位置。

請避免不當或長時間使用鍵盤、雷射筆及按鈕盤。不當或長時間使用鍵盤或雷射筆，可能會導致嚴重的傷
害。

請確定工作區符合適用的人體工程學標準。請詢問人體工程學專家以避免壓力傷害。

當抬起及攜帶產品時，請謹慎小心。本產品提供提把以便於抬起及攜帶。

警告。 本產品頗具重量。為了降低身體傷害或裝置受損的風險，當抬舉或攜帶產品時，請尋求協助。

請務必只用本產品所指定的 Tektronix 框架硬體。

維修安全摘要
＜維修安全摘要＞一節中含有安全維修產品所需的其他資訊。只有合格的服務人員方可執行維修程序。在
執行任何維修程序之前，請詳細閱讀＜維修安全摘要＞和＜一般安全摘要＞章節。

避免電擊。 請勿觸摸暴露在外的接線。

請勿獨自進行維修。 除非有另一名能夠進行急救及復甦術的人員在場，否則請勿進行本產品的內部維修或調
整。

中斷電源連接。 為避免遭受電擊，在卸下任何機蓋或面板、或開啟機殼進行維修之前，請先關閉產品電源，
並將電源線從主電源拔下。

若要在開啟電源的情況下進行維修，請特別小心。 本產品可能存在危險電壓或電流。在移除保護面板、進行
焊接或更換元件時，請中斷電源、卸下電池 (如果可以的話) 並中斷測試線的連接。

維修後請確認安全。 維修後，請務必重新檢查接地線的連續性以及主機的絕緣強度。
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手冊中的術語

本手冊可能會出現下列術語：

警告。 警告聲明中指明了可能導致受傷或喪命的情況或操作。

小心。 小心聲明中指明了可導致損壞此產品或其他物品的情況或操作。

產品上的術語

產品上可能會出現下列術語：

■ 「DANGER」(危險) 表示當您看到此標誌時可能會有立即受傷的危險。

■ 「WARNING」(警告) 表示當您看到此標誌時並不會有立即受傷的危險。

■ 「CAUTION」(小心) 表示可能損及財產 (包括本產品) 的危險。

產品上的符號

當產品上出現此符號標示時，請務必查閱手冊以找出潛在危險的性質，以及避免發生危險應採取
的行動。(本手冊中也會使用此符號指引使用者參考功率資訊。)

下列符號可能會出現在產品上：

                 

 重要安全資訊
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相容資訊

本節將列出儀器所依循的 EMC (電磁合規)、安全和環境標準。

EMC 合規

EC 符合性聲明 - EMC
符合電磁相容性指示 2014/30/EU 目標。經證實符合歐盟官方期刊所列出之如下規格：

EN 61326-1、EN 61326-2-1. 量測、控制和實驗室使用之電子設備必須遵守的 EMC 需求。  1 2 3 4

■ CISPR 11。輻射和傳導放射，群組 1、等級 A

■ IEC 61000-4-2。靜電釋放耐受性

■ IEC 61000-4-3。抗射頻電磁場  5

■ IEC 61000-4-4。電磁快速暫態/突波耐受性

■ IEC 61000-4-5。電源線突增耐受性

■ IEC 61000-4-6。傳導射頻耐受性 5

■ IEC 61000-4-11。抗電壓驟降和干擾耐受性

EN 61000-3-2. 交流電源線諧波發射

EN 61000-3-3. 電壓變化、波動和閃爍

澳洲 / 紐西蘭符合性聲明 – EMC
本儀器符合「無線電通訊法」中訂定 EMC 條款的下列標準，並符合 ACMA：

■ EN 61326-1 和 EN 61326-2-1。輻射和傳導放射，群組 1、等級 A。

1 本產品僅適用於非住宅區。用於住宅區可能會造成電磁干擾。
2 當本儀器連接測試物品時，發射層級可能會超過這項標準要求。
3 在進行內部連接時，您必須使用高品質的低 EMI 遮罩纜線。
4 因導線/探棒上的電磁干擾耦合而連接這些測試線和/或測試探棒時，該設備可能不符合此標準的耐受性需求。 若要讓電磁干擾的影響降到最

低，請盡量減少訊號無遮罩部分和相關回流線之間的迴路區域，並讓導線盡量遠離電磁干擾源。 將無遮罩測試線扭轉在一起可有效減少迴路
區域。 對於探棒，請盡量縮短接地回流線並接近探棒主體。 某些探棒具有配件探棒頭轉接器，可最有效地完成此作業。 在所有情況下，請留
意所用探棒或導線的所有安全指示。

5 當示波器位於連續呈現的電磁現象時適用的性能準則：10 mV/格至 1 V/格： ≤0.4 格波形位移，或峰對峰雜訊增加 ≤0.8 格。
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安全符合性
本節將列出產品所依循的安全標準及其他安全符合性資訊。

歐盟符合性聲明 - 低電壓

經證實符合歐盟官方期刊所列出之如下規格：

低壓指示 2014/35/EU。

■ EN 61010-1。 量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般需求。

美國國家認可測試實驗室清單

■ UL 61010-1。 量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般需求。

加拿大檢定證明

■ CAN/CSA-C22.2 No. 61010-1。 量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般
需求。

其他合規

■ IEC 61010-1。 量測、控制和實驗室使用之電子設備必須遵守的安全需求 – 第一部分：一般需求。

設備類型

測試和量測設備。

安全等級

等級 1 – 接地性產品。

污染等級說明

針對周圍環境和產品內部所進行的污染量測。通常產品內部環境會視為相同於其外部環境。本產品只適用
於已評估的環境。

■ 污染等級 1。不會產生污染，或只會產生乾燥而非傳導式的污染物。這項種類的產品通常會加以密封、
氣密封存或是放置在無塵室中。

■ 污染等級 2。通常只會產生乾燥而非傳導式的污染物。必須預防因凝結所發生的暫時傳導性。這種場所
通常是辦公室/居家環境。暫時性凝結只會在產品不使用時發生。

■ 污染等級 3。傳導式污染，或是由於凝結導致乾燥、非傳導式污染成為傳導式污染。這是指沒有控制溫
度或溼度的遮蔽場所。該區域可避免陽光直曬、雨水或是直接風吹。

■ 污染等級 4。指透過傳導性灰塵、雨水或雪產生永久傳導性的污染。一般戶外場所。

污染等級

污染等級 2 (依據 IEC 61010-1 定義)。附註：評估僅限用於室內、乾燥環境。

相容資訊  
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IP 級別

IP20 (依照 IEC 60529 所定義)。

量測及過電壓類別說明

您可以根據下列一或多個類別來評估本產品量測端子的主電壓 (請參閱產品上或手冊中所標示的特定功率)。

■ 量測類別 II：量測直接連接低電壓安裝的電路。

■ 量測類別 III：在建築安裝時執行量測。

■ 量測類別 IV：量測低電壓安裝來源。

NOTE. 僅主電源供應電路適用過電壓類別級別。僅量測電路適用量測類別級別。產品中的其他電路不適用上
述兩種級別。

主電源過電壓類別級別

過電壓類別 II (依據 IEC 61010-1 定義)

環境相容性
本節提供此產品對環境所造成的影響之相關資訊。

產品報廢處理

回收儀器或元件時，請參閱下列指引：

設備回收. 本設備的生產作業需要自然資源之回收與利用。本設備在產品報廢階段若未正確處理，可能會產
生對環境或人類健康有害的物質。為了避免此類物質釋放到環境，並減少使用自然資源，建議您透過適當系
統回收此產品，以確保大部分的材料均適當地回收或再利用。

依照歐盟廢棄電子電器設備 (WEEE) 和電池指令要點指示 2012/19/EU 和 2006/66/EC，此符號表示
此產品遵守歐盟要求。如需回收選項的詳細資訊，請參閱 Tektronix 網站 (www.tek.com/
productrecycling)。

高氯酸鹽材料. 此產品包含一或多種 CR 鋰電池類型。根據加州法律，CR 鋰電池被歸類為高氯酸鹽材料，必
須採取特殊處理。請參閱 www.dtsc.ca.gov/hazardouswaste/perchlorate 取得其他資訊。

 相容資訊
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前言
本手冊說明 DPO70000SX 系列儀器的安裝和基本操作方式。如需其他操作資訊，請參閱儀器上的儀器說明。
本文件支援以下儀器：

■ DPO77002SX
■ DPO75902SX
■ DPO75002SX
■ DPO73304SX
■ DPO72304SX
■ DPO71604SX
■ DPO71304SX

主要功能
DPO70000SX 系列儀器有助您確認、偵錯和辨識電子設計。主要功能包括：

■ 1 個類比通道的機型為 70 GHz 頻寬與 200 GS/s，2 個類比通道的機型為 33 GHz 頻寬與 100 GS/s
(DPO77002SX)

■ 1 個類比通道的機型為 59 GHz 頻寬與 200 GS/s，2 個類比通道的機型為 33 GHz 頻寬與 100 GS/s
(DPO75902SX)

■ 1 個類比通道的機型為 50 GHz 頻寬與 200 GS/s，2 個類比通道的機型為 33 GHz 頻寬與 100 GS/s
(DPO75002SX)

■ 2 個類比通道的機型為 33 GHz 頻寬與 100 GS/s，4 個類比通道的機型為 50 GS/s (DPO73304SX)

■ 2 個類比通道的機型為 23 GHz 頻寬與 100 GS/s，4 個類比通道的機型為 50 GS/s (DPO72304SX)

■ 2 個類比通道的機型為 16 GHz 頻寬與 100 GS/s，4 個類比通道的機型為 50 GS/s (DPO71604SX)

■ 2 個類比通道的機型為 13 GHz 頻寬與 100 GS/s，4 個類比通道的機型為 50 GS/s (DPO71304SX)

■ 當「加強型頻寬」功能啟用時，便可套用擴充頻寬和拉平帶通頻率的「數位訊號處理 (DSP)」濾波功能。
「加強型頻寬」在波道達到最大取樣率時，經由已啟用的波道提供配比響應。您可以將最大頻寛限制在

500 MHz，讓雜訊比例下的訊號達到最佳化。加強型頻寬延伸至某些高效能探棒和頭的探棒頭。

■ 記錄長度最多可達 10 億個取樣，視不同機型和選配儀器而定

■ 最高可達 1.0% 直流垂直增益精確度，視機型而定

■ 使用 UltraSync™ 介面組合多達 4 部儀器以搭配增加的通道計數。

■ 在可選外部監視器上顯示使用者介面

■ 多達 4 個類比輸入通道，視機型而定 (不使用高解析度模式時，每個通道具有 8 位元解析度)、輔助觸發
輸入和輸出

■ 具有各種指令集和訊息介面的完整可程式化能力

■ 具有靈活 A 和 B 觸發事件的 PinPoint 觸發

■ 邊緣觸發 >20 GHz，輔助觸發 > 10 GHz。

■ 可選擇的「觸發位置更正」可以更精確地放置觸發並減少抖動

■ 功能強大的內建量測能力，包括有長條圖、自動量測、眼狀圖量測和量測統計值
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■ 採用算術方式來組合波形，建立支援資料分析工作的波形。在數學方程式中使用任意濾波器。使用頻譜
分析來分析頻域中的波形。

■ 可從水平刻度，分別控制取樣率和記錄長度

■ 直觀的圖形使用者介面 (UI)，其中內建了可顯示於螢幕的線上說明

■ 內部可移除式儲存磁碟

說明文件
重新檢視下列表格，找出更多有關此產品的資訊。

相關主題 說明文件

安裝和操作 (概要) 使用者手冊。使用者手冊。

操作和使用者介面 「說明」功能表中的儀器說明。

程式設計師指令 程式設計師手冊。本手冊可以自 Tektronix 網站中取得
(www.tektronix.com/manuals)。

本手冊使用慣例
本手冊使用以下圖示。

步驟 前面板電源 連接電源 網路 PS-2 SVGA USB

前言  
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安裝儀器
請拆封儀器，並檢查您已收到所有列於「標準配件」的項目。線上說明會列出建議的配件、探棒、儀器選配
項目和升級。 如需最新資訊，請參閱 Tektronix 網站 (www.tektronix.com)。

標準配件

配件 Tektronix 零件編號

使用者手冊 -- 視語言選擇而定 071-3357-xx
前護蓋、TekConnect 儀器
ATI 儀器

200-5337-00 
200-5358-00 

PCIe 主機埠保護插頭 200-5344-00 
第 2 個 Ethernet 埠插頭 200-5389-00 
快速邊緣 (2X) 上的 50 Ω 終端 015-1022-01 
TCA-292D (5X) (ATI 儀器上為 3X) 090-0044-00 
Windows 相容鍵盤 119-7275-xx
Windows 相容滑鼠 119-7054-xx
靜電保護腕帶 006-3415-05 
偏移校正纜線 (M2.92 對 M2.92) 174-6793-00 
偏移校正轉接器 (1.85F 對 2.92F)，僅限 ATI 儀器 103-0483-00 
衰減器，2.92 毫米母接頭對 2.92 毫米公接頭，50 Ω，
10 分貝

011-0221-00 

ATI 接頭護套 (1.85 毫米)，僅限 ATI 儀器 103-0474-00 
ATI 護蓋，僅限 ATI 儀器 016-2101-00 
轉矩扳手，僅限 ATI 儀器 067-2787-00 
支持扳手，僅限 ATI 儀器 003-1942-00 
配件包 016-2045-00 
最佳實務手冊 071-2989-04 
ROHS 資訊 071-2185-04 
校準檢定證明 001-1179-00 
校準檢定證明信封 006-8018-01 
電源線 – 下列其中一種：
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配件 Tektronix 零件編號

北美 (選項 A0) 161-0213-00 
歐洲通用 (選項 A1) 161-0209-00 
英國 (選項 A2) 161-0210-00 
澳洲 (選項 A3) 161-0211-01 
瑞士 (選項 A5) 161-0212-01 
日本 (選項 A6) 161-0213-00 
中國 (選項 A10) 161-0320-00 
印度 (選項 A11) 161-0325-00 
巴西 (選項 A12) 161-0358-00 
無電源線 (選項 A99)

操作需求

警告。

為了避免造成傷害和儀器損壞，儀器以後支腳接觸平面時，請勿操作儀器。

1. 將儀器放在儀器專用推車或測試台上。儀器必須以底端支腳接觸平面。另提供選購的機架安裝套件。遵
守下列空間需求和尺寸：

■ 頂部：0 英吋 (0 公釐)

■ 左側：3 英吋 (76 公釐)

■ 右側：3 英吋 (76 公釐)

■ 背面：後支腳後方保留 3 英吋 (76 公分) 以保護連接至後面板的任何纜線

■ 底部：0 英吋 (0 公釐)，支腳站立，支架朝下

小心。 為了確保適當冷卻效果，請保持儀器底部和兩側沒有任何阻礙物。

為了確保適當冷卻效果，如果將儀器堆疊在另一部儀器上方，則必須保留儀器的底端支腳。

2. 寬度：19.0 英吋 (483 公釐)

3. 高度：6.0 英吋 (152 公釐)

4. 操作儀器之前，確認周圍溫度：5 °C 到 +45 °C (+41 °F 到 +113 °F)

5. 確認操作濕度：在低於 +32 °C (+90 °F) 時為 8% 至 80% 相對溼度

在 +32 °C (+90 °F) 至 +45 °C (+113 °F) 之間時為 5% 至 45% 相對溼度，非冷凝溫度，且必須符合最高濕球溫度
+29.4 °C (+85 °F) 範圍 (在 +45 °C (+113 °F) 相對溼度會衰減到 32%)

6. 確認操作海拔高度：3,000 公尺 (9,843 英呎)，海拔高度超過 1500 公尺 (4921.25 英呎) 時，每升高 300 公尺
(984.25 英呎)，最大操作溫度會降低 1 ℃。

7. 最大輸入電壓：

TekConnect 通道：≤1.2 V/FS 設定：

±1.5 V 相對於終端偏壓 (最大 30 mA)。

安裝儀器  
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±5 V 絕對最大輸入電壓。

>1.2 V/FS 設定：±8.0 V。受限於最大 Vterm 電流和衰減器功率。

ATI 通道：± 0.75 Vpk

輔助通道：±5.0 Vpk

電源供應需求
下表列出適用於您儀器的電源供應器需求。

來源電壓與頻率 功率消耗

100 VAC 到 240 VAC，50/60 Hz
或 115 VRMS，400 Hz。

980 W

警告。

為了減少火災或是電擊的風險，請確定主電源供電的電壓波動未超過作業電壓範圍的 10%。

預防儀器損壞

預防 ESD

小心。 直接的靜電釋放會損壞儀器輸出。若要瞭解如何避免該損壞，請閱讀以下資訊。

在處理任何電器設備時，您必須注意靜電釋放 (ESD) 相關問題。雖然儀器本身的設計具有強大的 ESD 防護，
但大量的靜電直接進入訊號輸入時仍有可能造成儀器的損壞。若要避免儀器的損壞，請使用以下的技巧來預
防靜電釋放到儀器中。

1. 當連接和拔除纜線和 TekConnect 轉
接器時，請配戴接地的抗靜電腕帶，
以釋放您體內的靜電電壓。儀器已
基於此目的而提供前面板連接。

 

 安裝儀器
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2. 測試台上未連接的纜線，或是攜帶
纜線穿越房間會產生大量的靜電。
在將纜線連接到儀器之前，將纜線
的中央導線快速接地，或將 50 Ω 終
端連接到一端，以將纜線連接到測
試中的儀器或裝置之前釋放所有纜
線中的靜電。

小心。 不要使用工具 (如螺絲起
子、扳手端等) 將中央導線短接到地
殼的接頭上，因為任何刮傷或缺口
都會損壞纜線的 RF 響應。

留意最大輸入電壓

警告。 注意所有的端子功率。為了避免損壞儀器，請留意產品上所有的功率及標記。在與產品連接之前，請
先參閱產品手冊以便進一步了解有關功率的資訊。

請勿將電位加至任何會超過其最大功率的終端，包括共同終端。

ATI (非同步時間交叉) 輸入的最大輸入電壓是 ±0.75 Vpk。超過此最大電壓便會發生損壞。

TekConnect 輸入的最大輸入電壓於 ≤ 1.2 V 全幅設定下是相對於終端偏壓 (最大 30 mA) ±1.5 V，於 >1.2 V 全幅設
定下是 8 V。
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選取適當的衰減器

ATI 輸入具有 300 mVFS 的最大電壓範圍。使用衰減器可以提高最大電壓範圍。

表格 4: 最大 ATI 電壓範圍

衰減器 最大 ATI 電壓範圍

無 300 mVFS

3 dB 420 mVFS

6 dB 600 mVFS

10 dB 950 mVFS

16 dB (6 dB + 10 dB 衰減器) 1.88 VFS

20 dB 3 VFS

接頭清潔

所有接頭都必須保持乾淨。接頭中的灰塵會損壞接頭，以及與髒汙接頭搭配使用的任何接頭。灰塵也有可能
會損害 RF 效能。所有的纜線、衰減器和轉接器都應該使用接頭蓋保存以避免灰塵。

在每次使用之前，請執行下列步驟：

1. 確認接頭沒有任何灰塵、金屬微粒、
刮傷和變形。

2. 確認接頭大小正確。

警告。 若要避免眼睛受傷，請在使
用壓縮空氣時戴上護目鏡。

3. 讓接頭朝下，使用與接頭保持一定
角度的低壓壓縮空氣來清潔接頭。

4. 如果您仍需要清潔接頭，請使用沾
有異丙醇且大小適當的清潔棒來清
潔接頭螺紋和配對表面。請不要讓
中央導線突出。

小心。 請勿按壓接頭的中央接腳。
對中央接腳施加壓力會損壞接頭。
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適當的連接技術

連接至 ATI 1.85 公釐接頭、SMA 接頭、轉接器、直流區塊或纜線時，請使用 8 英吋/磅的轉矩。使用不適當的
轉矩或連接技術可能會衰減您的訊號並損壞接頭。

請利用下列程序來連接至 ATI 輸入：

小心。 連接至 ATI 輸入時，如果未使用提供的支持扳手和轉矩扳手，可能會損壞您的儀器。

1. 當連接和拔除纜線和轉接器時，請配戴接地的抗靜電腕帶，以釋放您體內的靜電電壓。儀器已基於此目
的而提供前面板連接。使用有黑色塑膠索環的接地連接，因為其具有 1 MΩ 系列電阻隔離，所以不會有
電擊的機會，但可以釋放靜電電壓。

圖表 1: 配戴抗靜電腕帶
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2. 使用提供的接頭護套來保護儀器接頭。未使用時，請安裝末端護蓋以防止灰塵和 ESD 損壞。可存放 ATI
護蓋的其他位置包括前面板的右上角和後面板音訊接頭的右方。安裝接頭護套時，請以 8 英吋/磅的轉矩
固定。

小心。 接頭護套可能看似未如預期固定/鬆開，因為示波器 ATI 輸入接頭是公接頭。

圖表 2: 安裝接頭護套

3. 安裝接頭時，使用支持扳手固定接頭護套可避免因接頭旋轉而導致的損壞。
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4. 使用提供的轉矩扳手將纜線接頭與接頭護套固定 (8 英吋/磅)。

圖表 3: 安裝纜線

小心。 連接至 ATI 輸入時，如果無法避免中央導線旋轉，則將損壞您的儀器。若要需要，請使用第二把
支持扳手固定纜線以避免纜線旋轉。請使用提供的轉矩扳手固定 (8 英吋/磅) 所有接頭。

5. 若要需要，請使用第二把支持扳手固定纜線以避免纜線旋轉。

圖表 4: 使用第二把支持扳手
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開啟儀器電源
1. 將交流電源線接到儀器的背面。

2. 使用前面板電源按鈕來開啟儀器電源。

電源按鈕可表示儀器電源狀態：

■ 無燈號 – 未開啟電源

■ 綠燈 – 已開啟電源
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將儀器電源關閉

1. 請按下前面板電源按鈕將儀器關機。

注意。 若要關閉多儀器配置電源，請先關閉主要儀器電源。

關機程序約需 30 秒的時間才能完成，之後儀器會進入待機模式。或者，請使用「Windows Shutdown (Windows
關機)」功能表。

注意。 只要按住電源按鈕四秒便可強制立即關機，但未儲存的資料都會遺失。

2. 若要完全移除儀器的電源，請執行上述關機程序，然後拔掉儀器的電源線。

多儀器配置
在多儀器配置中連接儀器可建立具有同步觸發和取樣時脈，且具有多達 4 個通道、最高頻寬和最高取樣率的
系統。 

儀器堆疊

您可以堆疊多部儀器以節省空間，並縮短纜線和以更便利的方式連接。 

警告。 使用顛倒放置的儀器時，請注意避免夾傷您的手指。
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在工作台上顛倒放置儀器時，頂端支腳
的標準方向非常有用。 在儀器上堆疊
OM4000 時，也可使用頂端支腳的標準方
向。 

使用頂端支腳的旋轉方向可在兩部儀器
的頂端進行堆疊。 

堆疊兩部儀器且旋轉頂端支腳時，底端支腳會落入露出的洞中。
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啟動之前

在開啟儀器電源之前，您必須正確連接多儀器配置中的所有儀器。 如果您在開啟儀器電源之後變更配置，則
可能需要重新啟動系統。 

如果您未在多儀器配置中連接儀器，則會以獨立模式而非多儀器模式開啟儀器電源。

UltraSync™ 匯流排纜線

UltraSync 匯流排纜線可連接任何可進行多儀器配置的儀器。 

在通電之前，您必須將所有纜線連接至儀器。 如果您在連接纜線之前開啟儀器，則需要重新啟動。
 

 

UltraSync™ 匯流排纜線連接順序

將 UltraSync 匯流排纜線束連接至主要儀器：

1. 選擇要將哪部儀器作為主要儀器。

在主要儀器上，將每個 UltraSync 纜線束連接至專用連接埠 (從「To Extension B」(連接至擴充儀器 B) 連接
埠開始；若要連接第三部儀器，請使用「To Extension C」(連接至擴充儀器 C) 連接埠；若要連接第四部儀
器，請使用「To Extension D」(連接至擴充儀器 D) 連接埠)：

2. 將時脈纜線連接至「12.5 GHz Clock Out」(12.5 GHz 時脈輸出) 接頭 (轉矩為 8 英吋/磅)。

3. 將觸發纜線連接至「Trigger」(觸發) 接頭。

4. 將 PCIe 纜線連接至 PCIe 接頭。
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將 UltraSync 匯流排纜線束連接至擴充儀器。

在擴充儀器上，將每個 UltraSync 纜線束連接至專用連接埠：

1. 將時脈纜線連接至「12.5 GHz Clock In」(12.5 GHz 時脈輸入) 接頭 (轉矩為 8 英吋/磅)。

2. 將觸發纜線連接至「To Master」(連接至主要儀器) 中的「Trigger」(觸發) 接頭。

3. 將 PCIe 纜線連接至 PCIe 接頭
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主要儀器和擴充儀器連接順序

由左至右 (擴充 B、C，然後是 D) 將每部擴充儀器依序連接至主要儀器。

注意。 將擴充儀器以星形方式連接至主要儀器，請勿以菊輪鍊方式連接儀器。
 

 

若要關閉多儀器系統電源，請先關閉主要儀器電源。
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開啟多儀器電源

啟動程序期間，儀器會檢查是否已在多儀器配置中連接儀器。如果未連接儀器，則會以獨立模式開啟儀器電
源。如果已連接儀器，則會驗證配置。如果配置無效，則會提供指引以協助您建立有效的配置。

注意。 在成功開啟多儀器系統的電源之後，請等待暖機時間完成，然後執行訊號路徑補償。

下圖顯示具有無效連接的擴充儀器，並提供修正連接的指引 (提供遺失的主要儀器連接)。
 

 

下圖顯示未正確連接的主要儀器，並提供修正問題的指引 (提供遺失的擴充儀器連接)。
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下圖顯示具有有效連接的主要儀器和擴充儀器。
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多儀器連接驗證完成且儀器顯示其作業狀態顯示後，主要儀器會顯示其狀態和計時器顯示。在示波器應用程
式啟動之前，若要進行其他變更，請暫停計時器。按下「Start Scope」(啟動示波器) 可略過計時器。計時器倒
數結束時，示波器應用程式便會啟動。
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如果您的多儀器配置包括 ATI 儀器，您可以選擇使用「ATI Channel」(ATI 通道) 或「non-ATI (TekConnect) Channel」(非
ATI (TekConnect) 通道)。在此範例中，已選擇「ATI Channel」(ATI 通道)。

注意。 您也可以選擇所有 TekConnect 通道的「Time Synchronized」(時間同步) 模式。在此模式中，擷取為時
間同步，而主要儀器控制所有 TekConnect 通道的水平、記錄長度和觸發設定。為了確保所有通道都已同步，
請以單次序列模式操作多儀器配置。使用可程式化的介面指令擷取所有 TekConnect 通道資料。波形資料未
傳送至主要儀器。若您打算使用時間同步模式，請聯絡您的 Tektronix 代表以取得更多資訊。

多儀器連接驗證完成後，儀器會顯示其狀態顯示。在此範例中，主要儀器 (A) 正在通道 2 (ATI) 上進行擷取。
擴充儀器 (B) 正在通道 2 (ATI) 上進行擷取，且顯示為通道 1。

主要儀器顯示器會自己辨識為主要儀器，並會辨識正在擷取的通道。

若要 (在示波器上) 在 Configuration Application (配置應用程式) 和示波器顯示之間切換，請使用 Alt-Tab。若要關閉
Configuration Application (配置應用程式)，請按一下 x。如果看不到 x，請按兩下 Configuration Application (配置應用
程式) 的右上角以顯示 x。
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開啟多儀器系統電源後，請執行訊號路徑補償。請參閱 訊號路徑補償在頁面上26。

在多儀器模式之間切換

若要在 ATI 通道、TekConnect 通道以及「Time Synchronized」(時間同步) 模式間切換，請使用下列程序：

1. 在「Vertical > Configuration」(垂直 >
配置) 功能表中選擇 ATI、TekConnect
或 TimeSync。
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2. 按一下「Yes」(是) 繼續。

重新啟動多儀器系統。 若要重新啟動多儀器系統而不關閉示波器，請執行下列步驟：

1. 若要關閉配置管理器和所有示波器
應用程式，並且將其重新啟動而不
變更配置模式，請選擇「File >
Restart」(檔案 > 重新啟動)。

ATI 與 TekConnect 通道

ATI 通道提供高達 70 GHz 的頻寬、200 GS/s 的取樣率和最低雜訊。使用 ATI 通道時，您無法使用 TekConnect 通
道。

TekConnect 通道具有高達 33 GHz 的頻寬和 100 GS/s 的取樣率。TekConnect 通道利用 TCA 轉接器提供多連接選
項，並且可與多種效能探棒相容。
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多儀器狀態顯示

在多儀器配置中，面板會顯示狀態資訊，例如：通道數、開啟/關閉、執行/停止、Arm/trig'd 和 UltraSync 連接資
訊。主要儀器也會顯示觸發設定，以及擷取和顯示的通道。
 

 

可用功能

表格中提及的某些儀器或配置可提供本手冊中討論的功能。

表格 5: 獨立式儀器

功能 DPO77002SX
DPO75902SX
DPO75002SX

DPO73304SX
DPO72304SX
DPO71604SX
DPO71304SX

狀態 (時脈樣式)
觸發

適用於 TekConnect 通道 可供使用

XYZ 模式 適用於 TekConnect 通道 可供使用

等時擷取 適用於 TekConnect 通道 可供使用

高解析度和峰值
檢測

適用於 TekConnect 通道 可供使用

FastAcq 適用於 TekConnect 通道 可供使用

捲動模式 適用於 TekConnect 通道 可供使用

IRE 和 MV 方格圖
模式

適用於 TekConnect 通道 可供使用
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DPO7AFP 輔助前面板 (選配)
DPO7AFP 是可選插入式面板，提供可控制 DPO70000SX 系統示波器的實體旋鈕和按鈕。 若要連接 DPO7AFP：

1. 關閉 TekScope 應用程式。

注意。 在連接 DPO7AFP 之前，您必
須關閉 TekScope 應用程式。

2. 將 DPO7AFP 插入 DPO70000SX 上的
任何 USB 埠。 等候 Windows OS 辨
識和載入所需驅動程式。

3. 啟動 TekScope 應用程式。 TekScope
連接至面板時，面板 LED 會亮起。

4. 若要確認 DPO7AFP 是否正常運作，
請按下任何通道按鈕，並觀察
TekScope 應用程式是否啟用或停用
所選通道

注意。 如果您在執行 TekScope 時
拔除 DPO7AFP，則需要關閉
TekScope、重新連接 DPO7AFP，並
重新啟動 TekScope 才能使用
DPO7AFP。

檢查儀器
每次開啟儀器電源時，儀器便會自動執行電源開啟自我測試診斷。

確認內部診斷通過

使用下列程序來驗證儀器的功能。
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1. 開啟儀器電源。

2. 選取「Instrument Diagnostics...」(儀器
診斷...)。

3. 按一下「Run」(執行)。測試結果會
出現在診斷控制視窗。

4. 請驗證所有測試皆已通過。如果發
生診斷失敗情形，請聯絡您當地的
Tektronix 服務人員。

啟動 Windows 10
以延遲啟動模式提供，隨附於此產品的 Microsoft Windows 10 副本。Microsoft 設有預設啟動方法，需要連線至網
際網路。如果您無法連接至網際網路，可以撥打電話啟動 Windows 10，或繼續於延遲啟動模式中操作。

第一次啟動。 您可以透過下列任一方式啟動 Windows 10。

1. 將儀器連接至網際網路。Windows 將自動啟動。您也可以移至「系統內容」(System Properties) 來連接並啟
動。

2. 致電 Microsoft 並與代表交談以啟動 Windows 10。聯絡資訊和唯一啟動代碼 (安裝 ID) 將出現於彈出視窗。

以卸除式磁碟機啟動。 如果從一個儀器中移除 SSD，並插入另一個儀器，則需要在第二個儀器上再次執行啟
動程序。如果第二個儀器未連接至網際網路，啟動將會失敗，啟動 Windows 的浮水印將會顯示在螢幕上。若
要啟動 Windows 並移除浮水印，您必須連接至網際網路或致電 Microsoft。
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Windows 介面指引

因為儀器使用 Microsoft Windows 介面，所以您可以存取 Windows 作業系統。您可以存取 Windows 桌面以載入與
執行其他 Windows 應用程式，例如 Microsoft Excel。

使用儀器時請遵守這些指引，以避免任何可能造成問題的作業系統變更：

■ 進行控制面板的變更時請注意。避免對您不熟悉的控制項進行變更。

■ 不可變更或移除任何系統字型；這可能會影響顯示的品質。

■ 變更系統「Display (顯示)」內容時請特別小心。變更如解析度、文字大小、字型和方向等設定，會影響顯
示器和觸控式螢幕的可用性。

■ 請勿變更 Windows 資料夾或 Program Files\Tektronix\AWG70000\ 資料夾的內容。

■ 請勿變更 BIOS 設定；這可能會影響儀器的整體操作。
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訊號路徑補償

請定期執行訊號路徑補償 (SPC)，以確保您的量測值可達到最高的精確度。當您使用儀器以較高靈敏度
(10 mV/格和較低) 設定來量測訊號，而不論溫度變化或上次執行距今的時間時，Tektronix 認為是執行 SPC 的最
佳時機。無法執行 SPC，可能會導致儀器無法達到保證的效能等級。

SPC 可以修正因溫度變化或長期漂移而導致的直流誤差。SPC 可以最佳化擷取系統、修正直流偏移，以及交
叉校準。交流元件的輸入訊號會對 SPC 產生不利影響。

請使用此程序來最佳化擷取系統：

■ 如果自上次訊號路徑補償 (SPC) 至今溫差超過 5 °C (9 °F)
■ 如果使用儀器來量測靈敏度更高的訊號 (10 mV/格和更低)，而一週至少執行一次 SPC
■ 前面板 SPC 狀態圖示不是綠色

■ 更換或插入磁碟機媒體

■ 您變更多儀器系統的配置，例如變更哪個儀器做為主要或擴充儀器。

1. 先決條件：

■ 儀器必須開啟電源，直到
「Utility」(公用程式) >「Instrument

Calibration」(儀器校準) >
「Temperature Status」(溫度狀態)
為「Ready」(就緒)。

■ 必須移除所有輸入通道訊號。

■ 如果選取時基外部參考模式，
請將外部參考訊號保持為已連
接且使用中狀態。
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2. 選取「Instrument Calibration」(儀器
校準)。

DPO70000SX 儀器上的「Utility」
(公用程式) 功能表

3. 當「Temperature Status」(溫度狀態)
變成「Ready」(就緒) 時，請按一下
「Run SPC」(執行 SPC) 以啟動校準。
校準程序可能需要 10 到 15 分鐘。

注意。 在執行 SPC 校準之前，請先
移除所有通道輸入訊號。

注意。 當您在目前儀器中時，如果
使用未執行 SPC 的磁碟機，您將看
到沒有先前 SPC 警告訊息。如果看
到此警告，請執行 SPC。
 

 

 

DPO70000SX 儀器上的「Calibration」(校準) 功能表
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4. 如果儀器驗證沒有通過，請重新校
準儀器，或是交由合格的服務人員
處理。

注意。 若要在超過一個月未執行
SPC 時一律顯示 SPC 狀態圖示或顯
示警告，請按一下對應的核取方塊。

 DPO70000SX 儀器上的「Calibration」(校準) 功能表

5. 如果需要 SPC 的圖示為紅色時，請
執行訊號路徑補償 (SPC)。

檢查 SPC 狀態圖示的顏色：

■ 綠色表示已成功通過 SPC 且溫
度穩定。

■ 黃色表示儀器處於暖機狀態，
或表示自上次執行 SPC 後已過
了超過 30 天。

■ 紅色表示需要執行 SPC (溫度
變化超過 5 °C、SPC 失敗，或
SPC 尚未執行)。
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連線到網路

將儀器連接到網路，進行列印、檔案共
用、網際網路存取和其他功能。請先詢
問網路管理員，再使用標準 Windows 公
用程式來設定儀器的網路連線。 

請使用 Windows 的遠端桌面連線，並從
遠端控制和檢視儀器。 

 安裝儀器
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新增第二台監視器
您可以一邊操作儀器，一邊在外部監視器上使用 Windows 和已安裝的應用程式。 請依照下列程序執行，設定
雙螢幕配置。

1. 關閉電源。

2. 連接第二台監視器。

3. 連接鍵盤。

4. 連接滑鼠。

5. 開啟儀器電源。

6. 開啟監視器電源。

啟動 Windows 10
以延遲啟動模式提供，隨附於此產品的 Microsoft Windows 10 副本。Microsoft 設有預設啟動方法，需要連線至網
際網路。如果您無法連接至網際網路，可以撥打電話啟動 Windows 10，或繼續於延遲啟動模式中操作。

第一次啟動

您可以透過下列任一方式啟動 Windows 10。

1. 將儀器連接至網際網路。Windows 將自動啟動。您也可以移至「系統內容」(System Properties) 來連接並啟
動。

2. 致電 Microsoft 並與代表交談以啟動 Windows 10。聯絡資訊和唯一啟動代碼 (安裝 ID) 將出現於彈出視窗。
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以卸除式磁碟機啟動

如果從一個儀器中移除 SSD，並插入另一個儀器，則需要在第二個儀器上再次執行啟動程序。如果第二個儀
器未連接至網際網路，啟動將會失敗，啟動 Windows 的浮水印將會顯示在螢幕上。若要啟動 Windows 並移除
浮水印，您必須連接至網際網路或致電 Microsoft。

復原儀器作業系統和產品軟體

您可以直接從儀器復原儀器的 Windows 作業系統。 儀器並未隨附作業系統復原光碟。

若要復原或更新產品軟體，您需要從 Tektronix 網站下載最新的版本。

注意。 復原或更新產品軟體並不需要復原 Windows 作業系統。

作業系統復原

小心。 使用復原程序將硬碟重新格式化，然後重新安裝作業系統。所有儲存的資料都會遺失。如果可能，執
行系統復原前，將重要檔案儲存至外部媒體。

已安裝的 Windows 作業系統是針對本儀器的硬體及產品軟體所設計。安裝提供版本之外的作業系統將無法正
常運作。

安裝作業系統後，您需要從 Tektronix 網站下載產品軟體安裝套件，並重新安裝軟體。

內部復原公用程式
當您在復原損毀的 Windows 作業系統時，建議使用此方法。此方法使用 Acronis Startup Recovery Manager 來復原
Windows 作業系統。Acronis 軟體會使用預先安裝在硬碟中的復原影像重新安裝作業系統。

此方法會保留復原影像，並且能夠重複執行復原程序。

1. 將鍵盤連接至儀器。

2. 重新啟動儀器。在開機程序期間，您會在螢幕頂端看見下列訊息：

Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager (正在啟動

Acronis Loader… 按下 F5 啟動 Acronis Startup Recovery Manager)

注意。 若要成功完成系統還原，您必須使用 Windows 版本的 Acronis 軟體。 使用一般 MAC 鍵盤會啟動
DOS 版本的 Acronis 軟體。 請勿使用 MAC 鍵盤。

3. 重複按下 F5 鍵，直到 Acronis True Image Tool 開啟為止。從訊息出現至儀器進行儀器正常啟動為止，總共
15 秒。如果儀器未開啟 Acronis 應用程式，將儀器的電源關閉，然後開啟電源再試一次。

4. 按一下「Restore」(復原)。

5. 在「Confirmation (確認)」對話方塊中，按一下「Yes (是)」復原儀器作業系統，或按一下「No (否)」結束復
原程序。 復原程序需時約 30 分鐘；實際時間須視儀器配置而定。

 安裝儀器
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產品軟體安裝

注意。 對於 DPO77002SX 儀器，您必須從 Tektronix 訂購產品軟體。

1. 下載產品軟體安裝套件。此安裝套件包含：

■ 操作說明

■ 產品軟體安裝程式

2. 依照螢幕上的所有提示安裝產品軟體。
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了解儀器

前面板接頭

圖表 5: ATI 及 TekConnect 通道
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圖表 6: TekConnect 通道

表格 6: 前面板接頭

識別器 接頭 說明

1 USB 2.0 四個 USB 接頭。

2 底盤接地線 蕉型接地連接。

1 MΩ 電阻接地 蕉型接地連接。
當連接和拔除 TekConnect 轉接器的纜線時，請配戴接地的
抗靜電腕帶，以釋放您體內的靜電電壓。

3 直流探棒校準 探棒校準輸出

4 1、2、3 和 4 (類比輸入) 這些接頭提供類比訊號。

5 輔助輸入 輔助觸發輸入

6 差動快速邊緣 差動快速邊緣步階輸出。
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後面板接頭

表格 7: 後面板接頭

接頭 說明

PCIe 連接外部裝置或配置多儀器系統的 PCIe 埠。

12.5 GHz 時脈輸入 提供用於多儀器配置之外部時脈訊號的 SMA 類型接頭。

12.5 GHz 時脈輸出 SMA 類型接頭可提供與取樣率相關的高速時脈。 此時脈用於多儀器配置。

觸發 UltraSync 觸發匯流排。

LAN 將儀器連接至網路的 RJ-45 接頭。

USB 3.0 連接如滑鼠、鍵盤或其他 USB 裝置的四個 USB 3.0 主機埠接頭 (A 型)。除所提供的滑鼠及鍵
盤外，Tektronix 並不提供 USB 裝置的支援或裝置驅動程式。

USB USB 裝置接頭

VGA 連接延伸式桌面操作之監視器的 VGA 埠。若要將 DVI 監視器連接至 VGA 接頭，請使用 DVI
至 VGA 轉接器。

DVI-D 使用 DVI-D 視訊埠可將儀器顯示傳送至投影機或平板 LCD 監視器。

顯示埠 這些接頭提供數位顯示介面

PS/2 滑鼠 此接頭可供 PS/2 滑鼠使用。

PS/2 鍵盤 此接頭可供 PS/2 鍵盤使用

音訊 這些接頭提供麥克風輸入、Line In 和 Line Out。
輔助輸出 儀器觸發或某些其他事件發生 (例如遮罩測試失敗或完成) 時，SMA 類型接頭提供 TTL 相容

的負極脈波。

參考輸出 SMA 類型接頭可提供同步訊號至外部裝置。

外部參考輸入 提供外部參考時脈輸入的 SMA 類型接頭。

電源 電源線輸入。
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介面和顯示
功能表列模式可用來存取控制本儀器所有功能和性能的指令。 工具列模式可存取最常用的功能。

1. 功能表列： 存取資料輸入∕輸出 (I/
O)、列印、線上說明和儀器功能

2. 按鈕∕功能表： 按一下便可切換工具
列模式和功能表列模式，以及自訂
工具列

3. 多用途旋鈕讀值： 調整及顯示多用
途旋鈕控制的參數

4. 顯示畫面： 以游標呈現顯示中的波
形、參考波形、數學運算波形和匯
流排波形

5. Waveform Handle (波形拖曳點)： 按
一下並拖曳，便可變更波形或匯流
排的垂直位置。按一下拖曳點，便
可透過多功能旋鈕來變更位置和刻
度。

6. 控制項狀態： 對應至垂直選取、刻
度、偏移和參數的快速參考。 針對
某些探棒頭提供探棒狀態。

7. 讀值： 顯示這個區域中的游標和量
測讀值。您可從功能表列或工具列
選取量測值。如果出現控制視窗，
表示某些讀值組合會移到方格圖區
域。

警告。 如果出現垂直裁剪，探棒頭則具有危險的電壓，但讀數格只會顯示低電壓。如果出現垂直裁剪的情
況，儀器讀數格則會出現  符號。發生訊號垂直裁剪的自動振幅相關量測值，所產生的結果將不精確。
若儲存或匯出讓其他程式使用的波形被裁剪，也會導致不精確的振幅值。如果是裁剪數學波形，則數學波
形的振幅量測值並不會受到影響。

 

8. 狀態： 顯示擷取狀態、模式和擷取數目；觸發狀態、日期和時間；以及對應至記錄長度和水平參數的
快速參考
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1. 按鈕∕功能表： 按一下便可切換工具
列和功能表列，以及自訂工具列

2. 拖曳游標，便可量測螢幕上的波形

3. 拖曳位置圖示，便可重新定位波形

4. 請按一下圖示以指定波形垂直位置
和刻度的多用途旋鈕

5. 在波形區域上拖曳，便可建立方塊
來縮放、啟用/停用長條圖、閘控量
測，及新增和控制視覺觸發區域

6. 拖曳圖示，便可變更觸發位準

 了解儀器
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控制面板

注意。 輔助前面板配件可提供這些控制鈕。 儀器功能表可提供這些控制鈕所執行的功能。

1. 按下此按鈕，便可自動依所選波道
來設定垂直、水平和觸發控制項。

2. 按下此按鈕，便可將設定恢復到預
設值。

3. 按下此按鈕，便可直接列印或儲存
螢幕擷取。

4. 按下此按鈕，便可啟動 MultiView
Zoom，並新增擴大方格圖到畫面上。

5. 調整水平刻度、位置、延遲，以及
設定所有波形的記錄長度 (解析
度)。

6. 使用此按鈕來啟動和停止擷取、啟
動單一擷取程序、清除資料，或啟
動快擷取。

7. 使用此按鈕來設定觸發參數。按下
「進階」可顯示其他的觸發功能。

Arm (作用中)、Ready (就緒) 和 Trig'd
(已觸發) 燈號表示擷取狀態。

8. 旋轉此旋鈕可調整波形強度。

9. 旋轉此旋鈕可調整從螢幕介面選取
的參數。按下此按鈕可切換一般調
整和微調。

10. 按下此按鈕可開啟和關閉游標。

11. 用於搜尋和標記波形。

12. 按下此按鈕可開啟和關閉觸控式螢
幕。

13. 開啟和關閉通道顯示。調整垂直刻
度、位置，或是偏移波形。切換位
置和偏移。
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存取線上說明
線上說明將深入提供本儀器所有功能的詳細資訊。

如果要從作用中視窗存取智慧型輔助說
明，請選取「Help > Help on Window...」
(說明 > 視窗上顯示說明...)，或是按下
F1。 

1. 如果要存取說明系統中的任何主
題，請選取「Help > Contents and
Index...」(說明 > 內容和索引...)。

2. 使用「內容」、「索引」、「搜尋」或
「我的最愛」等索引標籤來選取主
題，然後按一下「Display」(顯示)。

如果要瀏覽說明系統： 

■ 按下說明視窗的按鈕，在「概要」
和特定主題之間瀏覽。

■ 按一下說明視窗中的「Minimize」(最
小化)按鈕可將說明最小化，以便您
操作儀器。

■ 同時按下 Alt 和 Tab 可再查看上一
次的說明主題。

 

 了解儀器
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存取功能表和控制視窗
您可以使用下列技巧來存取功能表和控制視窗：

■ 按一下功能表，接著選取一個指令。

 

■ 在方格圖任何位置或在物件上按滑
鼠右鍵，便可使用捷徑功能表。捷
徑功能表可以即時線上顯示，而且
會依滑鼠右鍵按下的不同區域位置
或物件提供不同選項。右圖舉出一
些範例。

 

■ 使用工具列模式時，按一下按鈕可
快速存取設定控制視窗。請參閱 
介面和顯示。
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檢查儀器
使用下列程序來驗證儀器的功能。

確認內部診斷通過

1. 開啟儀器電源。

2. 選取「Instrument Diagnostics...」(儀
器診斷...)。

3. 按一下「Run 」(執行)。測試結果會
出現在診斷控制視窗。

4. 請驗證所有測試皆已通過。如果發
生診斷失敗情形，請聯絡您當地的
Tektronix 服務人員。
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擷取
本節將介紹使用擷取系統的概念和程序。

訊號路徑補償

請定期執行訊號路徑補償 (SPC)，以確保您的量測值可達到最高的精確度。當您使用儀器以較高靈敏度
(10 mV/格和較低) 設定來量測訊號，而不論溫度變化或上次執行距今的時間時，Tektronix 認為是執行 SPC 的最
佳時機。無法執行 SPC，可能會導致儀器無法達到保證的效能等級。

SPC 可以修正因溫度變化或長期漂移而導致的直流誤差。SPC 可以最佳化擷取系統、修正直流偏移，以及交
叉校準。交流元件的輸入訊號會對 SPC 產生不利影響。

請使用此程序來最佳化擷取系統：

■ 如果自上次訊號路徑補償 (SPC) 至今溫差超過 5 °C (9 °F)
■ 如果使用儀器來量測靈敏度更高的訊號 (10 mV/格和更低)，而一週至少執行一次 SPC
■ 前面板 SPC 狀態圖示不是綠色

■ 更換或插入磁碟機媒體

■ 您變更多儀器系統的配置，例如變更哪個儀器做為主要或擴充儀器。

1. 先決條件：

■ 儀器必須開啟電源，直到
「Utility」(公用程式) >「Instrument

Calibration」(儀器校準) >
「Temperature Status」(溫度狀態)
為「Ready」(就緒)。

■ 必須移除所有輸入通道訊號。

■ 如果選取時基外部參考模式，
請將外部參考訊號保持為已連
接且使用中狀態。
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2. 選取「Instrument Calibration」(儀器
校準)。

DPO70000SX 儀器上的「Utility」
(公用程式) 功能表

3. 當「Temperature Status」(溫度狀態)
變成「Ready」(就緒) 時，請按一下
「Run SPC」(執行 SPC) 以啟動校準。
校準程序可能需要 10 到 15 分鐘。

注意。 在執行 SPC 校準之前，請先
移除所有通道輸入訊號。

注意。 當您在目前儀器中時，如果
使用未執行 SPC 的磁碟機，您將看
到沒有先前 SPC 警告訊息。如果看
到此警告，請執行 SPC。
 

 

 

DPO70000SX 儀器上的「Calibration」(校準) 功能表
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4. 如果儀器驗證沒有通過，請重新校
準儀器，或是交由合格的服務人員
處理。

注意。 若要在超過一個月未執行
SPC 時一律顯示 SPC 狀態圖示或顯
示警告，請按一下對應的核取方塊。

 DPO70000SX 儀器上的「Calibration」(校準) 功能表

5. 如果需要 SPC 的圖示為紅色時，請
執行訊號路徑補償 (SPC)。

檢查 SPC 狀態圖示的顏色：

■ 綠色表示已成功通過 SPC 且溫
度穩定。

■ 黃色表示儀器處於暖機狀態，
或表示自上次執行 SPC 後已過
了超過 30 天。

■ 紅色表示需要執行 SPC (溫度
變化超過 5 °C、SPC 失敗，或
SPC 尚未執行)。

 擷取
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設定類比訊號輸入
使用下拉式功能表或輔助前面板，可設定儀器進行訊號擷取。

如果您使用下拉式功能表，請執行下列步驟：

1. 將探棒或纜線連接到輸入訊號源。

小心。 若要避免造成儀器的損壞，
在進行儀器的連接時請一律配戴抗
靜電腕帶，並觀察輸入接頭的最大
輸入電壓功率。

2. 選取輸入通道：選取「Vertical >
Vertical Setup」(垂直 > 垂直設定)。
選取要選取之通道的索引標籤，然
後按下「Display」(顯示) 按鈕以開啟
或關閉通道。

3. 選取「Horiz/Acq > Autoset」(水平/擷
取 > 自動設定)。

4. 選取「Vertical > Vertical Setup」(垂直
> 垂直設定)。調整垂直位置、刻度
和偏移：按兩下「Position」(位置)、
「Scale」(刻度) 和「Offset」(偏移) 控
制項，並使用跳出鍵盤進行調整。

5. 如果您要讓輸入訊號反向，按一下
「Invert」(反向) 按鈕，可將反向切換
為開和關。「Invert」(反向) 按鈕位於
「Vertical Setup」(垂直設定) 功能表或
「Deskew/Attenuation/Invert」(偏移校
正/衰減/反向) 功能表中。
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6. 選取「Horiz/Acq > Horizontal/
Acquisition Setup」(水平/擷取 > 水
平/擷取設定)。調整水平位置和刻
度：按兩下「Position」(位置) 和
「Scale」(刻度) 控制項，並使用跳出
鍵盤進行調整。

水平位置會決定前置觸發和後置觸
發的取樣數目。  

如果您使用輔助前面板，請執行下列步驟：

1. 將探棒或纜線連接到輸入訊號源。

小心。 若要避免造成儀器的損壞，
在進行儀器的連接時請一律配戴抗
靜電腕帶，並觀察輸入接頭的最大
輸入電壓功率。

2. 選取輸入通道。

3. 選取「Horiz/Acq」(水平/擷取)，然後
選取「Autoset」(自動設定)。

4. 調整垂直位置、刻度和偏移。
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5. 調整水平位置和刻度。

水平位置會決定前置觸發和後置觸
發的取樣數目。  

使用預設值設定

1. 若要快速回復到原廠預設值設定，
請從檔案功能表中選取「Recall
Default Setup」(叫出預設值設定)，
或按下輔助前面板上的「DEFAULT
SETUP」(預設值設定)。
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使用自動設定
使用「自動設定」功能，便可快速並自動依據輸入訊號特性來設定儀器 (擷取、水平、觸發和垂直)。 自動設
定可調整訊號，使波形靠近中間位準觸發來顯示二或三個週期。

1. 請接上探棒，再選擇輸入波道。請
參閱 設定類比訊號輸入在頁面上
46。

2. 若要執行自動設定，選取「Horiz/
Acq」(水平/擷取)，然後選取
「Autoset」(自動設定)，或按下輔助
前面板上的「AUTOSET」(自動設定)
按鈕。

3. 按一下「Undo」(復原) 以取消上一
次的自動設定。不受「自動設定」
影響的參數仍會保留其設定。

快速秘訣

■ 「Autoset」(自動設定) 可自動設定類比波道。

■ 在含有 iCapture 的儀器上，「Autoset」(自動設定) 可自動設定 iCapture 波道。

■ 為了適當調整波形位置，您可能會用「自動設定」來改變垂直位置。Autoset (自動設定) 也可調整垂直偏
移。

■ 顯示一個以上的通道時，如果您使用「自動設定」，本儀器就會選取最小編號的通道執行水平比例和觸
發。您可以分別控制各個通道的垂直刻度。

■ 如果在螢幕沒有顯示任何通道時使用「自動設定」，儀器就會啟動通道 1 (Ch 1)，並設定通道刻度。

■ 按一下 X 便可關閉「復原自動設定」(Autoset Undo) 控制視窗。「復原自動設定」關閉後，您仍然可以從
「編輯」(Edit) 功能表選擇「復原上一次自動設定」(Undo Last Autose) 來恢復成上一次的自動設定。

■ 可在「Utilities」(公用程式) 功能表中變更「User Preferences」(使用者偏好)，停止「Autoset Undo」(復原自
動設定) 控制視窗不要自動開啟。
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探棒補償和偏移校正
請參閱儀器線上說明執行下列程序，以最佳化量測精確度：

■ 補償被動探棒

■ Compensate active probes
■ 偏移校正輸入波道

偏移校正工具
從「Analyze」(分析) 功能表中，選取「Deskew Tool」(偏移校正工具)。
 

 

概要

使用「Deskew Tool」(偏移校正工具) 來補償輸入訊號路徑中的傳播延遲。

偏移校正工具可透過 UltraSync 纜線用於獨立式示波器或在多個 DPO70000SX 示波器之間使用。

偏移校正工具會使用示波器觸發點及時對齊所有通道。此工具需要即時訊號連接到每個通道。即時訊號必
須時間同步至觸發通道。相較於觸發通道，用於偏移校正的訊號可以是相同或相反的極性。針對具有相同極
性的訊號，會使用包含與觸發相同極性的最接近邊緣作為校準用的參考邊緣。針對差動訊號，會使用包含與
觸發相反極性的最接近邊緣進行校準。
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1. 「Display Mode」(顯示模式) 中的模式可為：

■ 適用於獨立式示波器的 Standalone

■ 適用於多重 ATI/TekConnect 儀器的 Multiscope

■ 時間同步模式

2. 通道選擇 - 通道關閉時，通道會呈現灰色。按下通道按鈕可將通道切換為開啟或關閉。

3. 分佈圖檢視 - 會顯示平均值、標準差和總數。

4. 斜率與位準 - 定義用於偏移校正的斜率和位準。

■ 觸發會使用觸發斜率和位準作為參考極性以及通道校準的位準。

■ 上升會使用最接近觸發點的上升邊緣，並可讓您調整位準。

■ 會使用最接近觸發點的下降邊緣，並可讓您調整位準。

■ 使用上升或下降邊緣和位準。

注意。 使用偏移校正工具來對齊差動對時，選取第一個通道的觸發斜率，以及極性與觸發極性相反
的邊緣。

5. 偏移校正為平均值 - 將每個已選取通道的量測偏移值新增至每個個別通道的通道偏移校正值。

6. 設定 0 - 將所有通道偏移校正值重設為 0。

7. 分佈圖重設 - 將其總數資料的分佈圖清除。

8. 設定預設 - 設定所有通道上的「Slope to Trigger」(斜率對觸發)，並重設分佈圖。

工具的運作方式為精準計算觸發位置與每個通道已選取邊緣之間的差異。計算的值會顯示在分佈圖檢視中。
若要對齊示波器通道，請選取斜率和位準、等候累積足夠的總數 (等候接近「To Mean」(對平均值) 按鈕的指
示燈變成綠色)，然後按下「To Mean」(對平均值) 按鈕。

一般而言，在 DPO70000SX 示波器上需要兩次累積和按下「To Mean」(對平均值) 按鈕才能進行 Femtosecond (fs)
位準校準。這是因為當示波器中的偏移校正值設為 0 時，偏移值可能會在 Picosecond (ps) 的範圍。ps 與 fs 之
間的解析度具有大幅差異。因此，第一次嘗試時會很接近，而第二次嘗試就會進入 fs 範圍。
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若要使用

使用「Deskew Tool」(偏移校正工具) 來補償輸入訊號路徑中的傳播延遲。

1. 將觸發模式設為邊緣，並調整參考通道上的觸發位準，直到您獲得穩定的觸發為止。

2. 選取要偏移校正的通道。確定每個通道都已連接即時訊號，且其邊緣是在觸發通道邊緣的 0.5 UI 範圍內。

3. 選取每個通道的斜率和位準。

4. 等候累積足夠的總數 (接近「To Mean」(對平均值) 按鈕的指示燈變成綠色)

5. 按下「To Mean」(對平均值) 按鈕。

6. 多次重複步驟  4 和  5。ps 與 fs 之間的解析度具有大幅差異。因此，第一次嘗試時會很接近，而第二次嘗
試就會進入 fs 範圍。

此圖表為偏移校正之前的快速邊緣訊號範例：
 

 

此圖表為偏移校正之後的快速邊緣訊號範例：
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此圖表為偏移校正之前的差動訊號範例：
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此圖表為偏移校正之後的差動訊號範例：
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擷取概念

擷取硬體

顯示訊號之前，訊號會先通過輸入波道，以設定刻度和完成數位化。每個波道都有專用的輸入放大器和數位
器。 每個通道都會產生數位資料流，讓儀器從中擷取波形記錄。
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取樣過程

擷取是指取樣類比訊號、將其轉換成數
位資料、組合成波形記錄，然後將波形
記錄儲存到擷取記憶體的過程。 

即時取樣

使用即時取樣時，儀器會數位化所有單
一觸發事件擷取到的點。使用即時取樣
可以擷取單擊訊號或暫態訊號。 

內插即時取樣

使用內插即時取樣時，儀器將數位化所
有單一觸發事件擷取到的點。如果儀器
無法透過最大即時取樣率擷取建立完整
波形的足夠取樣數，它就會採取內插方
式。使用內插即時取樣可以擷取單擊訊
號或暫態事件。 

等時取樣

本儀器會使用等時取樣，將取樣率擴展
超過其即時最大取樣率。只有當「等時」
(Equivalent Time) 已選取，而且即時取樣
之時基已設定成取樣率快到無法建立波
形記錄的情況下，您才能使用等時取樣
功能。 

本儀器會多次擷取重複性波形，以便取
得完整波形記錄在建立時所需的取樣密
度。可想而知，等時取樣功能只可用於
重複性訊號。 
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波形記錄

示波器以下列參數來建立波形記錄： 

■ 取樣間隔： 取樣點之間的時間。

■ 記錄長度：構成波形記錄所需的取
樣數量。

■ 觸發點： 波形記錄中的零時間參考
點。

■ 水平位置： 水平延遲關閉時，水平
位置是 0 到 99.9% 之間的波形記錄
百分比。觸發點和水平參考在波形
記錄中將顯示相同時間。例如，當
水平位置為 50% 時，觸發點就是位
在波形記錄的中間。如果有啟用水
平延遲，從觸發點到水平參考之間
的時間就是水平延遲時間。

 

內插法

當儀器沒有取得建立波形記錄所需之全部實際取樣時，儀器可以在擷取的取樣間採用內插法。線性內插法會
應用最適直線，計算出介於實際擷取取樣之間的記錄點。

Sin(x)/x 內插法會應用最佳曲線，計算出介於實際擷取數值之間的記錄點。 Sin(x)/x 內插法為預設的內插模式，
因為它在精確呈現波形時所需的實際取樣點數比線性內插法少。

擷取模式的運作方式

擷取模式

「Sample」(取樣)模式會保留從每個擷取間
隔的第一個取樣點。 取樣是預設模式。

「Peak Detect」(峰值檢測)模式會使用兩個連
續擷取間隔所含全部樣本中最高和最低
者。 這個模式只能用於即時、沒有任何插
入的取樣，且可用於擷取高頻率突波。

「Hi Res」(高解析度)模式會計算每個擷取間
隔的所有樣本平均。 高解析度提供較高解
析度、較窄頻寬的波形。

「Envelope」(包封)模式會從眾多擷取中找出
最高和最低的記錄點。 包封會針對每次擷
取使用峰值檢測。
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擷取模式

「Average」(平均)模式會計算眾多擷取上每
個記錄點的平均值。「平均」模式會為每個
擷取使用「取樣」模式。 請使用平均模式
來降低隨機雜訊。

「Waveform Database」 (波形資料庫) 模式是
經過數次擷取後所得到的來源波形資料三
維累積。 除了振幅和時序資訊，這個資料
庫還會包括所擷取特定波形點 (時間和振
幅) 的次數計數。

啟用加強型有效位元數

在「Acquisition」(擷取) 標籤中使用此控制項，可開啟或關閉「Enhanced Effective Number of Bits (ENOB)」(加強型
有效位元數) 以顯示最詳盡的波形細節。 
 

 

1. 按一下「Enhanced Effective Number of Bits」(加強型有效位元數) 核取方塊可開啟或關閉 ENOB 功能。您可
在「Horizontal/Acquisition」(水平/擷取) 控制視窗的「Acquisitions」(擷取) 標籤中找到此控制項。

「加強型有效位元數」可啟用改善有效位元數的交插修正 DSP。僅部分儀器機型提供此控制項。此控制項無
法在高解析度模式中使用。

當啟用「Enhanced Effective Number of Bits」(加強型有效位元數) 時，水平/擷取讀數中會顯示 EB+。
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改變擷取模式
請使用此程序來改變擷取模式。

1. 選取「Horiz/Acq > Acquisition Mode」
(水平/擷取 > 擷取模式)。

2. 請執行下列一項動作來選取擷取模
式：

■ 直接從功能表選取擷取模式。

■ 按一下 「Mode...,」(模式...) 選取
擷取模式。

 

3. 使用「平均」或「包封」擷取模式
時，請按一下 「# of Wfms」 (波形數
目) 控制項，然後以多用途旋鈕設定
波形數目。使用波形資料庫
(WfmDB) 模式時，請按一下
「Samples」(取樣) 控制項，然後以多
用途旋鈕設定取樣數目。

快速秘訣

■ 按一下數字鍵盤圖示，便可設定波形或取樣的數目。

■ WfmDB 模式不適用於多單元配置。
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開始和停止擷取
在選取要擷取的通道之後，請使用下列程序。

1. 若要開始擷取，請選取「Horiz/Acq >
Run/Stop」(水平/擷取 > 執行/停止)，
並按一下「Run/Stop」(執行/停止)，
或按下輔助前面板上的「Run/Stop」
(執行/停止) 按鈕。

2. 若要停止擷取，請再按一下「Run/
Stop」(執行/停止)，或按下「RUN/
STOP」(執行/停止) 按鈕。

3. 若要進行單一擷取，請按一下
「Single Sequence」(單次序列)，或按
下「Single」(單一) 按鈕。
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選取水平模式
您的儀器有三個水平模式。「自動」是預設模式。 請選取最適合測試設定的水平模式。

若要設定水平模式，請選取「Horiz/Acq
> Horizontal/Acquisition Setup」(水平/擷取
> 水平/擷取設定) 以顯示水平控制視窗。
選擇下述模式之一。 

在「自動」模式可以設定「刻度」和「取
樣率」。記錄長度是相依變數。若變更
刻度會讓記錄長度超出「記錄長度限
制」，取樣率會減少至下一個可用設
定。 

取樣模式若為即時且取樣率到達即時限
制，便無法增加取樣率。 

若要設定「記錄長度限制」，請按一下
「Record Length Limit 」(記錄長度限制)，
並使用按鈕或鍵盤設定限制。預設的最
大限制取決於儀器機型和記錄長度選
項。 

在「常態取樣率」模式可以設定「取樣
率「和「刻度」。預設取樣率可以確保頻
寬濾波器作業。記錄長度是相依變數。
最大記錄長度取決於儀器機型和記錄長
度選項。 

輔助前面板解析度旋鈕可以在自動和常
態取樣率模式下變更取樣率。 
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在「手動」模式下可以設定「取樣率」
和「記錄長度」。根據取樣率和記錄長度
計算出來的「水平刻度」是相依變數。 

「水平刻度」旋鈕可以變更手動模式的記
錄長度。 

如圖所示，這三個模式與取樣率、刻度
和記錄長度均有所互動。水平線是最大
即時取樣率。每個樓階顯示若將刻度增
加到最大記錄長度或記錄長度限制，就
必須減少取樣率。手動模式使用最大記
錄長度。 

「自動」和「常態取樣率」模式是相同
的。但「常態取樣率」模式讓取樣率維
持在可以使用加強型頻寬濾波器的常態
取樣率。 

擷取  

62  DPO70000SX 系列使用者



使用 FastAcq
快速擷取模式可減少波形擷取之間的停工時間，以便擷取並顯示暫態訊號 (如突波或矮波脈衝)。快速擷取模
式也可反應發生率之強度來顯示波形狀態。FastAcq 不適用於 ATI 通道和某些儀器配置。

1. 按下選配前面板上的 FastAcq，或選
取「Horiz/Acq > Fast Acquisition」(水
平/擷取 > 快速擷取)。

2. 尋找突波、暫態訊號或其他隨機突
波。

當您注意到異常狀況時，請設定觸
發系統來尋找它。請參閱 擷取間
歇性異常在頁面上179。 

快速秘訣

■ 若要讓擷取詳細資訊或罕見事件達到最佳化，請選取「Horiz/Acq > Horizontal/Acquisition Setup > Acquisition>
Fast Acq」(水平/擷取 > 水平/擷取設定 > 擷取 > 快速擷取)，然後針對「Capturing Details」(擷取詳細資訊)
或「Capturing rare events」(擷取罕見事件) 選取「Optimize」(最佳化)。
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使用 DSP 加強型頻寬

如果儀器擁有加強型頻寬功能，您便可使用 DSP (數位訊號處理) 加強型頻寬進行更精確的上升時間量測，以
便擴充頻寬及拉平高取樣率時的帶通頻率。「加強型頻寬」可讓啟用的通道產生配比響應，供您執行通道至
通道比較及不同測量。

1. 使用「AUTOSET」(自動設定) 來設定
水平、垂直和觸發控制項，或是手
動設定控制項。

2. 選取「Vertical > Bandwidth
Enhanced...」(垂直 > 加強型頻寬...)。
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3. 按一下 「Digital Filters (DSP)
Enabled」(啟用數位濾波器 (DSP))，
開啟加強型頻寬。必須設定正確的
取樣率，才能啟用 DSP。

4. 若要強制執行可啟用 DSP 濾波器的
常態取樣率，請勾選 「Force
Constant Sample Rate 」(強制常態取
樣率)。

注意。 若尚未設定，請選取「常態
取樣率」，將水平模式設定為常態取
樣率、將取樣率設定為允許 DSP，
並選取 DSP 頻寬。

 

5. 從 「Bandwidth 」(頻寬) 清單中選取
所需要的頻寬。

可用的頻寬選項取決於儀器、探棒
和探棒頭。 

選取 Analog Only (僅類比)，選取硬體
頻寬。 

6. 若要將這些選擇套用到所有波道，
請勾選 「Apply To All Channels 」(套
用到所有波道)。

如果探棒不同，儀器則無法將所有
波道設定成相同，但儀器會為每個
波道設定最接近的可能頻寬值。 

當加強型頻寬啟動時，頻寬指示器將顯
示於垂直讀數中。 

快速秘訣

■ 在波形拖曳點上按一下滑鼠右鍵叫出功能表，選取波道頻寬和其他加強型頻寬設定。

■ DSP 加強型頻寬發生於最大取樣率。

■ 請在訊號上升時間小於 50  ps 時使用 DSP 加強型頻寬。

■ 如果要產生較多波形輸送量、過激訊號，或是您偏好使用自訂的 DSP 後置處理時，請選取 Analog Only (僅
類比)。

■ 若要限制儀器頻寬，請選取 Vertical > Bandwidth Limit (垂直 > 頻寬限制)，再選取頻寬。
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設定終端電壓

以往示波器輸入會以終端接地。訊號量測時通常未經接地參考。將訊號拉至接地可能會對量測結果造成負
面影響或可能損壞 DUT。終端電壓適用於 TekConnect 通道，而不適用於 ATI 通道。

儀器對待測試中裝置 (DUT) 提供最多 ±3.5 伏特的可變終端電壓，並支援較大的偏移範圍。這可讓您調整示波
器以反映 DUT 的條件和行為，並在類似於儀器運作的環境中量測高速訊號。

使用終端電壓和偏移的組合以集中 DUT 操作範圍中的示波器參考點，可讓適用的動態範圍達到最大，並讓量
測系統的雜訊降到最低。

若要設定通道的終端電壓，請執行下列步驟：

1. 選取「Vertical > Vertical Setup」(垂直
> 垂直設定)。

2. 按一下「Termination Voltage」(終端
電壓) 欄位。使用鍵盤或多功能旋
鈕設定終端電壓。
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使用捲動模式
捲動模式將顯示類似低頻訊號的紙條圖表記錄器之畫面。捲動模式會直接顯示已擷取的資料點，而不用等候
擷取到完整的波形記錄。

1. 選取「Horiz/Acq > Horizontal/
Acquisition Setup...」(水平/擷取 > 水
平/擷取設定...)。

2. 如果沒有選取的話，請按一下
「Acquisition」(擷取)索引標籤。按一
下「Auto」(自動) 便可開啟捲動模
式。

注意。 捲動模式需要配合「取樣」、
「峰值檢測」或「高解析度」等擷取
模式。

 

3. 如果要在「捲動」模式停止擷取：

■ 如果您並未處於單次序列模
式，請選取「Horiz/Acq > Run/
Stop」(水平/擷取 > 執行/停止)，
然後按一下「Run/Stop」(執行/
停止)，或按下輔助前面板上的
「RUN/STOP」(執行/停止) 以停整
捲動模式。

■ 如果是使用單次程序模式，捲
動模式擷取會在擷取到完整記
錄時自動停止。

 

快速秘訣

■ 切換至「包封」、「平均」或「波形資料庫」(WfmDB) 擷取模式將會關閉捲動模式。

■ 如果水平刻度設定為 50  ms/div 或更快時，捲動模式將會停用。

■ 使用多單元配置時，會停用捲動模式。
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設定匯流排
您可以設定串列 (選配) 和並列匯流排。

1. 選取「Vertical > Bus Setup」(垂直 >
匯流排設定)。

2. 選取「Config」(設定) 索引標籤。

3. 捲動然後選取要設定的匯流排。

4. 若要開啟或關閉匯流排的畫面，請
按一下「Bus」(匯流排) 按鈕。

5. 若要變更匯流排的預設標籤，請按
一下「Label」(標籤) 並使用鍵盤來
輸入新標籤。

6. 若要變更顯示的匯流排位置，請按
一下「Bus Position」(匯流排位置) 並
使用鍵盤或多功能旋鈕來輸入新的
匯流排位置。
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7. 若要選取匯流排類型，請按一下
「Bus Type」(匯流排類型) 的「Serial」

(串列) 或「Parallel」(並列)。

您可以設定每個匯流排類型。 

請參閱設定串列匯流排在頁面上
70 或設定並列匯流排在頁面上
71。 

快速秘訣

■ 按一下匯流排或波形拖曳點，並將拖曳點拖曳到所需的位置，可設定匯流排或波形的位置。

 擷取

DPO70000SX 系列使用者 69



設定串列匯流排
您可以設定串列 (選購) 匯流排參數。 

1. 若要設定串列匯流排，請選取「Bus
Type」(匯流排類型) 的「Serial」(串
列) ，並從下拉式清單中選取串列匯
流排類型。

每個匯流排類型都擁有您設定的專
屬參數集合。為選取的匯流排設定
其他適當的匯流排類型。 

請參閱線上說明，以取得設定匯流
排的詳細說明。 

2. 若要為顯示的匯流排元件選取輸
入，請按一下「Component」(元件)
的「Input」(輸入) 並從顯示的清單
中選取。

3. 若要設定輸入臨界值，請按兩下
「Threshold」(臨界值) 並使用鍵盤輸
入臨界值。

注意。 若要個別設定目前為共用
的臨界值，請移至「Trig > A Event
(Main) Trigger Setup」(觸發 > A 事件
(主要) 觸發設定)，並將「Settings」
(設定) 變更為「Independent」(獨立)。

 

4. 若要為顯示的匯流排元件選取極
性，請按一下「Component」(元件)
的「Polarity」(極性) 並從顯示的清
單中選取。

快速秘訣

■ 若要使用自訂串列解碼器，請參閱線上說明。
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設定並列匯流排
您可以設定並列匯流排參數。 

1. 若要設定並列匯流排，請選取「Bus
Type」(匯流排類型) 的「Parallel」(並
列)。

請參閱線上說明，以取得設定匯流
排的詳細說明。 

2. 若要將來源新增到匯流排。請按一
下「Add Sources」(新增來源) 的
「Select」(選取) 按鈕。

3. 按一下每個您要於匯流排中使用的
波道按鈕。並列匯流排的順序是由
您選取波道的順序所決定的。

4. 按一下「OK」(確定) 按鈕。

5. 若要移動匯流排中的波道，請捲動
到您要移動的波道並選取該波道，
然後按一下向上或向下箭頭按鈕。

6. 若要移除匯流排中的波道，請捲動
到您要移除的波道並選取該波道，
然後按一下「Remove」(移除) 按鈕。

7. 若要設定波道臨界值，請按一下
「Thresholds」(臨界值) 的「Setup」

(設定) 按鈕。
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8. 針對您要設定的每個臨界值按兩下
通道的「Threshold」(臨界值)，並使
用輔助前面板上的鍵盤或多功能旋
鈕輸入臨界值。

9. 設定所需的臨界值之後，按一下
「OK」(確定) 按鈕。

10. 若要設定時脈來源和極性，按兩下
該項目並從顯示的清單中選取。
若要設定時脈位準，請按兩下「Clock
Level」(時脈位準)，並使可選用輔助
前面板上的鍵盤或多功能旋鈕輸入
位準。
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設定匯流排畫面
您可以設定匯流排樣式和解碼。 

1. 選取「Vertical > Bus Setup」(垂直 >
匯流排設定)。

2. 選取「Display」(顯示) 索引標籤。

3. 若要選取匯流排，請捲動以顯示匯
流排，然後選取該匯流排。

4. 從匯流排解碼清單中選取解碼。

請參閱線上說明中有關「結果表」
的資訊。 

5. 按一下 + 方塊可展開 (顯示其他) 檢
視，或者按一下 - 方塊收合 (移除)
檢視。

6. 按一下顯示器中的 + 或 - 方塊，也可
新增或移除顯示器中的匯流排檢
視。系統提供的檢視可能包括異
動/傳輸、連結/圖框/封包、實體/位
元組/符號和位元位準。

 擷取

DPO70000SX 系列使用者 73



7. 如果要使用符號表格，請勾選「Use
Symbol File」(使用符號檔案)。按一
下「Browse」(瀏覽) 並找到符號表
格檔案。

部分匯流排有其他可供使用的設
定。為您的匯流排設定適合的其他
設定。 

請參閱線上說明，以取得設定匯流
排的詳細說明。 

使用 FastFrame 模式
「快速圖框擷取」可在大筆記錄中將眾多觸發事件一筆一筆地擷取，並在之後分別檢視和量測每筆記錄。 時
戳可以顯示特定訊框的絕對觸發時間，以及兩個指定訊框觸發之間的相對時間。

1. 使用「AUTOSET」(自動設定) 來設定
水平、垂直和觸發控制項，或是手
動設定控制項。

2. 選取「Horiz/Acq > FastFrame Setup...」
(水平/擷取 > FastFrame 設定...)。
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3. 按一下「FastFrame」(快速圖框)，以
將其切換為「On」(開啟)。

4. 選取「Frame Size」(圖框尺寸) 與「#
of Events Frames」(事件圖框的數
目)。接著使用多用途旋鈕來設定
每一筆記錄。圖框數目代表擷取之
觸發事件的數目。 訊框尺寸代表
每次觸發事件 (或訊框) 所要儲存的
取樣數目。如果記憶體不夠儲存所
有記錄，圖框數目就會減少。圖框
長度越短，可擷取的圖框數目就越
多。

5. 使用「圖框檢視」(Frame Viewing) 控
制項來選取要檢視的圖框。

6. 如果要檢視互相重疊的多個圖框，
請選取「重疊」(Overlay)。

7. 使用「時戳」(Time Stamps) 控制項來
選取參考圖框的來源和圖框數目。
參考圖框是指量測二個圖框之間相
對時間所使用的起始點。

快速秘訣

■ 當您要保留每次觸發事件的相關資料以供日後分析或目視檢驗時，請使用「快速圖框」功能。

■ 當您想要擷取長停工時間中不特定的多個事件，請使用快速圖框功能。

■ 檢視多層圖框時最好是使用一般、綠色或灰色調色盤。因為使用「溫度」或「頻譜」時，所選取的深藍
色圖框可能不易辨識。
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■ 如果您選取「Average Summary Frame」(平均摘要圖框)，即可將數學功能 (計算平均值) 設定為套用至「All
Frames」(所有圖框)，或是僅將該功能套用至摘要圖框。如果您主要是要想觀察摘要資料，則選取「Summary
Frame Only」(僅摘要圖框) 可以大幅提升系統輸送量。
 

 

使用 FastFrame 訊框搜尋工具
訊框搜尋工具可讓您尋找與其他訊框不同的 FastFrame 訊框。

1. 選擇 FastFrame 訊框來源。

2. 輸入 「From Frame # 」(起始圖框編
號) 和 「To Frame # 」(結束圖框編
號) 以設定「搜尋範圍」。

3. 選取「Horiz/Acq > Run/Stop」(水平/
擷取 > 執行/停止)，並按一下「Run/
Stop」(執行/停止)，或按下輔助前面
板上的「Run/Stop」(執行/停止) 以停
止擷取。

4. 按下「Start」(開始) 以開始搜尋。
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訊框搜尋工具會搜尋和顯示不同的訊
框。 

5. 如果您所尋找的異常不在顯示的訊
框中，請按下「No」(否)。 訊框搜
尋工具會搜尋其他不同的訊框。

6. 如果您所尋找的異常在顯示的訊框
中，請按下「Yes」(是)。

7. 如果您完成搜尋，則按下 「Stop 」
(停止)。

8. 選取「Horiz/Acq > Run/Stop」(水平/
擷取 > 執行/停止)，並按一下「Run/
Stop」(執行/停止)，或按下輔助前面
板上的「Run/Stop」(執行/停止) 以重
新啟動擷取。

 擷取

DPO70000SX 系列使用者 77



擷取  

78  DPO70000SX 系列使用者



Pinpoint 觸發

Pinpoint 觸發系統提供了 A 和 B 觸發都可應用的進階觸發方式。如果 B 事件沒有在特定事件數或特定時間之
後觸發，它可重置觸發程序。Pinpoint 觸發可依據最複雜的觸發事件或觸發事件程序來支援擷取事件。

本節將介紹使用此觸發系統的概念和程序。

觸發概念

觸發事件

觸發事件會建立波形記錄中的時序零點。所有的波形記錄資料皆依時序零點的時間來定位。 本儀器會持續
擷取並保留足夠的取樣點，來填滿波形記錄的前置觸發部分。 當觸發事件一出現，儀器就會開始擷取取樣，
建立波形記錄的後置觸發部分 (也就是在觸發事件之後或其右邊的顯示部分)。 除非已完成擷取且延滯時間
已到期，否則儀器在確認觸發後就不會接受其他觸發。

觸發模式

若觸發事件沒有出現，觸發模式會決定示波器應採取的行動：

■ 一般觸發模式限制示波器只在被觸發時才擷取波形。如果沒有觸發事件，顯示畫面將一直顯示上次擷取
到的波形記錄。如果上次沒有擷取任何波形，螢幕將不顯示任何波形。

■ 自動觸發模式將使示波器自動擷取波形，即使沒有任何觸發。自動模式使用觸發事件發生之後開始的計
時器。若是在計時器逾時之前還未偵測到其他觸發事件，示波器就會強制觸發。觸發事件的等候時間長
度取決於時基設定。

自動模式缺乏有效觸發事件時所強制進行的觸發，不會和顯示畫面中的波形同步。該波形會在整個螢幕上捲
動。如果發生了有效觸發，顯示畫面就會穩定下來。

在邊緣觸發模式中，按下「Trigger Setup」(觸發設定) 控制視窗上的「Force Trigger」(強制觸發) 按鈕可強制儀
器觸發。

在「Trig > Mode」(觸發 > 模式) 功能表中選取觸發模式。 如需更多資訊，請參閱儀器線上說明。

觸發閉鎖

觸發延滯有助於穩定觸發，藉由延長觸發期間，可在啟動擷取之後抑制進一步的觸發辨識。 這樣的延長可幫
助系統跳過循環脈衝事件的剩餘事件，如此一來，就可使每一次的脈衝皆在第一個事件時觸發。在示波器觸
發到不想要的觸發事件時，請調整延滯，以保持穩定觸發。

在「Trig > Holdoff」(觸發 > 延滯) 功能表中設定觸發延滯。 如需更多資訊，請參閱儀器線上說明。
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觸發耦合

觸發耦合會決定要將哪個訊號部份傳遞給觸發電路。邊緣觸發可使用所有的耦合類型： 交流、直流、低頻排
斥、高頻排斥、雜訊排斥和射頻耦合。所有其餘觸發類型只能使用「DC 耦合」。您的儀器可能不會提供所有
的耦合類型。

在「Trig > A Event (Main) Trigger Setup」(觸發 > A 事件 (主要) 觸發設定) 功能表中選取觸發耦合。 如需更多資訊，
請參閱儀器線上說明。

水平位置

水平位置可定義波形記錄中觸發的發生位置。您可透過它來選擇儀器在觸發事件前後所要擷取的時間。 在
觸發之前所發生的記錄部分，就是前置觸發部分。 在觸發之後發生的部分，即為後置觸發部分。

前置觸發資料有助於故障排除。 例如，如果您想了解為何測試電路產生不想要的突波，請在該突波發生時觸
發，並加長前置觸發期間到足以擷取突波之前的資料。您可以分析該突波之前發生哪些現象，找出一些資訊
來研究其發生原因。 此外，若要了解觸發事件會對系統造成哪些影響，請加長後置觸發期間到足以擷取觸發
後的資料。

斜率和位準

斜率控制項定義示波器找到訊號上升緣和下降緣的觸發點。 位準控制項決定觸發點在邊緣上的發生位置。

延遲的觸發系統

您可單獨觸發 A (主要) 觸發系統，或是結合 A (主要) 觸發和 B (延遲) 觸發來觸發次序事件。如果是使用次序觸
發，A 觸發事件會啟動觸發系統。而當 B 觸發條件符合時，B 觸發事件就會觸發儀器。A 和 B 觸發可以 (通常
也是如此) 具有不同的來源。B 觸發條件是根據時間延遲或特定事件數。 請參閱使用 A (主要) 和 B (延遲) 觸
發在頁面上85。
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選擇觸發類型
本儀器讓您可從輔助前面板修改基本的觸發參數，或在「Trigger Setup」(觸發設定) 控制視窗中設定更多進階
的觸發。

注意。 某些觸發類型選項不適用於某些儀器。

1. 選取「Trig > Edge Setup」(觸發 > 邊
緣設定)。

2. 使用設定功能表設定來源、斜率、
耦合和模式。
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3. 若要選取其他的觸發類型之一，請
直接從「Trig」(觸發) 功能表選取觸
發類型。

4. 使用顯示觸發類型的控制項，完成
觸發設定。用來設定觸發的控制
項，將依觸發類型、儀器機型與選
項而有所不同。
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觸發選項

觸發類型 觸發條件

邊緣 請依斜率控制項的定義，觸發上升或下降邊緣。耦合選擇可為直
流、交流、低頻排斥、高頻排斥、雜訊排斥和射頻。

突波 觸發比指定寬度更窄 (或更寬) 的脈波，或是忽略比指定寬度更窄
(更寬) 的突波。

寬 觸發指定時間範圍內∕外的脈波。您可在正脈波或負脈波上觸發。

矮波 觸發一脈波振幅。它可與第一個臨界值交叉，但再度交叉第一個
臨界值之前，無法與第二個臨界值相交。您可以偵測正矮波或負
矮波，或是只偵測比指定寬度還寬的矮波。這些脈波也可以被其
他通道的邏輯狀態限定。在多儀器配置上，此觸發適用於對應通
道。

視窗 當輸入訊號高於上方臨界水平或低於下方臨界水平時觸發。當
訊號正在進入或離開臨界視窗時觸發儀器。請使用「較寬時觸
發」(Trigger When Wider) 選項，以時間來限定觸發事件。或視其他
通道的邏輯狀態而使用「邏輯時觸發」(Trigger When Logic) 選項。
在多儀器配置上，此觸發適用於對應通道。

逾時 在指定時間內沒有偵測到任何脈波時觸發。在多儀器配置上，此
觸發適用於對應通道。

轉換 當脈波邊緣穿越兩個臨界值間的速率快/慢於指定時間時，觸發脈
波邊緣。這種脈波邊緣可為正向或負向。在多儀器配置上，此觸
發適用於對應通道。

碼型 當邏輯輸入值使選定的函數成為 TRUE 或 FALSE 時觸發。您也可
以指定：邏輯條件必須滿足特定次數後才觸發。在多儀器配置
上，此觸發無法使用。

狀態 當所有邏輯輸入值使選定的函數成為 True 或 False 且時脈輸入值
變更狀態時觸發。在多儀器配置上，此觸發無法使用。

設定∕保持 當邏輯輸入值在與時脈相關的設定時間及保持時間內改變狀態
時觸發。模式在設定和保持違反時觸發。在多儀器配置上，此觸
發無法使用。

串列
 

 

以高達 14.1Gb/s 的資料速率觸發高達 160 位元的 8b/10b 符號。
需要選項 ST14G。包含時脈還原。按下「Push to Set 50%」(按下設
定 50%) 控制項可重新初始時脈還原。

匯流排 觸發您要定義的匯流排元件 (例如指定的位址)。在某些儀器、儀
器配置和選項中，觸發類型包括並列、8b10b、SPI、RS-232、USB 和
I2C 觸發。

頻率/週期 在指定時間或頻率範圍時觸發。在多儀器配置上，此觸發適用於
對應通道。
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檢查觸發狀態

從讀數或輔助前面板上的狀態燈查看觸發狀態。

 

若要快速判斷某些重要觸發參數的設
定，請檢查螢幕下方的觸發讀值。 邊緣
觸發和進階觸發的讀數不同： 

1. A 觸發源 = Ch3

2. 觸發斜率 = 上升邊緣

3. 觸發位準 = 250 mV

4. 時基

5. 查看 ARM、READY 和 TRIG'D 來判斷
觸發狀態。

6. 查看觸發選項功能表來判斷觸發模
式。

查看 ARM、READY 和 TRIG'D 等前面板控
制鈕來判斷觸發狀態。 

■ 如果 TRIG'D 燈亮起，表示儀器已確
認有效的觸發，且正在建構波形的
後置觸發部分。

■ 如果 READY 燈亮起，表示儀器可接
受並正在等候有效的觸發發生。前
置觸發資料已取得。

■ 如果 ARM 燈亮起，表示觸發電路正
在建構波形記錄的前置觸發部分。

■ 如果 TRIG'D 和 READY 都亮燈，表示
已確認有效的 A 事件觸發，而且儀
器正在等候延遲觸發。 確認延遲
觸發後，將建構延遲波形的後置觸
發部分。

■ 如果 ARM、TRIG'D 和 READY 燈都沒
有亮起，表示擷取已經停止。
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使用 A (主要) 和 B (延遲) 觸發

您可以單獨使用簡單訊號的 A 事件 (主要) 觸發，或將它結合 B 事件 (延遲) 觸發以擷取較複雜的訊號。A 事件
發生之後，觸發系統會先尋找 B 事件，然後才觸發和顯示波形。

A 觸發 

1. 選取「Trig > A Event (Main) Trigger
Setup...」(觸發 > A 事件 (主要) 觸發
設定...)。

2. 在「A Event」(A 事件) 索引標籤中設
定 A 觸發類型和來源。

B 觸發 (延遲) 

注意。 在多單元系統中，A 和 B 觸發源
都必須來自相同的單元。

 

3. 在 A →B Seq (A →B 次序) 索引標籤
中選擇函數。

4. 設定觸發延遲時間或 B 事件數量。

5. 在 B Event (Delayed) (B 事件 (延遲))
索引標籤中設定 B 觸發特性。
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6. 在 Mode (模式) 索引標籤中，選取
「Normal 」(一般) 觸發模式和
「Auto 」(自動) 延滯。

在 B 事件發生時觸發

A 觸發會啟動示波器。後置觸發擷取開
始於第 n 個 B 事件。 

在延遲時間之後啟動 B 觸發

A 觸發會啟動示波器。在觸發延遲時間
之後的第一個 B 邊緣上開始後置觸發擷
取。 

預觸開啟 A 之後 B 觸發

在預觸示波器以觸發開啟一或多個 B 事
件之前，預觸開啟 A 觸發開啟 B 示波器
會等候 A 事件發生 (一次)。  
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Arm-on-A 然後 Trigger-on-B (水平延遲開啟)
在預觸示波器以觸發開啟一或多個 B 事件之前，預觸開啟 A 觸發開啟 B 示波器會等候 A 事件發生 (一次)。

從「Trig」(觸發) 功能表選取 A - B 觸發序列。

概要。 使用此視窗中的控制來定義 A ->B 次序觸發的參數，並將「Horizontal Delay」(水平延遲) 開啟。
 

 

若要使用這項功能。。

1. 從其個別索引標籤設定 A 事件和 B 事件。

2. 選取「A>B Seq」(A>B 次序) 索引標籤；然後按一下「Arm on A Trig on B」(預觸開啟 A 觸發開啟 B)。

3. 將「Horizontal Delay Mode」(水平延遲模式) 按鈕設為「On」(開啟)。

4. 使用「Acquisition Delay」(擷取延遲) 和「Reference Point」(參考點) 項目方塊來延遲與 A 事件觸發相關的擷
取。

5. 視需要使用「Horizontal」(水平) 位置控制和「B Trig Level」(B 觸發位準) 控制。
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行為。 當您在預觸示波器以觸發開啟一或多個 B 事件之前，選取預觸開啟 A 觸發開啟 B 示波器會等候 A 事件
發生 (一次)。一旦預觸後，示波器不會返回尋找 A 事件。
 

 

您可以在獨立式示波器或是在示波器 TimeSync 或 UltraSync 堆疊上使用「Arm on A Trig on B」(預觸開啟 A 觸發開
啟 B) 方法。可用於「Single Step」(單一步驟) 或「Continuous Acquisitions」(連續擷取)。可搭配 FastFrame 或一般
擷取使用。

使用示波器堆疊時，擷取的通道會對應堆疊中每個示波器的一個通道)。若要發揮這些擷取通道的最大用途，
可使用主要示波器未對應通道來觸發。堆疊主要示波器上的未對應通道是設計為使用者介面或可程式化介
面中的 MCh1、MCh2、MCh3 或 MCh4。使用示波器堆疊時，這些通道可供觸發。它們僅在「Stack Master」(堆
疊主要) 上。

在 ATI 示波器上，Ch2、MCh1 和 MCh3 可供觸發。在 4 通道示波器上，Ch1、MCh2、MCh3 和 MCh4 可供觸發。

垂直設定控制視窗 (M Chx 索引標籤)
從「Vertical」(垂直) 功能表，選取「Vertical Setup」(垂直設定)；然後開啟 M Chx 索引標籤。
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概要。 使用 Arm-on-A Trigger-on-B 次序觸發時，請設定觸發所使用的每個未對應通道之「最小」和「最大振
幅」值。
 

 

使用此控制視窗來設定 UltraSync 堆疊主要示波器上未對應通道的最小和最大振幅垂直設定。這會配置示波
器，因此這個範圍中的訊號會盡可能提供不包含截波或其他非線性的最大觸發激發。請務必將這些最小/最大
振福設定對應到測試下的實際訊號。

在示波器堆疊中，對應通道是用來擷取資料的 (堆疊中每個示波器有一個通道)。堆疊中其中一個示波器上的
對應通道也可用來觸發。堆疊主要上的未對應通道也可供觸發。並未擷取這些通道，因此不會顯示這些通道
的任何波形。這些通道是指定為 MCH1、MCH2、MCH3 和 MCH4。在 ATI 堆疊上，CH2、MCH1 和 MCH3 可供觸
發。在 4 通道堆疊上，CH1、MCH2、MCH3 和 MCH4 可供觸發。

請注意，並未擷取這些未對應通道的波形，因此無法在示波器螢幕上看到。若要判斷測試訊號下的裝置最
小/最大振幅的最佳值，請暫時將主要示波器移開堆疊、測量值，然後將主要示波器放回 UltraSync 堆疊內。

重設觸發

您可以指定當某條件在 B 觸發事件前發
生時，便重置觸發系統。重置事件發生
後，觸發系統即停止等候 B 事件，並恢
復成等候 A 事件。 

快速秘訣

■ B 觸發延遲時間和水平延遲時間是各自獨立的功能。當您單獨使用 A 觸發或同時使用 A 和 B 觸發建立觸
發情況時，您也可以使用水平延遲進行額外數量擷取的延遲。
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更正觸發位置

「觸發位置更正」可更正資料路徑和觸發路徑上的偏差，更精確地將觸發放在顯示的波形上。「觸發位置更
正」也可使用平均，更精確地將觸發放在雜訊訊號上。 若要更精確地將邊緣觸發放在顯示器上，請執行下列
程序。

1. 若要更精確地將觸發放在畫面上，
請勾選「Enhanced Triggering」(加強
型觸發)。若要更精確地將觸發放
在雜訊訊號上，也請勾選「Optimized
for Noisy Signals」(針對雜訊訊號最
佳化)。

若要勾選 「Optimized for Noisy
Signals 」(針對雜訊訊號最佳化)，必
須先勾選 「Enhanced Triggering 」
(加強型觸發) 。 
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使用 B 事件掃描進行觸發

使用「A->B 序列」的「B 事件掃描」以建立由 A 觸發事件進行同步化和初始化的重疊眼狀圖。

「在第 n 個事件觸發」會針對所有擷取來擷取發生於 A 事件之後的第 n 個 B 事件。「B 事件掃描」會自動提高
B 事件的值以擷取不同部分的訊號。

1. 在「A Event」(A 事件) 索引標籤中設
定 A 觸發類型和來源。

2. 在「B Event」(B 事件) 索引標籤中設
定 B 觸發類型和來源。

3. 若要更精確地將觸發放在畫面上，
請勾選「Enhanced Triggering」(加強
型觸發)。若要更精確地將觸發放
在雜訊訊號上，也請勾選「Optimized
for Noisy Signals」(針對雜訊訊號最
佳化)。

4. 在「A>B Seq」(A>B 次序) 索引標籤
中，選取「Trig on nth Event」(在第 n
個事件觸發) 和「B Event Scan」(B 事
件掃描)。

5. 若要顯示「B Event Scan Setup」(B 事
件掃描設定) 視窗，請按下「B Event
Scan > Setup」(B 事件掃描 > 設定)。
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6. 設定 B 事件開始值。

7. 設定 B 事件結束值。

8. 設定 B 事件值遞增前的擷取次數。

9. 選取在所選擷取次數到達後 B 事件
值會遞增的方法：

「Sequential Scan」(次序掃描) 以 1 遞
增直到達到「結束事件」。達到「End
Event」(結束事件) 時，會將 B 事件
值重設為「Start Event」(開始事件)
值並重新開始程序。 

「Random Scan」(隨機掃描) 會針對
每一組「Advance After」(在此事件後
提高) 擷取將 B 事件值設定為介於
「Start Event」(開始事件) 和「End

Event」(結束事件) 之間的隨機值。 

「Toggle Between Events」(切換事件)
可針對每一組「Advance After」(在此
事件後提高) 擷取將 B 事件值在
「Start Event」(開始事件) 和「End

Event」(結束事件) 之間切換。 
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10. 在這個範例中，DDR3 DQS 訊號是在
Ch 1 上，DQ 訊號則在 Ch 2 上。儀器
為「Run Mode」(執行模式)，且「Display
Mode」(顯示模式) 設為「Infinite
Persistence」(無限持續累積)。儀器
的觸發設定如下：

Ch 1 上的「A 事件視窗觸發」以檢測
DDR3 DQS 寫入條件。  

Ch 1 上「任一斜率的 B 事件邊緣觸
發」以在 DQS (時脈) 邊緣觸發。 

A -> B 序列設定為「在第 n 個事件觸
發」。  

B 掃描以開始事件啟動 = 1、結束事
件 = 8 而模式 = 次序。 

資料眼是由 Ch2 上的 DQ 訊號組成。
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在並列匯流排上觸發

在並列匯流排上觸發以找出問題。

1. 設定並列匯流排。請參閱設定匯流
排在頁面上 68。 選取「Trig > A
Event (Main) Trigger Setup...」(觸發 >
A 事件 (主要) 觸發設定...)。

2. 選取「A Event」(A 事件) 索引標籤。

3. 選取「Bus」(匯流排) 觸發類型。
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4. 選取要觸發的匯流排。

注意。 如果時脈來源設定為 Ch4，
則時脈匯流排僅會顯示在下拉式清
單中。

 

5. 按一下「Edit」(編輯) 按鈕以設定您
要觸發的樣式和格式。

6. 選取資料格式。

7. 使用鍵盤來設定要觸發的樣式。
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8. 分析您的波形。

在串列匯流排上觸發

在串列匯流排上觸發以找出問題。

設定串列匯流排。請參閱設定匯流排在
頁面上 68。 

1. 選取「Trig > A Event (Main) Trigger
Setup...」(觸發 > A 事件 (主要) 觸發
設定...)。

2. 選取「A Event」(A 事件) 索引標籤。
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3. 選取「Bus」(匯流排) 觸發類型。

4. 選取匯流排。

5. 選取要觸發的匯流排訊號。

6. 根據您的「Trigger On」(觸發開啟) 選
擇和匯流排類型，請為匯流排選擇
必要的選項。

請參閱線上說明，以取得設定匯流
排的詳細說明。 
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使用視覺觸發進行觸發 (視覺觸發)
視覺觸發可允許您直接在顯示螢幕上建立觸發條件。 (視覺觸發為可供部分機型使用的選項。)

1. 使用左鍵按一下並拖曳螢幕上的方
塊以建立視覺觸發區域。然後從功
能表選取「Add Visual Trig Area」(新
增視覺觸發區域)。

注意。 此功能表能讓您隱藏或顯
示所有視覺觸發區域，並可切換開
啟或關閉視覺觸發。

 

2. 按一下區域以啟用拖曳點。 按一
下並拖曳區域以將該區域移至新位
置。 按一下並拖曳其中一個區域
拖曳點以垂直、水平或雙向調整區
域的大小。

3. 在視覺觸發區域按一下滑鼠右鍵，
並從功能表選取「Visual Trigger Area」
(視覺觸發區域)。

使用視覺觸發功能表編輯觸發區域
和設定視覺觸發的條件。 

請參閱線上說明，以取得關於建立
和編輯視覺觸發的詳細資訊。 
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4. 從「Trig」(觸發) 功能表，選取「Visual
Trigger Setup」(視覺觸發設定)，然後
按兩下「Visual Trigger」(視覺觸發)
公式。

請參閱線上說明，以取得關於使用
合格運算式編輯器的詳細資訊。 
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設定依事件採取動作
依事件採取動作可允許您配置示波器，以在定義的事件 (例如觸發事件、遮罩測試失敗和極限測試失敗) 發生
時儲存各種檔案。

1. 選取「File > Action on Event」(檔案
> 依事件採取動作)。

2. 選取要使用的事件。

3. 選取事件發生時所採取的動作。選
取「Save」(儲存)、「Send E-mail」(傳
送電子郵件) 或兩者皆選。

使用「Setup」(設定) 按鈕 (「Save」
(儲存) 旁) 以顯示「Save on Event
Setup」(依事件儲存設定) 顯示螢
幕。 

使用「Setup」(設定) 按鈕 (「Send E-
mail」(傳送電子郵件) 旁) 以顯示
「Send E-mail Setup」(傳送電子郵件設
定) 顯示螢幕。請參閱 設定依事件
發出電子郵件在頁面上102。 

4. 輸入儲存檔案的位置。

5. 選取開始儲存的事件。

6. 選取事件發生時所儲存的檔案類
型。

7. 設定所使用的檔案命名慣例。

8. 設定要儲存的事件數。
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依觸發傳送電子郵件
您必須先設定「依事件發出電子郵件」，才能執行下列程序。 請參閱設定依事件發出電子郵件在頁面上102。

1. 選取「Trig > A Event (Main) Trigger
Setup...」(觸發 > A 事件 (主要) 觸發
設定...)。

2. 選取「Mode」(模式) 索引標籤。

3. 在 E-mail on Trigger (依觸發傳送電子
郵件) 表下，按一下「On」(開啟)，
再按一下「Setup」(設定) 。請參閱 
設定依事件發出電子郵件在頁面上
102。
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設定依事件發出電子郵件

1. 選取「Utilities > E-mail on Event >
Setup...」(公用程式 > 依事件發出電
子郵件 > 設定...)。

2. 輸入收件人的電子郵件地址。使用
逗號分隔多個地址項目。電子郵件
地址方塊的長度限制是 252 個字
元。

3. 按一下「Config」(組態)，然後輸入
SMTP 伺服器位址。請聯絡網路管
理員取得正確位址。
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4. 選取當發生時要發送電子郵件的事
件。

5. 如果要包含附件，請選取附件類型，
再按一下「Settings」(設定) 來指定
格式。

6. 設定最大訊息限制和電子郵件大
小。如果已到達最大訊息限制，您
必須按一下「Reset」(重設)，才能
再依事件發出電子郵件。

7. 若要驗證您設定的電子郵件地址無
誤，請按一下「Send」(傳送) 來傳
送測試郵件。

8. 如有需要，���按一下「Config」
(組態) 來存取電子郵件組態對話方
塊，並調整其組態。
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使用水平延遲

使用水平延遲，可在重要時間間隔分隔
的觸發位置區域中擷取波形細節。 

1. 選取「Horiz/Acq > Horizontal/
Acquisition Setup」(水平/擷取 > 水
平/擷取設定)。

2. 按下「Delay Mode」(延遲模式) 按
鈕，將延遲模式切換成開啟。

3. 使用水平「POSITION」(位置) 控制項
來調整延遲時間，或在控制視窗輸
入延遲時間。

4. 調整水平「SCALE」(刻度) 來擷取所
需細節。

快速秘訣

■ 您可同時使用 MultiView 縮放和水平延遲功能來放大延遲的擷取。

■ 開啟和關閉水平延遲功能，便可快速比較在兩個不同重要區域的訊號細節。一個是接近觸發區域，另一
個則位在延遲時間的中央。
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顯示波形
本節將介紹顯示波形的概念和程序。線上說明將提供詳細資訊。

設定顯示樣式

若要設定顯示樣式，請選取「Display >
Display Style」(顯示 > 顯示樣式)，然後
選取下列其中一種樣式：  

向量。 在記錄點之間畫線來顯示波
形。 

點。 將波形記錄點顯示為螢幕上的
點。 

增亮樣值。 顯示實際取樣。不顯示內
插產生的點。 
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設定顯示持續累積

選取「Display >Display Persistence」(顯示
> 顯示持續累積)，然後選取持續累積類
型。 

■ 「不持續」設定將只顯示目前擷取的
記錄點。每筆新的波形記錄都會取
代前一個擷取到的通道記錄。

■ 無限餘輝會持續累積記錄點，直到
您改變其中一個擷取顯示設定。用
於顯示出現在一般擷取包封以外範
圍的點。

■ 可變餘輝指定了時間間隔的記錄
點。每個記錄點會根據時間間隔個
別消失。

■ 重設持續累積會清除持續累積。

 

1. 若要設定可變持續累積，請選取
「Display >DisplayPersistence

>Persistence Controls...」(顯示 > 顯示
持續累積 > 持續累積控制項...)。

2. 按一下「Variable」(可變)、「Persist
Time」(持續時間)，再使用多用途旋
鈕來設定持續時間。
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設定顯示格式
本儀器可以顯示二種不同的波形格式。請選擇最適合您需求的格式。

選取「Display >Display Format」(顯示 >
顯示格式)。 

■ 選取 Y-T 格式，可顯示隨時間而不
同的訊號振幅。

■ 選取「XY」格式，可逐點比較波形
記錄的振幅：

在儀器上比較下列通道時不使用
ATI 通道：

Ch 1 (X) 和 Ch 2 (Y)、

Ch 3 (X) 和 Ch 4 (Y)、

Ref 1 (X) 和 Ref 2 (Y)、

Ref 3 (X) 和 Ref 4 (Y)

在儀器上比較下列通道時會使用
ATI 通道：

Ch 1 (X) 和 Ch 3 (Y)
■ 選取 XYZ 格式，便可如同在 XY 格式

般，逐點比較 Ch 1 (X) 和 Ch 2 (Y) 波
形記錄的電壓位準。顯示的波形強
度由 Ch 3 (Z) 波形記錄來調變。觸
發 XYZ 格式。Ch 3 上的 -5 分格訊號
(包含位置和偏移) 產生空白螢幕，
+5 分格訊號產生完全強度。

 

快速秘訣

■ XY 格式在判讀如李塞爾氏圖形 (Lissajous Pattern) 的相位關係時特別有用。

■ XY 格式是僅顯示點的顯示格式，雖然這種格式也具有持續性。如果是選取 XY 格式，「向量樣式」不會產
生任何作用。

 顯示波形

DPO70000SX 系列使用者 107



選取波形內插法

選取「Display >Waveform Interpolation」
(顯示 > 波形內插法)，然後選取下列其中
一個項目： 

■ Sin(X)/X 內插法會應用最佳曲線，計
算出介於實際擷取取樣之間的記錄
點。

■ 線性內插法會應用最適直線，計算
出介於實際擷取取樣之間的記錄
點。

 

快速秘訣

■ Sin(X)/X 內插法是預設的內插模式。比起線性內插法，它在準確呈現波形時所需的實際取樣點數較少。
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新增螢幕文字

1. 選取「Display > Screen Text」(顯示 >
螢幕文字)。

2. 最多可輸入 8 行 (分開) 文字。

3. 按一下 Text (文字) 的 「Off 」(關閉)
或 「On 」(開啟)，便可開啟或關閉
文字顯示。

4. 按一下 「Font 」(字型) 或 「Color 」
(色彩)，便可選取螢幕文字的字型和
色彩。

5. 按一下 「Controls 」(控制)，便可開
啟「文字內容」控制視窗來設定顯
示中的文字位置。

6. 按一下「Clear」(清除)，便可消除選
定行的所有文字。

快速秘訣

■ 可從螢幕上按一下並拖曳螢幕文字，為其重新定位。

■ 您也可以標示波形和匯流排。請參閱 設定匯流排在頁面上 68。
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設定方格圖樣式

若要設定方格圖樣式，請選取「Display
> Graticule Style」(顯示 > 方格圖樣式)，
然後選取下列其中一種樣式：  

用於快速估計波形參數。 

用於不需要十字線時，顯示包含游標和
自動讀值的全螢幕測量值。 

用於快速估計波形，以便留下更多空間
給自動讀值和其他資料。 

用於不需要顯示功能時，顯示自動讀值
和其他螢幕文字。 

用於顯示 NTSC 視頻訊號。 

用於顯示非 NTSC 的其他視訊訊號 
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「Solid」(實線) 與「Full」(完整) 類似，但
格線、十字線和訊框使用實線繪製。 

設定觸發位準標記

1. 選取「Display > Objects...」(顯示 >
物件...)。

2. 選取下列其中一個選項：

■ 選項「Short」(短)：在方格圖旁
邊顯示短箭頭。

■ 選項「Long」(長)：顯示橫跨方
格圖的水平線。

■ 選項「Off」(關閉)：關閉觸發位
準標記。

 

顯示日期和時間

1. 選取「Display > Objects...」(顯示 >
物件...)。

2. 切換方格圖顯示的日期和時間。使
用 Utilities 功能表來設定日期和時
間。
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使用調色盤

選取「Display > Record View Palette」(顯示
> 記錄檢視調色盤) 或「FastAcq/WfmDB
Palette」(FastAcq/WfmDB 調色盤)，然後
針對波形和方格圖選取下列其中一個色
彩組合： 

■ 「一般」選項將顯示最佳整體檢視的
色調和亮度。 每個通道波形的色
彩皆符合輔助前面板垂直旋鈕的對
應色彩。

■ 「溫階」選項會以紅色來顯示出現最
高取樣密度的波形區域。最低取樣
密度的區域則呈現為藍色。

■ 「單色綠色」選項以淺綠色來顯示出
現最高取樣密度的波形區域。最低
取樣密度的區域則呈現深綠色。這
很仿似類比示波器的顯示顏色。

 

■ 「頻譜層次」選項以藍色來顯示出現
最高取樣密度的波形區域。最低取
樣密度的區域則呈現紅色。

 

■ 「單色灰色」選項以淺灰色來顯示出
現最高取樣密度的波形區域。最低
取樣密度的區域則呈現深灰色。

 

■ 「使用者」選項以使用者定義色彩來
顯示波形。

 

快速秘訣

■ 在「Display > Colors」(顯示 > 色彩) 控制視窗中選擇其中一組色階調色盤，便可查看不同色彩代表的不同
取樣密度。

■ 調色盤有二種。一種用於「記錄檢視」，另一種用於「快速擷取∕波形資料庫」。
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設定參考波形的色彩

選取「Display > Colors...」(顯示 > 色
彩...)，然後選取下列其中一種方法： 

■ 預設：使用參考波形預設的系統色
彩。

■ 沿用：使用相同於原參考波形的色
彩。
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設定數學運算波形的色彩

選取「Display > Colors...」(顯示 > 色
彩...)，然後選取下列其中一種方法： 

■ 預設：使用算術運算波形預設的系
統色彩。

■ 沿用：使用相同於套用數學函數之
最小編號通道波形的色彩。

 

快速秘訣

■ 每個算術運算波形和參考波形使用不同的預設色彩。
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使用 MultiView Zoom
使用 MultiView Zoom 功能，可垂直、水平、或等比例放大波形尺寸。縮放過的波形也可以排列、鎖定和自動捲
動。 「刻度」和「位置」設定只會影響顯示，而不會影響實際波形資料。

1. 如果 MultiView Zoom 已關閉，請選取
「Horiz/Acq > Zoom Setup...」(水平/擷
取 > 縮放設定)，並按一下「Zoom」
(縮放)，然後按一下「Controls」(控
制項)，或按下輔助前面板上的
「MultiView Zoom」以分割螢幕並加
入縮放方格圖。

 

2. 按下 「HORIZ」 (水平) 或 「VERT」
(垂直)，可選擇要放大縮放方格圖中
哪一條軸線。使用多用途旋鈕可調
整放大波形的刻度和位置。

這個範例的主要方格圖是方格圖的
上半部，縮放方格圖是方格圖的下
半部。 

注意。 若要隱藏或顯示縮放波形，
請按「Show/Hide Waveforms」(顯示/
隱藏波形)，再勾選要顯示的縮放波
形。

 

 

3. 如果要調整縮放方格圖尺寸，請從
「垂直」或「水平∕擷取」功能表選取
「縮放方格圖尺寸」。

4. 如果「MultiView Zoom」為開啟，但
縮放控制項未與讀數連接，按下
「MultiView Zoom」按鈕即可連接讀
數與縮放控制項。再按一次
「MultiView Zoom」按鈕可關閉縮放。

 

快速秘訣

■ 可使用「Zoom Setup」(縮放設定) 功能表來變更縮放波形的方格圖尺寸。
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在多塊區域縮放
如果您想同時檢視和比較同一筆記錄中的多塊區域，請使用下列程序。

1. 在您想要縮放的波形區域周圍按一
下滑鼠，拖曳出一個矩形。

2. 選取 「Zoom 1 On」 (縮放 1 開啟)。

3. 在另一個要縮放的波形區域周圍按
一下滑鼠，拖曳出一個矩形，然後
選取 「Zoom 2 On」 (縮放 2 開啟)。

4. 如果要水平調整縮放區域，請按一
下該縮放矩形下方的水平標記，以
選取縮放區域。

5. 使用可選多功能旋鈕或按兩下讀
數，並使用鍵盤調整所選縮放區域
的水平位置和係數。
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6. 如果要垂直調整該縮放區域，請選
取「Vertical > Zoom Setup...」(垂直 >
縮放設定...)，按一下垂直圖場，然
後使用可選多功能旋鈕或按兩下讀
數，並使用鍵盤調整垂直位置和係
數。

快速秘訣

■ 如果要清除縮放區域，請按一下「縮放設定」控制視窗中的 「Position Factor Reset」 (位置係數重置)。
■ 可從「Zoom Setup」(縮放設定) 控制視窗開啟和關閉每個縮放顯示。

■ 按一或兩下「MultiView Zoom」按鈕可切換所有縮放顯示的開關狀態。

■ 如果要重新定位縮放區域的水平位置，請按一下並拖曳縮放矩形底部的水平標記。
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鎖定和捲動縮放波形

1. 如果要使用「鎖定和捲動」，請在
「垂直」或「水平∕擷取」功能表選取
「Zoom Setup...」(縮放設定...)，再選
取「Lock and Scroll」(鎖定和捲動)
索引標籤。

2. 如果要捲動單一縮放區域，請選取
「Zoom 1-4」(縮放 1-4)核取方塊，再
按一下「自動捲動」按鈕。

3. 如果要同時捲動多塊縮放區域，請
按一下「Lock,」(鎖定)，再選取
「Zoom1-4」(縮放 1-4) 核取方塊。

鎖定縮放區域可鎖定它們的相對水
平位置。改變一個已鎖定縮放區域
的水平位置，就會改變全部的水平
位置。 

快速秘訣

■ 如果只有選取多塊縮放區域卻沒有鎖定，最大編號的縮放區域將自動捲動，而其他縮放區域則維持不動。
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隱藏縮放視窗中的波形

1. 若要隱藏或檢視波形，請從
「Vertical」(垂直) 或「Horiz/Acq」(水
平∕擷取) 功能表選取「Zoom Setup...」
(縮放設定...)。

2. 選取「Zoom」(縮放) 索引標籤，然
後按下「Show/Hide Waveforms」(顯
示/隱藏波形)。

3. 選取要顯示或隱藏之波形的所在縮
放區域。

4. 取消勾選您要隱藏的波道、算術運
算或參考波形。

搜尋和標記波形
您可以從擷取的波形來標記特定的位置。這些標記有助於限制自己分析特定波形區域。您可以自動標記符
合特殊條件的波形區域，或是手動標記每個特定項目。您可以在標記之間跳躍移動 (在特定區域之間移動)。
您可自動搜尋並標記多個能夠觸發的相同參數。許多搜尋參數沒有將時間限制作為觸發。您可以搜尋數學
和參考波形。您可以尋找特定類型的所有擷取事件。

搜尋標記提供了標記波形區域來作為參考的方式。 使用搜尋條件，自動設定標記。 您可以使用特定邊緣、
脈波寬度、矮波、邏輯狀態、上升/下降時間、設定和保持違反以及匯流排等搜尋類型，搜尋並標記區域。

 顯示波形

DPO70000SX 系列使用者 119



若要手動設定並清除 (刪除) 標記：

1. 開啟「Multiview Zoom」。使用 Zoom
1 (附標記)。

請參閱 使用 MultiView Zoom 在頁面
上 115。 

2. 選取「Analyze > Search」(分析 > 搜
尋)。

3. 旋轉輔助前面板上的多功能旋鈕，
或選取縮放方塊底端並將其拖曳至
所需位置，以移動 (縮放方塊) 到您
要設定 (或清除) 搜尋標記的波形區
域。

按下「Next」(下一個) (→) 或「Prev」
(上一個) (←) 箭頭按鈕，跳到現有標
記。 

4. 按下「Set Clr」(設定清除)，或輔助
前面板的「Set/Clear」(設定/清除) 按
鈕。

如果螢幕中央沒有出現任何搜尋標
誌，儀器就會增加一個標誌。 

建立標記後，則會儲存水平縮放係
數。使用 Next (下一個) 或 Prev (上
一個) 按鈕在標記之間移動時，則會
還原縮放係數。 

建立標記後，則會儲存水平縮放係
數。使用 Next (下一個) 或 Prev (上
一個) 按鈕在標記之間移動時，則會
還原縮放係數。 
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5. 在搜尋標記之間移動，調查研究您
的波形。使用「Next」(下一個) (→)
或「Prev」(上一個) (←) 箭頭按鈕，
從一個標記位置跳到另一個標記位
置，而無需調整任何其他的控制項。

6. 刪除標記。按下「Next」(下一個) (→)
或「Prev」(上一個) (←) 箭頭按鈕，
跳到您想要清除的標記。若要移除
置中位置的標記，請按下「Set Clr」
(設定清除)，或輔助前面板的「Set/
Clear」(設定/清除) 按鈕。這對於手
動與自動建立的標記都有用。
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若要自動設定並清除 (刪除) 搜尋標記

1. 按下「Search」(搜尋) 或選取「Analyze
> Search」(分析 > 搜尋)。

2. 從功能表選取所需要的搜尋類型。

搜尋功能表很類似觸發功能表。 

串列匯流排搜尋為選用選項。 

3. 從 Configure (組態) 索引標籤設定搜
尋。 若要複製觸發設定或搜尋設
定，請按下「Copy Settings」(複製設
定)。

4. 從 Copy Settings (複製設定) 視窗選
取設定的複製來源和複製目的地。
按 Copy (複製)，再按 Close (關閉)。
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5. 若要修改目前的搜尋設定，請調整
所顯示的控制項。顯示的控制項因
您選取的搜尋而異。

6. 如果尚未開啟，請按下「All
Searches」(所有搜尋) 以切換成開啟
搜尋。

7. 在這個螢幕中，三角形表示自動標
誌的位置，白色框線的三角形則表
示自訂 (使用者定義) 的標誌位置。
這些標記都可出現在一般或縮放過
的波形檢視。
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8. 利用「Next」(下一個) (→) 與「Prev」
(上一個) (←) 箭頭按鈕，以在標記之
間移動，快速調查您的波形。不需
要其他調整。

9. 若要切換顯示搜尋事件計數或標記
時間，請選取 「Results 」(結果) 索
引標籤，並按 View (檢視) 的
「Count 」(計數)。

10. 若要將標記表匯出至檔案，請按 All
Marks (所有標誌) 的「Export 」(匯
出)。

11. 若要將一個或所有標記轉換為使用
者標記，請按 Search Marks (搜尋標
記) 的 「Save 」(儲存) 或 「Save All 」
(存全部)。

12. 若要從標記表中移除目前反白的資
料列，請按 Search Marks (搜尋標記)
的 「Clear 」(清除)。

13. 若要切換以工程表示法或以高精準
度表顯示標記位置，請按 「Digits 」
(位數)。

14. 若要切換開啟和關閉顯示標記三角
形，請選取 「View 」(檢視) 索引標
籤，並按 「Show Marks 」(顯示標
記)。
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15. 若要在找到符合項目時停止擷取，
請選取 「Mode 」(模式) 索引標籤，
並勾選 「Stop Acquisition if event
found 」(找到事件便停止擷取)。

快速秘訣

■ 只搜尋擷取到的資料。設定儀器擷取您正在搜尋的資料。

■ 設定可辨別搜尋事件的取樣率。您可以搜尋大於一些取樣間隔的突波。

■ 您可以複製觸發設定，在擷取波形中搜尋符合觸發條件的其他位置。您可以複製搜尋設定到觸發。

■ 建立邊緣搜尋標記時不需要縮放係數。其他搜尋類型使用適當的縮放係數建立標記。

■ 按 Bring Zoom to Mark (縮放標記) 的 「Zoom 2 」(縮放 2) 或 「Zoom 3 」(縮放 3)，可使用 Zoom 1 (縮放 1) 的縮
放參數，顯示對應的縮放檢視。

■ 在儲存波形以及儲存設定時，自訂 (使用者) 標誌就會隨波形一起儲存。

■ 當儲存波形時，自動搜尋標記不會隨著波形一起儲存。然而，搜尋條件會儲存在已儲存的設定中，因此
您可以再使用搜尋功能，輕鬆地重新擷取這些標記。

「搜尋」有下列搜尋功能：

搜尋 說明

邊緣 以使用者指定的臨界值位準來搜尋邊緣 (上升或下降)。
突波 搜尋比指定寬度更窄 (或更寬) 的脈波，或是忽略比指定寬度更窄 (更寬) 的突波。

寬 搜尋 >、<、= 或 ≠ 使用者指定脈波寬度的正脈波與負脈波寬度。

設定 & 保持 搜尋使用者指定的設定和保持時間違反。

矮波 搜尋正脈波或負脈波，它可與第一個振幅臨界值交叉，但再度交叉第一個臨界值
之前，無法與第二個臨界值相交。 搜尋所有矮波脈波或只搜尋期間 >、<、= 或 ≠
使用者指定時間的矮波脈波。

視窗 搜尋進出臨界值視窗的訊號。請使用「When Wider」(較寬時) 選項，以時間來限定
搜尋。或視其他波道的邏輯狀態而使用「When Logic」(邏輯時) 選項。

碼型 搜尋多個波形間的邏輯樣式 (AND、OR、NAND 或 NOR)，每個輸入設定為 High
(高)、Low (低) 或 Don't Care (無關)。 當事件在 >、<、= 或 ≠ 使用者指定時間為真、
為假或有效時，進行搜尋。此外，您必須將其中一項輸入定義為同步 (狀態) 搜尋
的時脈。

轉換 搜尋 >、<、= 或 ≠ 使用者指定時間的上升和/或下降邊緣。

逾時 搜尋指定時間內沒有任何脈波。

狀態 當所有邏輯輸入值使選定的邏輯函數成為真或假且時脈輸入值變更狀態時，進行
搜尋。

DDR 讀取 搜尋 DDR 讀取脈衝。需要選項 DDRA。
DDR 寫入 搜尋 DDR 寫入脈衝。需要選項 DDRA。
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搜尋 說明

DDR 讀取和寫入 搜尋 DDR 讀取和寫入脈衝。需要選項 DDRA。
匯流排 並列匯流排： 搜尋二進位或十六進位值。

自訂：使用自訂解碼器搜尋。
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使用視覺搜尋

執行視覺搜尋所使用的執行設定和主要觸發相同。視覺搜尋結果所顯示的標記，會使用有別於分析搜尋標記
的顏色。請執行下列步驟設定視覺搜尋。

1. 設定 Pinpoint 觸發。請參閱 選擇觸
發類型在頁面上 81。

2. 設定視覺觸發。請參閱 使用視覺
觸發進行觸發 (視覺觸發)在頁面上
98。

3. 按一下「Mark All Trigger Events in
Record」(標記記錄中所有觸發事
件)。

4. 視覺觸發區域會以藍色顯示。

5. 視覺搜尋區域會以綠色顯示。

6. 只有作用中的視覺搜尋區域才會顯
示。按下標記「Next」(下一個) 和
「Prev」(上一個) 按鈕，將作用中的
區域移至其他視覺搜尋區域。

使用其他的「分析搜尋」控制視窗，
以控制或檢視視覺搜尋的結果。 
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分析波形
本儀器提供了游標、自動測量、統計、長條圖、算術運算、頻譜分析和進階的通過∕失敗測試等功能，以幫助
您分析波形。本節將介紹分析波形的概念和程序。線上說明將提供詳細資訊。

進行自動量測

1. 選取「Measure > Measurement
Setup...」(量測 > 量測設定...)。

2. 選取您要量測的波道、算術運算或
參考波形。

3. 請使用這些索引標籤來選取 5 種不
同類別的量測。

4. 若要移除所有量測值，請按一下
「Clear All」(清除全部)。

5. 若要移除多筆量測值，請按一下並
拖曳來選取這些量測值，然後按一
下「Clear Selected」(清除所選量測
值)。
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您也可以直接在「量測」功能表選擇所
選波形的量測值。請參閱 自動量測選
項在頁面上130。 

快速秘訣

■ 使用捲動模式時，您必須等到擷取停止之後，才可以看到量測值。

警告。 如果出現垂直裁剪，探棒頭則具有危險的電壓，但讀數格只會顯示低電壓。如果出現垂直裁剪的
情況，儀器讀數格則會出現  符號。發生訊號垂直裁剪的自動振幅相關量測值，所產生的結果將不精
確。若儲存或匯出讓其他程式使用的波形被裁剪，也會導致不精確的振幅值。如果是裁剪數學波形，則
數學波形的振幅量測值並不會受到影響。

自動量測選項

下表列出各種依類別的自動量測：裁剪、時間、長條圖、通訊，或更多。 請參閱進行自動量測在頁面上 129。

表格 8: 振幅量測

量測 說明

振幅 整個波形或選通區域的高值減去低值後，所得到的值。

高 在測量上升或下降時間這類需要用到高參考、中參考或低參考值的情況下，這個
值就會當作 100% 使用。這個值可使用最小值∕最大值、或長條圖方法計算得出。
最小值∕最大值方法會使用實際找到的最大值。長條圖方法會使用實際找到最常
超過中點的值。這個值可由測量整個波形或閘控區域得到。

低 在測量上升或下降時間這類需要用到高參考、中參考或低參考值的情況下，這個
值就會當作 0% 使用。這個值可使用最小值∕最大值、或長條圖方法計算得出。最
小值∕最大值方法會使用實際找到的最小值。長條圖方法會使用實際找到最常低
於中點的值。這個值可由測量整個波形或閘控區域得到。

RMS 整個波形或選通區域的真均方根電壓。

AC RMS 測量區域上的真「均方根」電壓。

最大值 最大正峰值電壓。最大值可由測量整個波形或閘選區域得到。
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量測 說明

最小值 最大負峰值電壓。最小值可由測量整個波形或閘選區域得到。

峰對峰值 整個波形或選通區域中，最大和最小振幅的絕對差值。

週期均方根 波形第一個週期或是選通區域第一個週期的真均方根電壓。

正過激 這是測量整個波形或選通區域所得的測量值。可由下列運算式得出： 正過衝 =
((最大值 - 高) / 振幅) x 100%。

負過激 這是測量整個波形或選通區域所得的測量值。可由下列運算式得出： 負過衝 =
((低 - 最小值) / 振幅) x 100%。

中數 整個波形或選通區域的代數平均值。

週期平均 波形第一個週期或是選通區域第一個週期的代數平均值。

表格 9: 時間測量值

量測 說明

上升時間 波形或選通區域中第一個脈波上升邊緣，從最後值的低參考值 (預設 = 10%) 爬升
到高參考值 (預設 = 90%) 所需要的時間。

下降時間 波形或選通區域中第一個脈波下降邊緣，從最後值的高參考值 (預設 = 90%) 下降
到低參考值 (預設 = 10%) 所需要的時間。

正脈波寬 正脈波中參考 (預設 50%) 振幅點之間的相隔距離 (時間)。測量波形或閘控區域的
第一個脈波，就可知道測量值。

負脈波寬度 負脈波中參考 (預設 50%) 振幅點之間的相隔距離 (時間)。測量波形或閘控區域的
第一個脈波，就可知道測量值。

正工作週期 正脈波寬度和訊號週期的比率，以百分比例表示。測量波形或閘控區域的第一個
週期，就可知道工作週期。

負工作週期 負脈波寬度和訊號週期的比率，以百分比表示。測量波形或閘控區域的第一個週
期，就可知道工作週期。

週期 完成波形或閘控區域中第一個週期所需要的時間。週期是頻率的倒數；以秒鐘為
測量單位。

Freq 波形或閘控區域中第一個週期的頻率。頻率是週期的倒數；它的測量單位是 Hertz
(Hz)，1 個 Hz 指每秒鐘一個週期。

延遲 兩個不同波形中參考 (預設 50%) 振幅點之間的相距時間。

表格 10: 其他測量值

量測 說明

區域 整個波形或閘控區域的面積。單位為伏特-秒。測量基線以上的面積是正值；測量
基線以下的面積是負值。

週期面積 這是指波形第一個週期或閘控區域第一個週期的區域面積。單位為伏特-秒。測
量高於一般參考點面積會得到正值，測量低於一般參考點面積會得到負值。

相位 特定波形超前、或落後另一個波形的時間長度，以度來表示。這時 360° 包含整個
波形週期。

爆衝寬度 爆衝 (一連串暫態事件) 期間時間，可測量整個波形或選通區域得知。
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表格 11: 長條圖測量值

量測 說明

波形特性 顯示構成長條圖的波形數目。

矩形中的命中數 顯示出現在長條圖矩形中∕上的點數。

峰命中數 顯示長條圖中最大集區出現的點數目。

中值 顯示長條圖矩形的中間點。位在長條圖矩形之內和之上的所有擷取點值中，有一
半小於這個值，而另一半大於這個值。

最大值 顯示垂直長條圖中非零值 bin 的最高電壓，或水平長條圖中最右邊非零值 bin 的時
間。

最小值 顯示垂直長條圖中非零值 bin 的最低電壓，或水平長條圖中最左邊非零值 bin 的時
間。

峰對峰值 顯示長條圖的峰對峰值。垂直長條圖顯示最高非零值 bin 的電壓減去最低非零值
bin 的電壓。水平長條圖顯示最右邊非零值 bin 的時間減去最左邊非零值 bin 的時
間。

中數 測量長條圖矩形內∕上所有擷取點的平均值。

標準偏差 測量長條圖矩形內∕上所有擷取點的標準偏差值 (均方根 (RMS) 偏差值)。
平均 ±1 標準差 顯示與長條圖平均不超過 1 個標準差的擷取點百分比。

平均 ±2 標準差 顯示與長條圖平均不超過 2 個標準差的擷取點百分比。

平均 ±3 標準差 顯示與長條圖平均不超過 3 個標準差的擷取點百分比。

表格 12: 通訊量測

量測 說明

消光比 眼球頂部至基準線的比例。這項測量只能用於波形資料庫，或波形資料庫模式下
已儲存的參考波形。

消光比 % 眼球頂部至基準線的比例。單位為百分比例。這項測量只能用於波形資料庫，或
波形資料庫模式下已儲存的參考波形。

消光比 (dB) 眼球頂部至基準線的比例。單位為分貝。這項測量只能用於波形資料庫，或波形
資料庫模式下已儲存的參考波形。

眼高度 測量眼高度。單位為伏特。

眼寬度 測量眼寬度。單位為秒鐘。

眼頂點 用於測量消光比的頂部值。

眼基準線 用於消光比量測中的基準值。

交叉 % 眼狀圖交叉點。以眼高度的百分比表示。

抖動 P-P 目前水平單位中邊緣抖動的峰對峰值。

抖動 RMS 目前水平單位中邊緣抖動的 RMS 值。

抖動 (6 Sigma) 目前水平單位中邊緣抖動 RMS 值的 6 倍值。

雜訊 P-P 指定訊號頂部或基準的雜訊峰對峰值。

雜訊 RMS 指定訊號頂部或基準的 RMS 值。

S/N 比例 指定訊號頂部或基準的訊號振幅和雜訊比例。
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量測 說明

週期失真 在中參考所測量第一個眼狀圖交叉的峰對峰時序變化。單位為眼球週期的百分
比例。

Q 係數 眼球尺寸至雜訊比例。

自訂自動量測

可使用閘控、修改量測統計或調整量測參考位準，來自訂自動量測。

閘控

使用閘控可將量測限制於波形的特定部
分。 

1. 選取「Measure > Gating > Gating...」
(量測 > 閘控 > 閘控...)。

2. 請執行下列動作之一來指定範圍：

■ 按一下「Cursor」(游標)，將閘
控區域設定為游標間的區域。

■ 按一下「Zoom (1-4)」(縮放
(1-4))，將閘控區域設定為「縮放
(1-4)」方格圖。
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統計

統計功能可自動啟動量測。統計值可顯
示量測的穩定性。 

1. 若要變更顯示的統計值，請選取
「Measure > Statistics」(量測 > 統計)，
然後選取「Mean」(平均值) 或「All」
(全部)。(「全部」選項包括了最小
值、最大值、平均值、標準差和總
數。)

2. 如果要關閉統計功能，請選取
「Off.」(關閉) 。

注意。 將游標置於量測上可顯示
量測的較高解析度版本。

 

快照

若要一次檢視所有有效量測值，請選取
「Measure > Snapshot」(量測 > 快照)。 

注意。 如果測量的設定無效，測量結果
顯示 3 個問號。

 

若要快照一般測量或通訊測量，請選取
General (一般) 或 Comm (通訊)。 
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註解量測

1. 若要註解測量，請從 Measurements
setup (測量設定) 控制視窗選取
「Annotation 」(註解) 。從下拉式選
單選擇測量以進行註解。

2. 若要選取量測註解的詳細資訊數
量，請選取「Measure > Annotation >
Standard」(量測 > 註解 > 標準) 或
「Detailed」(詳細)。
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參考位準

參考位準會決定和時間相關的實際測量
結果。 

1. 選取「Measure > Reference Levels...」
(量測 > 參考位準...)。

2. 將測量參考水平調整到不同的相對
值或絕對值。

■ 使用高、低參考來計算上升和
下降時間。預設的高參考是
90%，低參考是 10%。

■ 中參考主要用於邊緣之間的測
量，例如脈波寬度。預設水平
為 50%。

■ Mid2 參考則用於延遲或相位測
量所指定的第二個波形。預設
水平為 50%。

 

快速秘訣

■ 為確保精準的雜訊值，請務必在測量眼狀圖 (Eye) 訊號時，移至「Reference Levels Setup」(參考位準設定)
功能表，並將訊號類型設定成眼狀圖 (Eye) 訊號。
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進行游標量測

使用游標以手動量測擷取的資料。

1. 選取「Cursors > Cursor Controls」(游
標 > 游標控制)，或按下輔助前面板
上的「Cursors」(游標)。

注意。 如果已啟用游標，但多功能
旋鈕讀數未與「Position」(位置) 控制
項連接，請按下「Cursors」(游標) 按
鈕將控制項與讀數連接。再按一次
「Cursors」(游標) 按鈕可將游標關閉。

 

2. 選取游標來源。

3. 請選取下列游標類型之一：

■ 水平線條 (H Bars)：可量測振幅
(通常單位為伏特或安培)

■ 垂直線條 (V Bars)：可量測水平
參數 (時間)

■ 波形游標和螢幕游標可以同時
量測垂直和水平參數。波形游
標可附加到波型中。而螢幕游
標只能浮動在波形上，無法附
加到其中。

 

4. 如果要在二種波形之間進行量測，
請選取「Waveform」(波形)，再一一
選取游標的波形來源。
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5. 選取「Cursors > Cursor Position...」
(游標 > 游標位置...)，然後使用多功
能旋鈕來調整游標位置。

6. 於畫面讀取游標量測結果。

快速秘訣

■ 請使用「游標追蹤」模式以設定游標串聯地移動。請使用「游標獨立」模式以設定游標個別地移動。

■ 如果您使用縮放方格圖，可以直接放置游標在特定波形點以便進行精確量測。

■ 也可用游標按一下並拖曳它們到新的位置。

■ 若要將游標移到畫面中央，請按 「Move Cursors to Center 」(將游標移到中央)。
■ 您可以選取實線游標或虛線游標。

■ 垂直游標會量測從觸發點到垂直游標的時間。
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設定長條圖

您可以顯示垂直 (電壓) 或水平 (時間) 長條圖。使用長條圖量測，可以在特定軸線上取得波形區段的統計量測
資料。

1. 按一下指標並拖曳通過您希望長條
圖涵蓋的波形區段。如要設定水平
長條圖，則使矩形的寬度長於高度。

2. 從捷徑功能表中選取「Histogram
Vertical」(長條圖垂直) 或 「Histogram
Horizontal」(長條圖水平) 。

3. 在方格圖的頂點 (可檢視水平長條
圖) 或左邊緣檢視長條圖 (可檢視垂
直長條圖)。
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4. 若要調整長條圖刻度或長條圖方塊
的尺寸和位置，請選取「Measure >
Waveform Histograms」(量測 > 波形
長條圖)，然後使用「Histogram
Setup」(長條圖設定) 控制視窗。

5. 您也可以在長條圖資料上執行自動
化量測。請參閱 進行自動量測在
頁面上 129。

快速秘訣

■ 請使用垂直長條圖來量測訊號雜訊；使用水平長條圖來量測訊號抖動。

■ 按一下並拖曳捷徑功能表，便可關閉長條圖顯示。
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使用數學運算波形
建立算術運算波形，支持您對通道和參考波形的分析。您可以結合並轉換來源波形和其他資料到算術運算波
形，衍生在應用時所需要的資料檢視。

使用下列程序來取得預先定義的算術運算式。

1. 選取「Math > Math Setup...」(數學運
算 > 數學運算設定...)。

2. 選擇預先定義的算術運算式之一。

使用下列程序來建立進階的數學運算波形運算式。

1. 選取「Math > Math Setup...」(數學運
算 > 數學運算設定...)。

2. 按一下「Editor」(編輯器)。
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3. 使用來源、運算子、常數、量測值、
變數以及函數來建立算術運算波形
運算式。

4. 當您定義出滿意的運算式之後，請
按一下「Apply」(套用)。

5. 如果要新增個人的濾波器，請按一
下「Filter」(濾波器)索引標籤。按一
下「Load」(載入)。

6. 按兩下所要使用濾波器的資料夾。
按兩下您想使用的濾波器。

7. 使用所選的濾波器來建立個人的數
學運算式。

8. 當您定義出滿意的運算式之後，請
按一下「Apply」(套用)。
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快速秘訣

■ 連按兩下算術運算式可開啟算術運算方程式編輯器。

■ 如果來源不是有效資料，則無法套用算術運算的定義。

■ 算術運算波形可從類比波道、參考、算術運算來源波形、及量測值建立。

■ 算術運算波形也可用通道波形的相同方式，進行量測。

■ 算術運算波形可從算術運算式中的原始資料，衍生其水平刻度和位置。調整來源波形的控制項也可以調
整算術運算式。

■ 如果未勾選「Autoscale」(自動調整刻度)，開啟數學波形或變更數學方程式時，將不會計算垂直刻度和位
置。

■ 使用 MultiView Zoom 可放大數學運算波形；請使用滑鼠來定位縮放區域。

■ 請參閱線上說明以取得任意數學運算濾波器的更多資訊。
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使用頻譜分析
使用下列程序來取得預先定義的頻譜算術運算式。如需更多資訊，請參閱線上說明。

1. 選取「Math > Math Setup...」(數學運
算 > 數學運算設定...)。

2. 選擇預先定義的頻譜算術運算式之
一。

3. 按一下「Basic」(基本) 。

4. 按一下 Resolution BW (解析度頻寬)
或 Frequency Span (頻展)，並使用數
字鍵盤或多用途旋鈕來調整頻譜顯
示。

注意。 解析度 BW 和頻率頻展區只
能在手動水平模式中調整。

 

使用下列程序來建立進階的頻譜算術運算式。
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1. 選取「Math > Advanced Spectral...」
(數學運算 > 進階頻譜...)。

2. 選取您要定義的算術運算波形。

3. 按一下您要建立的頻譜波形類型。
如果要重新定義波形，請按一下「清
除」。

4. 選取來源波形。

5. 使用「Spectral Setup」(頻譜設定) 控
制視窗中的控制項或輔助前面板上
的多功能旋鈕，來調整頻譜波形。

6. 同時檢視時域和頻域的波形。

您也可以使用閘控，僅選擇頻譜分
析的一部分時域波形。請參閱 閘
控在頁面上 133。 

快速秘訣

■ 頻譜算術運算波形的來源須為波道或其他算術運算波形。

■ 使用短記錄長度，提供更快的儀器響應。

■ 使用長記錄長度，降低與訊號相關的雜訊，並提高頻率解析度。
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■ 不同的視窗功能會在頻譜中產生不同的濾波器響應波形，而且會產生不同的解析度頻寬。如需更多資訊，
請參閱線上說明。

■ 解析度頻寬 (RBW) 直接控制閘道寬度。因此，當您調整此控制項時，時域閘道標記也會隨著移動。

■ 您可以在頻譜中顯示實際資料或假想資料的線性振幅。這項功能在您離線狀態處理頻譜，並將其轉換回
時域軌跡時特別有用。
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使用錯誤偵測器
示波器的錯誤偵測器會執行與 BERT 類似的位元測試。此功能需要安裝 BITERR 和 ST14G 選項 (14.1 Gbps 串列
觸發)。錯誤偵測器通常會與 TekExpress 軟體應用程式一起使用，進行接收器和邊際測試。

此儀器系列的錯誤偵測器選項，為泛型 NRZ 串列資料位元錯誤偵測器。本質上並未對任何特定的標準有通訊
協定知覺，而是將傳入位元與在設定時指定的圖形檔案相比對。此位元間的逐一比較是在示波器的觸發系統
內完成，而非在擷取的波形內分析資料。這能確保沒有位元會在分析時遺漏，高達 14.1 Gbps 的資料速率。

錯誤偵測器具有內建的預設設定，可涵蓋 PRBS 訊號大多數的常用案例。內含的取樣任意波形產生器 (AWG)
設定檔適用於各種 PRBS 訊號。這些檔案可讓您輕鬆驗證錯誤偵測器的操作是否正確，而且可針對測試中裝
置 (DUT) 進行測試。但是，只要能建立圖形檔案，準確表示訊號源傳輸內容，任何串列訊號資料產生器皆能
使用。

如果要使用錯誤偵測器，請執行下列步驟：

1. 選取「Analyze > Serial Error Detector」
(分析 > 串列錯誤偵測器) 以顯示錯
誤偵測器控制視窗。

2. 在「Preset Setting」(預設設定) 下拉
式清單中選取「Setup (設定) 索引標
籤，選取預設，然後按下「Apply」
(套用)。如果您已選取
「CUSTOM_SETUP」，則無法使用
「Apply」(套用) 按鈕 (請繼續進行步
驟 3)。

如果您未選取「CUSTOM_SETUP」，
請繼續進行步驟 4。 
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3. 當您將「Preset Setting」(預設設定)
選取為「CUSTOM_SETUP」，會出現
「Pattern File」(圖形檔案) 圖場。按下
「Browse」(瀏覽) 按鈕以瀏覽，並選
取自訂圖形檔案 (.txt 檔案)。

選取檔案的名稱和路徑將出現在
「Pattern File」(圖形檔案) 圖場。錯誤
偵測器圖形檔的預設位置為 C:
\Users\Public\Tektronix\TekScope
\ErrorDetector。 

4. 從下拉式清單選取訊號來源和「資
料速率」。

如果您將「資料速率」選取為「自
訂」，「位元速率」圖場將出現在「資
料速率」(資料速率) 圖場下方。您
可以在這裡輸入自訂位元速率。  

5. 按下「Run」(執行) 按鈕啟動錯誤偵
測器。

如有必要，您隨時都可以按下
「Stop」(停止) 或「Reset」(重設)。停
止之後，您可以再按一次「Run」(執
行)。 

「Run」(執行) 會啟動錯誤偵測器進
行錯誤測試。 

6. 選取「Results」(結果) 索引標籤，可
查看執行錯誤偵測器的結果。

注意。 如果您按下「Reset」(重設)，
或是中斷然後重新連接訊號，錯誤
偵測器就會自動將所有的計數重設
為零。
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除非偵測到位元錯誤，否則示波器波型
顯示不會在執行錯誤檢測器時更新。在
觸發系統內偵測到位元錯誤時，系統會
產生觸發，以擷取與位元錯誤事件相關
的波形資料。 

如果您使用其中一種提供的 AWG　設
定檔案，可以按下 AWG 上的「Force
Event」(強制事件) 按鈕讓訊號中產生錯
誤，以驗證錯誤偵測器的操作。這些
AWG 設定檔在 Windows 中位於 C:\Users
\Public\Tektronix\TekScope\ErrorDetector
\AWG 目錄。 

此外，您也可以利用中斷然後重新連接
訊號的方式來驗證操作。雖然中斷連接
時會有大量錯誤，但重新連接訊號之後，
錯誤偵測器會清除錯誤計數和錯誤率，
然後繼續進行測試。  

7. 按下「Error Detector」(錯誤偵測器)
的「On/Off」(開啟/關閉) 按鈕，即可
結束錯誤偵測工作階段。

錯誤偵測器可搭配多種纜線排列方式使用。可讓您驗證錯誤檢測器操作的第一個纜線設定。 

連接顯示的纜線以驗證錯誤檢測器操
作。 
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如果要驗證 DUT 位元錯誤率效能，在顯
示的訊號產生器與錯誤檢測器之間插入
DUT。 

在訊號產生器與錯誤檢測器之間插入
DUT 後，將您的 PUT 放在迴路中，並開
始從訊號產生器輸出圖形。按下「Run」
(執行) 按鈕啟動錯誤偵測器。 

錯誤偵測器啟動後，觸發類型設為串列
觸發。除非在位元串中偵測到錯誤，否
則示波器不會在執行錯誤檢測器時擷取
新的波形。偵測到錯誤時，示波器會擷
取包含位元錯誤的波形。您可以使用其
他的示波器通道同時探測其他訊號，以
找出錯誤的原因。 

如果串列匯流排定義為「Vertical > Bus
Setup」 (垂直 > 匯流排設定)，即使正在
執行錯誤偵測器，解碼器將繼續在擷取
波形上執行解碼。這可以協助在波形中
找到位元錯誤發生的位置。 

注意。 如果因為某些原因，錯誤偵測器遺失訊號源上的鎖定 (例如：訊號源從輸入移除)，同步將會遺失。發
生這種情況時，因為觸發系統不再同步，所以示波器的波形擷取將在自由執行中操作。如果要將觸發系統重
新同步至訊號源並解決此問題，從主功能表選取「Edit > Clear Data」(編輯 > 清除資料)。這將會強制觸發系統
重新與訊號源同步，讓您可以繼續一般操作。
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使用遮罩測試

串列通訊遮罩測試 (Serial Communications Mask Testing 配合選項 MTM 或 MTH) 可用來比較訊號和預先定義的範
本或遮罩。通過此項測試的訊號必將座落於波罩定義的區段之外。一般來說，這些波罩是由 ANSI 這類標準協
會完成定義。 若要執行遮罩測試，請執行下列步驟：

1. 選取「Mask > Source...」(遮罩 > 來
源...)。

2. 選取訊號來源。

3. 按一下「Masks」(波罩) 索引標籤。

4. 選取特定類型和標準類型。

3357-002
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5. 請按一下「Config」(組態) 按鈕，來
存取「Mask Configuration」(遮罩組
態) 控制視窗。您可在其中調整遮
罩和違反的顯示方式，及「Mask
Autoset」(遮罩自動設定) 和「Autofit」
(自動適應) 的組態方式。

6. 按一下「Masks」(波罩)，便可返回
「波罩設定」控制視窗。

7. 按一下 Lock Mask to Wfm 「On」(開
啟)，便可追蹤水平或垂直設定的波
罩變更。

8. 切換成「計算擊數」(Hit Count) 「On」
(開啟)，便可在波罩測試期間反白選
取違反區段。

9. 按一下「Autoset」(自動設定)，便可
自動根據輸入訊號特性將波形對齊
波罩。

10. 切換成「自動適應」(Autofit) 「On」
(開啟)，便可自動在每次擷取之後重
新設定波形位置，以便盡量減少命
中次數。

11. 按一下「Tolerance」(容差) 索引標
籤，再設定容差。

大於 0% 的容差設定值會提高遮罩
測試的通過難度。若是小於 0%，則
表示測試比較容易通過。 

如果您要依照標準指定方式來使用
波罩，請使用 0%。 變更此百分比可
讓您進行邊際測試。 
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12. 選取「Pass/Fail Setup」(通過/失敗設
定) 索引標籤，設定通過∕失敗參數。
(如果是使用 WfmDB 擷取模式，「波
形數目」索引標籤 (# of Wfms ) 將變
成「取樣」(Samples)。)

13. 選取「通過/失敗測試通知」(Pass/Fail
Test Notifications)。

14. 選取您要測試的波形極性。

15. 切換成「重複」(Repeat) 「On」(開
啟)，便可持續執行波罩測試。

16. 選取當測試完成時您所希望收到的
通知。

17. 按一下「Pass/Fail Results」 (通過/失
敗結果) 索引標籤可檢視測試結果。

18. 切換成「通過/失敗測試」(Pass/Fail
Test) 「On」(開啟) 可開始波罩測試。

19. 按一下「重置」 (Reset) 可重置總數，
並清除所有違反。

快速秘訣

■ 如果訊號沒有在波罩範圍內，請啟用「自動設定」來將波形置入波罩中間。
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使用極限測試

選用性的極限測試可比較作用中訊號與波模波形。使用良好的訊號來建立波模波形並與作用中訊號做比較，
以進行通過/失敗測試。

1. 選取「Masks > Limit Test Setup... 」
(遮罩 > 極限測試設定...)。

2. 若要建立波模，請選取 Source (來
源)、Destination (目的地) 和 Tolerances
(容差)。可使用多功能旋鈕來調整
容差。容差可指定訊號的允許邊
際，超過後極限測試便失敗。

3. 按一下「Save」(儲存)。您可以建立
並儲存多個波模供日後使用。

4. 選取來源波形以和波模比較。

5. 選取波模和來源波形做比較。(通
常是您在步驟  3 建立的範本)。

6. 按一下「Failure Notification 」(失敗
通知)，可設定失敗通知。

7. 選取失敗通知，然後按一下
「Setup」(設定) 以返回設定控制視
窗。
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8. 按一下 Lock Template to Waveform (將
波模鎖定於波形) 的 「On 」(開啟)，
將波模的垂直刻度或位置鎖於來源
波形的垂直刻度或位置。

9. 按一下 Highlight Hits (反白擊數) 的
「On 」(開啟)，以不同顏色顯示落於
波模外部的點。

10. 切換到 Limit Test (極限測試) 的「On 」
(開啟)，啟動測試。

11. 按一下「Reset 」(重設)，可清除所
有違反，重設測設。

快速秘訣

■ 可使用作用中或已儲存的波形來建立極限測試範本。

■ 使用平均擷取模式，可建立更平緩的波模波形。

■ 使用「包封」擷取模式，可建立允許偶發過激量的波模。

■ 極限測試不適用於多單元配置。
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MyScope
您可以透過 MyScope，建立僅包含一般常用控制項的自訂控制視窗。將個人使用的控制項放入自訂的控制視
窗之後，您就不用在幾個控制視窗之間切換。

本節將介紹建立和使用 MyScope 控制視窗的程序。線上說明將提供詳細資訊。

建立新的 MyScope 控制視窗

1. 選取「MyScope > New Control
Window...」(MyScope > 新增控制視
窗...)。

2. 按一下 + 來展開類別。每個類別都
會包含可新增到 MyScope 控制視窗
的控制項。這些類別對應功能表
列，以協助您找到通常使用的控制
項。

3. 按一下控制項來預覽。
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4. 按兩下控制項，或是按一下 + 來展
開控制項清單。(如果這時沒有顯
示 +，表示該控制項目無法更進一步
自訂。)

5. 清除核取方塊，移除任何您不希望
包含在該控制項中的元件。
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6. 按一下控制項，並將它拖曳到
MyScope 控制視窗。當您釋放滑鼠
時，該控制項就會嵌入最靠近的方
格位置。 按一下並拖曳該控制項，
便可在 MyScope 控制視窗中變更控
制項的位置。

7. 按一下「新增索引標籤」 (New Tab)
可在 MyScope 控制視窗中新增索引
標籤。 最多可加入六個索引標籤。

8. 如果要重新命名索引標籤，請執行
下列動作之一：

■ 按一下「Rename Tab」(重新命
名索引標籤)。

■ 按兩下索引標籤，再輸入新名
稱。

 

9. 按一下 「User Pref...」 (使用者偏
好...)，指定要載入 MyScope 控制視
窗的使用者偏好。

10. 如果要刪除控制項，請執行下列動
作之一：

■ 選取索引標籤，再按一下
「Delete」(刪除)。這樣就可刪除
索引標籤和其中所有的控制
項。

■ 選取控制項，再按一下
「Delete.」(刪除) 。如此只會刪
除選取的控制項。

 

 MyScope
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11. 按一下「Save」(儲存)，然後輸入
MyScope 控制視窗的名稱，或是使用
預設名稱。

快速秘訣

■ 如果要重新設定控制項，請按一下該項，並將其拖回到預覽視窗。接著選取或清除核取方塊，以便包括
或移除控制項中的元件。

■ 如果要改變索引標籤的順序，請按一下索引標籤，再將它拖曳到新位置。

■ 若要刪除控制項，請按一下該項，再將它拖曳到螢幕的上半部 (拉離 MyScope 控制視窗)。
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使用 MyScope 控制視窗
如果要開啟先前所定義的 MyScope 控制視窗，請執行下列動作：

1. 選取「MyScope > Open Control
Window...」(MyScope > 開啟控制視
窗...)，或選取五個最常使用的
MyScope 視窗之一。

2. 選取您要使用的 MyScope 控制視
窗，並按一下「Open」(開啟) 。

如果要顯示作用中的 MyScope 控制視窗，請執行下列動作：

1. 選取「MyScope > Current...」(MyScope
> 目前...)，或於工具列模式中按一下
「MyScope」。(即使 MyScope 控制視
窗並未顯示，它還是有在持續作
用。)

若要編輯 MyScope 控制視窗，請執行下列步驟：

 MyScope
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1. 選取「MyScope > Edit Control
Window...」(MyScope > 編輯控制視
窗...)。

2. 選取您要編輯的控制視窗，並按一
下「Open」(開啟)。

快速秘訣

■ 有些控制項在 MyScope 控制視窗中，會執行與它在標準控制視窗中的不同功能。如需詳細資訊，請參閱
線上說明。

■ 您可以將 MyScope 控制視窗 (.tcw 檔案) 複製到其他 MSO/DPO70000DX、MSO/DPO70000C、DPO7000C 和 MSO/
DPO5000B 系列儀器。
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儲存和叫出資訊

本節將介紹從您的儀器儲存和叫出螢幕捕捉及設定、儲存測量值、使用剪貼簿和列印等程序。線上說明將提
供詳細資訊。

儲存螢幕擷取

1. 選取「File > Save」(檔案 > 儲存)，
或「Save As > Screen Capture...」(另
存新檔 > 螢幕擷取...)。

2. 按一下「Options...」(選項...) 以設定
「Palette」(調色盤)、「View」(檢視)、
「Image」(影像) 或「Screen Capture

Format」(螢幕捕捉格式) 等選項；否
則請跳至步驟  3。
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3. 選取要儲存該螢幕捕捉的位置。

4. 輸入螢幕捕捉的名稱，或是使用預
設名稱，接著選取檔案類型。

5. 按一下「Save」(儲存)。

快速秘訣

■ 如果要快速儲存多個螢幕捕捉，請選取「設定前面板列印按鈕成儲存」(Set Front Panel Print Button to Save)，
再按一下「儲存」。 這樣一來，您只需按下輔助前面板上的「Print」(列印) 按鈕即可儲存螢幕擷取。
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儲存波形

1. 若要儲存波形，請選取「File >
Save」(檔案 > 儲存)，或「Save As >
Waveform...」(另存新檔 > 波形...)。

2. 按一下「Waveform」(波形)。

3. 按一下「Options...」(選項...) 以指定
「Waveform Data Range」(波形資料範
圍)、「FastFrame Data Range」(快速圖
框資料範圍)、「Waveform Detail」(波
形細節)、「Data Destination」(資料目
的地)、「Source」(來源) 或是「Data
Ordering」(資料順序)；否則請跳至
步驟  4。
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4. 選取「來源」。

5. 您可以將波形另存成儀器記憶體的
參考波形，或是另存成 Windows 目
錄中的  .wfm 檔案。如果要將波形
另存成參考波形，請選取「Ref 1–
4 (參考 1–4)」。如果要另存成 .wfm
檔案，請選取您要儲存該波形的位
置。

6. 如果您要將波形儲存成  .wfm 檔案，
請輸入檔案名稱，或是使用預設名
稱。

7. 按一下「Save」(儲存)。

快速秘訣

■ 選取「Auto-increment file name」(自動遞增檔名) 可直接儲存相似波形，而不需要每次都重新輸入完整檔
名。

■ 如果要快速儲存多個波形，請選取「設定前面板列印按鈕成儲存」 (Set Front Panel Print Button to Save)，再
按一下「儲存」。 這樣一來，您只需按下輔助前面板上的「Print」(列印) 按鈕即可儲存波形。
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叫出波形

1. 選取「File > Recall...」(檔案 > 叫
出...)。

2. 按一下「Waveform」(波形)。

3. 選取您要叫出波形的「Destination (目
的地)」。

4. 選取要叫出的波形。

5. 按一下「Recall」(叫出) 。按一下「叫
出」便可開啟參考波形，並啟動「參
考波形」控制視窗。

6. 使用控制項來調整參考波形。 您
也可以選取「File > Reference
Waveform Controls...」(檔案 > 參考波
形控制...) 來存取「Reference
Waveform」(參考波形) 控制視窗。

快速秘訣

■ 您可以儲存多種不同的檔案類型，但是您只可以叫出設定 (*.set) 檔案和波形 (*.wfm) 檔案。
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儲存儀器設定

1. 選取「File > Save」(檔案 > 儲存)，
或「Save As > Setup...」(另存新檔 >
設定...)。

2. 按一下「Setup」(設定)。

3. 選取要儲存該設定的位置。 可以
將設定儲存到儀器記憶體提供的十
個設定儲存位置其中之一，或是另
存成 Windows 目錄中的 .set 檔案。

4. 輸入檔案名稱或是使用預設名稱。
使用跳出鍵盤輸入要存到儀器記憶
體中的設定檔案名稱。

5. 按一下「Save」(儲存)。

快速秘訣

■ 如果有啟用觸控顯示螢幕，請使用跳出數字鍵盤為設定加上便於識別的標籤。

■ 使用「Auto-increment file name」(自動遞增檔名) 可直接儲存相似檔案，而不需要每次都重新輸入完整檔名。

■ 如果要快速儲存多個設定，請選取「設定前面板列印按鈕成儲存」 (Set Front Panel Print Button to Save)，再
按一下「儲存」。 這樣一來，您只需按下輔助前面板上的「Print」(列印) 按鈕即可儲存設定。
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叫出儀器設定

1. 選取「File > Recall...」(檔案 > 叫
出...)。

2. 按一下「Setup」(設定)。

3. 選取您要叫出的設定檔案。 從儀
器記憶體十個位置其中之一或
Windows 目錄叫出所需的設定檔案。

若要保留目前的偏移校正設定，按
一下「Don't recall deskew values」(不
叫出偏移校正值)。 

4. 按一下「Recall」(叫出) 。

快速秘訣

■ 您可以叫出儲存在磁碟上的任何設定，然後將其存到內部設定儲存位置以便更快速存取。
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儲存量測

1. 選取「File > Save」(檔案 > 儲存)，
或「Save As > Measurement...」(另存
新檔 > 量測...)。

2. 按一下「Options...」(選項...) 以指定
「Displayed Measurements」(已顯示的
測量值)、「Measurement Snapshot」(測
量值快照集) 或「Measurement
Format」(測量值格式)；否則請跳至
步驟  3。

3. 選取要儲存該測量的位置。

4. 輸入該測量的名稱，或使用預設名
稱，然後選取檔案類型。

5. 按一下「Save」(儲存)。
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儲存使用者遮罩

1. 選取「File > Save」(檔案 > 儲存) 或
「Save As > User Mask」(另存新檔 >
使用者遮罩)。

2. 按一下「User Mask」(使用者遮罩)。

3. 選取要儲存該遮罩的位置。

4. 輸入該遮罩的名稱，然後選取檔案
類型。

5. 按一下「Save」(儲存)。
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儲存長條圖資料

1. 選取「「File > Save」(檔案 > 儲存) 或
「「Save As > Histogram Data」(另存新
檔 > 長條圖資料)。

2. 選取「Histogram」(長條圖)。 根據
先前的選項，您可能需要選取「More
> Histogram Data」(更多 > 長條圖資
料) 來顯示「Histogram」(長條圖) 選
項。

3. 選取要儲存該長條圖的位置。

4. 輸入該長條圖的名稱，然後選取檔
案類型。

5. 按一下「Save」(儲存)。
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儲存時戳

1. 選取「File > Save」(檔案 > 儲存) 或
「Save As > Timestamp Table」(另存新
檔 > 時戳表)。

2. 按一下「Timestamp」(時戳)。 根據
先前的選項，您可能需要選取「More
> Timestamp Table」(更多 > 時戳表)
來顯示「Timestamp」(時戳) 選項。

3. 按一下「Options...」(選項...) 以指定
「Source」(來源) 或 「FastFrame Data

Range」(快速圖框資料範圍)；否則
請跳至步驟  4。

4. 選取要儲存該時戳的位置。

5. 輸入該時戳的名稱，然後選取檔案
類型。

6. 按一下「Save」(儲存)。

 儲存和叫出資訊
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複製結果到剪貼簿
使用下列程序，設定要複製到 Microsoft 剪貼簿之影像、波形或量測值的輸出內容和格式。

1. 選取「Edit > Copy Setup...」(編輯 >
複製設定...)。

2. 按一下「Images」(影像)、
「Waveforms」(波形) 或
「Measurements」(測量值) 索引標籤，
然後選取所需選項。

如果要複製影像、波形或是測量值，請使用下列程序：

儲存和叫出資訊  

174  DPO70000SX 系列使用者



1. 選擇您要複製的項目。

2. 選取「Edit > Copy」(編輯 > 複製)，
或是按下 Ctrl + C。

3. 按下 Ctrl + V，便可將該項目貼入
Windows 應用程式。

 儲存和叫出資訊
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列印輸出

1. 若要列印輸出，請按下「Print」(列
印)按鈕，或選取「File > Print」(檔案
> 列印)。如有必要，請在「Page
Setup」(版面設定) 對話方塊中更改
版面配置。

「版面設定」對話方塊依所使用印表機而
有差異。 

2. 按一下「Page Setup...」(版面設
定...) 。

3. 選擇列印參數。
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執行應用軟體

您可以在儀器上免費使用每個應用程式 10 次。這些應用程式會提供特定應用程式的測量解決方案。下面將
介紹一些使用範例。同時也提供其他套件。您的儀器可能無法使用某些應用程式。如需詳細資訊，請聯絡
Tektronix 代理商或造訪我們的網站 www.tektronix.com。 

■ 使用 DJA DPOJET 抖動和眼狀圖分析，進一步準確地量測複雜的時脈、數位和串列資料訊號。DPOJET
Essentials 為所有機型隨附的標準配備。

■ 使用 DJAN-DPOJET 可準確地量測複雜的時脈、數位和串列資料訊號 (需要選項 DJA)。
■ 使用 LT Waveform Limit Testing (波形極限測試)，以比較擷取的波形以及您設定的容差界限。

■ 使用 MOST Essentials 進行 MOST50 和 MOST150 電子相容性和偵錯測試。

■ 使用 PAM4 可執行四位準脈波振幅調變 (PAM4) 裝置和介面的發射器和通道測試。

■ 使用 SDLA64 串列資料連結分析可視化工具可模擬串列資料通道、解除嵌入治具以及新增或移除發射器
等化。

■ 使用 SR-810B 可啟用 8B/10B 訊號的串列觸發和分析 (需要 ST6G)。
■ 使用 SVA AM/FM/PM 音訊訊號分析 (需要選項 SVE) 可分析音訊訊號。

■ 使用 SVP、SVM 和 SVE 頻譜分析應用程式來確認寬頻設計並辨識寬頻頻譜事件。

■ 使用 SVO 進行靈活的 OFDM 分析，需要 SVE。
■ 使用 SVT 進行穩定時間測量 (頻率和相位)，需要 SVE。
■ 使用 SV23 WLAN802.11a/b/g/j/p 量測應用 (需要選項 SVE) 可量測 WLN802.11a/b/g/j/p 訊號。

■ 使用 SV24 WLAN 802.11n 量測應用 (需要選項 SV23) 可量測 WLN802.11n 訊號。

■ 使用 SV25 WLAN 802.11ac 量測應用 (需要選項 SV24) 可量測 WLN802.11ac 訊號。

■ 使用 SV27 SignalVu 藍芽基本 LE TX SIG 量測可量測藍芽訊號

■ 使用 SV28 SignalVu LTE 下行鏈路射頻量測 (需要選項 SVE) 可量測 LTE 下行鏈路射頻訊號

■ 使用 VET 啟用視覺觸發和搜尋。

請依照應用軟體隨附的指示說明進行安裝。 若要執行軟體，請選取「Analyze」(分析)，然後選取應用程式。
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應用範例
本節將介紹本儀器在一般故障排除工作中的使用範例，及其擴充使用方式。

擷取間歇性異常
設計工程師經常面對的一大難題，就是找出間歇性故障的發生原因。如果您知道自己要尋找哪種異常狀況，
您就可以輕鬆地設定示波器進階觸發功能，隔離找出該異常狀況。然而，當您不知道自己要尋找哪���異
常狀況時，找出偶發異常的過程就會顯得十分冗長而耗時。尤其在使用傳統數位儲存示波器只能提供極慢波
形擷取速率時，更是如此。

加入 DPX 技術之數位螢光示波器所特別提供的 FastAcq 快速擷取模式，可讓您在數秒鐘或數分鐘之內找出這
類異常狀況。一般的 DSO 通常要花上好幾個小時、甚至幾天，才能找出此類異常事件。 FastAcq 適用於
TekConnect 通道，而不適用於 ATI 通道。

請使用下列程序來擷取間歇性異常。

1. 將探棒連接到輸入訊號源。

2. 選取「Horiz/Acq > Autoset」(水平/擷
取 > 自動設定)，或按下輔助前面板
上的「Autoset」(自動設定)。

3. 選取「Display > Display Persistence >
Infinite Persistence」(顯示 > 顯示持
續累積 > 無限持續累積)。 在此範
例中，您將要查看時脈訊號。在觀
察訊號 1–2  分鐘之後、以及從其他
位置尋找問題之前，請先移至步驟
 4。

DPO70000SX 系列使用者 179



4. 選取「Horiz/Acq > Fast Acquisitionst」
(水平/擷取 > 快速擷取)，或按下輔助
前面板上的「FastAcq」。

5. 尋找出現在訊號中的突波、暫態訊
號或其他隨機異常。此例中，
FastAcq 僅在執行幾秒鐘之後就找
到 300  ns 的正突波。

6. 如果要觸發在步驟  5 找到的突波，
請選取「Glitch Setup...」(突波設
定...)。

7. 選取適當的極性。

8. 按一下「Level」(位準)，再依照您在
步驟  5 找到的突波設定位準。

9. 按一下「Width」(寬度)，再依照您
在步驟  5 找到的突波設定寬度。

如果您要讓觸發系統將高頻率脈衝
視為單一脈波，請選取「Envelope」
(包封)。 

應用範例  

180  DPO70000SX 系列使用者



10. 按一下 E-mail on Trigger (依觸發傳送
電子郵件) 「On」(開啟) 。請參閱 設
定依事件發出電子郵件在頁面上
102。

11. 若要在單一突波發生時觸發，請選
取「Horiz/Acq > Run/Stop...」(水平/擷
取 > 執行/停止...)，然後按一下
「Single Sequence」(單次序列)，或按
下輔助前面板上的「Single」(單一)。

 應用範例
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使用延伸式桌面和 OpenChoice 架構有效進行記錄

工程師經常需要記錄自己的實驗工作，以供日後參考。您可能不想要將螢幕參數一次顯示和波形資料先儲存
到 CD 或 USB 記憶體裝置，以後再產生報告；這時您可以嘗試使用 OpenChoice 架構，即時記錄您的工作。

若要讓儀器成為設計和記錄程序中心，請使用下列程序。

注意。 在 64 位元系統上，您將需要 64 位元相容裝置驅動程式和應用程式軟體。

1. 將 Microsoft Word 或 Excel 載入本儀
器。

2. 連接第二台監視器。請參閱 新增
第二台監視器在頁面上 30。

3. 開啟 Microsoft Word，再將 Word 視窗
拖曳到延伸的桌面。

4. 按一下 TekScope 便可恢復到儀器
應用程式。

5. 選取「Edit > Select for Copy > Full
Screen (bitmap)」(編輯 > 選取以複製
> 全螢幕 (點陣圖))。

應用範例  
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6. 按下 Ctrl+C。

7. 在您要放置螢幕參數一次顯示的
Word 文件位置中按一下滑鼠，再按
下 Ctrl+V。

快速秘訣

■ 本儀器隨附多種專門設計的 OpenChoice 軟體工具，可提供最大效能以及與其餘設計環境的連接性。

 應用範例
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在匯流排上觸發

您可以使用您的儀器觸發 I2C、SPI、RS-232/422/485/UART、MIPI DSI-1、MIPI CSI-2、8B/10B、USB、CAN 和平行
匯流排。該儀器可以顯示實體層 (如類比波形) 和通訊協定層級資訊 (就像數位和符號波形)。

注意。 某些觸發類型不適用於某些儀器。

如需詳細的匯流排觸發程序，請使用下列程序： 請參閱在並列匯流排上觸發在頁面上 94 或在串列匯流排上
觸發在頁面上 96。

若要設定匯流排觸發：

1. 選取「Vertical > Bus Setup」(垂直 >
匯流排設定)。

2. 選取匯流排類型。

3. 如果您已選取「Serial」(串列) 匯流
排類型，請選取串列匯流排類型。

4. 指定元件。

5. 選取「Trig > Bus Setup」(觸發 > 匯流
排設定)。

應用範例  
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6. 選取您設定的匯流排。

7. 選取 Trigger On 以選擇想要的觸發
功能。

8. 根據您選擇的 Trigger On 選項，您可
能還需要選擇其他選項。

 應用範例
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規格
本章包含儀器的規格。所有規格均有保證，除非註明為「一般」。一般規格僅供您方便參考，並不提供保證。
驗證效能時會檢查以  符號標示的規格。

除非另有註明，否則所有規格皆適用於所有機型。若要符合規格，首先必須符合兩個條件：

■ 儀器必須在指定的作業溫度範圍內，持續操作 20 分鐘。

■ 您必須執行訊號路徑補償 (SPC) 作業。如果作業溫度變化超過 10 °C (18 °F)，則必須再次執行 SPC 作業。

垂直系統類比通道

類比頻寬 具有 TekConnect 通道上 TCA292D 轉接器或直接進入 ATI 通道的頻寬。

針對所有保證的頻寬規格假定周圍溫度為 18ºC 到 28ºC。

下列全幅 (FS) 步階增益設定保證加強型頻寬：

TekConnect 通道：62.5 mV、100 mV、200 mV、500 mV、1 V、2 V 和 5 V。

ATI 通道：從 100 mV 到 300 mV 的所有設定。
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儀器 通道 BW 設定 頻寬  1 取樣率

DPO77002SX ATI，1 個通道 70 GHz BWE >67 GHz
70 GHz (一般)

200 GS  2

DPO77002SX
DPO73304SX

TekConnect，2 個
通道

不含 BWE >33 GHz 全部

DPO77002SX
DPO73304SX

TekConnect，2 個
通道

33 GHz BWE >33 GHz 100 GS/s

DPO77002SX
DPO73304SX

TekConnect，2 個
通道
TekConnect，4 個
通道

23 GHz BWE >23 GHz 50 GS/s

DPO75902SX ATI，1 個通道 59 GHz BWE >59 GHz 200 GS
DPO75902SX
DPO75002SX

ATI，1 個通道 50 GHz BWE >50 GHz 200 GS

DPO75902SX TekConnect 不含 BWE >33 GHz 全部

DPO75002SX TekConnect 不含 BWE >25 GHz 全部

DPO75002SX TekConnect 25 GHz BWE >25 GHz 100 GS/s
DPO75002SX TekConnect 23 GHz BWE >23 GHz 50 GS/s
DPO72304SX TekConnect 不含 BWE >23 GHz 50 GS/s、100 GS/

s
DPO72304SX TekConnect 23 GHz BWE >23 GHz 50 GS/s、100 GS/

s
DPO71604SX TekConnect 16 GHz BWE >16 GHz 50 GS/s、100 GS/

s
DPO71304SX TekConnect 13 GHz BWE >13 GHz 50 GS/s、100 GS/

s

TekConnect 通道 一般溫度降低

頻率 TC，(dB/°C) 5 °C 45 °C
直流 - 5 GHz 0.005 dB/°C 0.07 -0.09 
10 GHz 0.010 dB/°C 0.13 -0.17 
15 GHz 0.025 dB/°C 0.33 -0.43 
20 GHz 0.045 dB/°C 0.59 -0.77 
23 GHz 0.10 dB/°C 1.30 -1.70 
25 GHz 0.10 dB/°C 1.30 -1.70 
30 GHz 0.115 dB/°C 1.50 -1.96 
33 GHz 0.160 dB/°C 2.08 -2.72 

1 若要判定超出溫度限制時效能的降低量，請使用一般溫度變化表格。
2 200 GS/s 是唯一可在所有 ATI 通道上使用的取樣率。

規格  垂直系統類比通道（待續）
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ATI 通道 一般溫度降低

頻率 TC，(dB/°C)
直流 - 10 GHz 0.002 dB/°C
15 GHz 0.005 dB/°C
20 GHz 0.01 dB/°C
30 GHz 0.05 dB/°C
40 GHz 0.07 dB/°C
50 GHz 0.05 dB/°C
60 GHz 0.05 dB/°C
67 GHz 0.05 dB/°C

直流增益精確度 ± 2%

直流電壓量測精準度、取樣、平
均值，以及高解析度模式

全幅設定 直流量測精確度

62.5 mVFS – 6 VFS
 3 ±(增益準確度 x | 垂直值 - 淨偏移 |) + 偏移

準確度 + 0.4% x FS
電壓差值讀數

62.5 mVFS – 6 VFS ±(增益準確度 x | 電壓差值量測 | + 0.008 x
FS

偏移精確度

全幅電壓範圍 偏移精確度

62.5 mVFS 到 1.2 VFS (TekConnect 通道) ±(0.4% | 淨偏移 | + 0.2% | 淨偏移 – Vterm 設
定 | + 2.5 mV + 1% FS)

>1.2 VFS 到 6 VFS (TekConnect 通道) ±(0.6% | 淨偏移 | + 13.4 mV + 1% FS)
100 mVFS 到 300 mVFS (ATI 通道) ±(0.35% | 淨偏移 | + 2 mV + 1% FS)

最大輸入電壓

TekConnect 通道： ≤1.2 VFS 設定：

±1.5 V 相對於終端偏壓 (最大 30 mA)

±5 V 絕對最大輸入電壓

>1.2 VFS 設定：

±8.0 V。受限於最大溫度時的最大 Vterm 電流和衰減器額定功率。

ATI 通道： ±0.75 Vpk

輔助通道： ±5.0 Vpk

3 若為 ATI 通道，全幅設定範圍為 100 mVFS 到 300 mVFS。

垂直系統類比通道（待續） 規格
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雜訊 (一般)
增益設定，全幅，
BWE 關閉

DPO77002SX、
DPO75902SX、
DPO75002SX、
DPO73304SX
TekConnect 通道

DPO72304SX DPO71604SX DPO71304SX

62.5 mV 0.88 mV 0.79 mV 0.74 mV 0.70 mV
100  mV 0.96 mV 0.86 mV 0.82 mV 0.79 mV
200 mV 1.53 mV 1.41 mV 1.30 mV 1.32 mV
500 mV 4.19 mV 3.14 mV 3.00 mV 3.05 mV
1 V 8.30 mV 6.10 mV 5.90 mV 6.08 mV
2.0 V 18.84 mV 14.19 mV 13.07 mV 13.09 mV
3.0 V 24.64 mV 19.09 mV 18.37 mV 18.37 mV
4.0 V 37.91 mV 26.01 mV 25.35 mV 25.55 mV
5.0 V 43.36 mV 31.84 mV 30.52 mV 30.62 mV
6.0 V 47.93 mV 36.97 mV 25.91 mV 36.33 mV

增益設
定，全幅，
BWE 開
啟

DPO77002SX、
DPO75902SX、
DPO75002SX、
DPO73304SX
TekConnect 通道

DPO72304SX DPO71604SX DPO71304SX

100 GS/s 50 GS/s 100 GS/s 50 GS/s 100 GS/s 50 GS/s 100 GS/s 50 GS/s
62.5 mV 0.84 mV 0.84 mV 0.75 mV 0.72 mV 0.78 mV 0.77 mV 0.71 mV 0.69 mV
100  mV 0.93 mV 0.93 mV 0.78 mV 0.82 mV 0.77 mV 0.81 mV 0.68 mV 0.73 mV
150 mV 1.31 mV 1.29 mV 1.08 mV 1.19 mV 0.94 mV 1.01 mV 0.88 mV 0.95 mV
200 mV 1.52 mV 1.60 mV 1.14 mV 1.43 mV 1.04 mV 1.18 mV 0.99 mV 1.14 mV
300 mV 2.49 mV 2.52 mV 2.10 mV 2.29 mV 1.58 mV 1.80 mV 1.57 mV 1.79 mV
400 mV 2.92 mV 3.12 mV 2.58 mV 2.29 mV 1.82 mV 2.20 mV 1.82 mV 2.21 mV
500 mV 3.55 mV 3.80 mV 2.65 mV 3.38 mV 2.17 mV 2.66 mV 2.2 mV 2.69 mV
600 mV 4.86 mV 4.86 mV 4.14 mV 4.42 mV 3.02 mV 3.46 mV 3.01 mV 3.43 mV
700 mV 5.25 mV 5.39 mV 4.64 mV 4.96 mV 3.28 mV 3.85 mV 3.25 mV 3.80 mV
800 mV 5.76 mV 6.08 mV 5.08 mV 5.52 mV 3.61 mV 4.37 mV 3.56 mV 4.29 mV
900 mV 6.30 mV 6.66 mV 5.63 mV 6.13 mV 3.96 mV 4.81 mV 3.89 mV 4.69 mV
1 V 6.80 mV 7.30 mV 5.09 mV 6.54 mV 4.29 mV 5.29 mV 4.2 mV 5.14 mV
1.1 V 8.69 mV 9.02 mV 7.79 mV 8.20 mV 5.48 mV 6.94 mV 5.45 mV 6.74 mV
1.2 V 9.12 mV 9.60 mV 8.28 mV 8.72 mV 5.75 mV 7.50 mV 5.73 mV 7.28 mV
2.0 V 15.40 mV 14.53 mV 11.66 mV 14.65 mV 9.70 mV 12.23 mV 9.88 mV 11.87 mV
3.0 V 19.91 mV 19.82 mV 15.31 mV 20.51 mV 12.98 mV 16.55 mV 13.19 mV 16.81 mV
4.0 V 28.83 mV 27.85 mV 21.61 mV 27.84 mV 19.56 mV 23.17 mV 18.64 mV 21.32 mV
5.0 V 34.32 mV 32.80 mV 25.69 mV 34.07 mV 22.82 mV 27.79 mV 21.82 mV 26.03 mV
6.0 V 39.82 mV 38.96 mV 29.65 mV 39.18 mV 26.65 mV 32.42 mV 25.74 mV 31.45 mV

規格  垂直系統類比通道（待續）
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增益設定，全幅，ATI 通道 DPO77002SX
DPO75902SX、DPO75002SX

100 mV 1.19 mV
200 mV 1.76 mV
250 mV 2.10 mV
300 mV 2.49 mV

輸入電阻

≤1.2 VFS 設定 50 Ω ±3%，18 至 28 ºC (64 至 82 ºF)

50 Ω ±4%，5 至 45 ºC (45 至 113 ºF)
>1.2 VFS 設定 50 Ω ±4.4%，5 至 45 ºC (45 至 113 ºF)
ATI 通道 50 Ω ±3%，從 18 °C 至 28 °C

50 Ω ±4%，從 5 °C 至 45 °C

水平和擷取系統

長期取樣率精確度 ± 0.1 ppm 初始精準度。第一年老化 < 0.8 ppm，第一年後每年 <0.3 ppm。只在使用內部
參考值時才適用。

垂直系統類比通道（待續） 規格
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差值時間測量精確度 以下列出針對指定之儀器設定和輸入訊號計算最大差值時間測量精確度 (DTAmax)
的公式 (假設為奈奎斯特 (Nyquist) 頻率以上的無意義訊號內容，以及因為假像、過載
復原和過載內插所造成的無意義錯誤)：

Ntyp = 一般輸入參考雜訊規格 (伏特 rms)

FN = 1.3 適用於儀器頻寬 ≤9 GHz；1.5 適用於儀器頻寬 ≥10 GHz

SR1 = 量測中第 1 點周圍的扭轉率 (第 1 個邊緣)

SR2 = 量測中第 2 點周圍的扭轉率 (第 2 個邊緣)

FI = 1.2 × 10–2 

tr1 = 第一個邊緣的上升時間

tr2 = 第二個邊緣的上升時間

tj = 取樣抖動/頻距不確定性 (在 10 μs 時間內約 100 fs)

根據 500 個波形之統計累計值的峰值對峰值。

DTAMAXpk-pk
(seconds)

=10 × (Ntyp × FN)2 ( 1
SR1

)2
+ ( 1

SR2
)2

+ FI
2 × (tr12 + tr2

2 ) + (2 × tj
2)

無論資料收集時間長短，皆保證 RMS。

DTAMAXrms
(seconds)

= (Ntyp × FN)2 ( 1
SR1

)2
+ ( 1

SR2
)2

+ FI
2 × (tr12 + tr2

2 ) + (2 × tj
2)

開根號下方的時期為穩定，且由時間間隔錯誤 (TIE) 所造成。

觸發規格

規格  水平和擷取系統（待續）
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邊緣觸發靈敏度直流耦合 (一般) 所有來源，正向或負向邊緣。

觸發源 靈敏度

A-Event 觸發 ≤ 5%FS，從直流至 50 MHz
≤ 7.5%FS 於 5 GHz
≤ 10%FS 於 10 GHz
≤ 15%FS 於 15 GHz
≤ 35%FS 於 20 GHz
≤ 50%FS 於 25 GHz

B-Event 觸發 ≤ 5%FS，從直流至 50 MHz
≤ 7.5%FS 於 5 GHz
≤ 10%FS 於 10 GHz
≤ 15%FS 於 15 GHz
≤ 35%FS 於 20GHz
≤ 50%FS 於 25 GHz

輔助輸入 100 mVpp，從直流到 1 GHz
175 mVpp 於 4 GHz
225 mVpp 於 8 GHz
450 mVpp 於 10 GHz
800 mVpp 於 11 GHz

時間限定的觸發計時器精確度 對於突波、寬度、時間限定的矮波、轉換，或時間視窗及逾時觸發 (40 ps 到 1.0 ns 一
般)：
時間範圍 精確度

40 ps 到 ≤50 ns ±(3% 設定 + 15 ps)
40 ps 到 ≤1 ns ±(3% 設定 + 15 ps) (一般)
1 ns 到 ≤50 ns ±(3% 設定 + 15 ps)
500 ns 到 1 s ±(150 ppm x 設定 + 500 ps)

設定/保持違反及時間限定的樣式 (40 ps 到 1.0 ns 一般)：

300 ps 到 1.01 μs ±(5% 設定 + 200 ps)
1.02 μs 到 1 s ±(TB  1精確度 + 20 ns)

觸發抖動直流耦合 A 邊直流耦
合緣 (一般)

10 fs 使用加強型觸發位置。

1 ps RMS (針對低頻)、快速上升時間訊號、A 邊緣、延滯時間 = 30 μs

1 TB 精確度是時基精確度，以設定的百分比表示

觸發規格（待續） 規格
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輸入/輸出埠規格

快速邊緣輸出步階振幅和偏移 1200 mV 差動電壓到 100 Ω 負載，搭配 300 mV 一般模式。

快速邊緣輸出步階頻率 1 kHz ± 20%

輔助輸出邏輯位準 Vout 高 Vout 低 (真)
≥2.5 V 到 1 MΩ 負載，
≥ 1.0 V 到 50 Ω 負載，接地

≤0.7 V 到 1 MΩ 負載
≤0.25 到 50 Ω 負載，接地

B、C、D 12.5 GHz 時脈輸出
(UltraSync)

1.3 Vp-p (6 dBm)

時基參考輸出頻率 10 MHz 和 12.5 GHz 輸出

內部參考輸出電壓 (一般)
10 MHz Vout pk-pk > 800 mV 峰值對峰值到 50 Ω

> 1.6 V 峰值對峰值到 1 MΩ (內部交流耦合)。

電源規格

功率消耗

<980 W，單一儀器，最大

≤780 W，單一單元 (一般)

來源電壓與頻率 100 V 至 240 VRMS，50/60 Hz

115 V ± 10%，400 Hz

CAT II

規格  
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機械規格

重量

DPO70000SX 機型 19 公斤 (42 磅) 僅示波器重量

尺寸

DPO70000SX 機型 157 公釐 (6.0 英吋) 高度
452 公釐 (17.8 英吋) 寬度
553 公釐 (21.8 英吋) 深度

DPO70000SX 機型，框架安裝
配置

177 公釐 (7.0 英吋) 高度
440 公釐 (19.75 英吋) 寬度
523 公釐 (20.6 英吋) 深度 (從機架固定耳至儀器背面)

冷卻

所需空間 風扇式空氣環流 (不含空氣濾網)
頂部 0 公釐 (0 英吋)
底部 支腳站立，支架朝下時至少 6.35 公釐

(0.25 英吋) 或 0 公釐 (0 英吋)
左側 76 公釐 (3 英吋)
右側 76 公釐 (3 英吋)
背面 距離後支腳 0 公釐 (0 英吋)

建構材質 底盤部分材質是鋁合金，前面板材質是塑膠薄板，電路板材質是玻璃薄板

環境規格

溫度

操作中 +5 °C 到 +45 °C (41 °F 到 +113 °F)，最大梯度為每小時 11 °C，非冷凝溫度，海拔高度
超過 1,500 公尺 (4921.25 英呎) 時每 300 公尺 (984.25 英呎) 降低 1 °C

非操作中 -20 °C 到 +60 °C (-4 °F 到 +140 °F)，最大梯度為 20 °C/小時

濕度

操作中 8% 到 80% 相對溼度，最高溫 +32 °C (+90 °F)

5% 到 45% 相對溼度，溫度超過 +32 °C (+90 °F)、最高溫達 +45 °C (+113 °F)，非冷凝溫
度，而且必須符合最高濕球溫度 +29.4 °C (+85 °F) 範圍 (在 +45 °C (+113 °F) 相對溼度會
衰減到 32%)

非操作中 5% 到 95% 相對溼度，最高溫達 +30 °C (+86 °F)，

5% 到 45% 相對溼度，溫度超過 +30 °C (+86 °F)、最高溫達 +60 °C (+140 °F)，非冷凝溫
度，而且必須符合最高濕球溫度 +29.4 °C (+85 °F) 範圍 (在 +60 °C (+140 °F) 相對溼度會
衰減到 11%)

 規格
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海拔高度

操作中 最高 3,000 公尺 (9,843 英呎)，海拔高度超過 1,500 公尺 (4921.25 英呎) 時，每升高
300 公尺 (984.25 英呎)，最大操作溫度會降低 1 ℃

非操作中 最高 12,000 公尺 (39,370 英呎)

規格  環境規格（待續）
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附錄 A：維修

維修
本節包含執行定期儀器維修所需的資訊。 

小心。 請勿移除蓋住儀器的外殼。 移除該外殼會損壞儀器。 損壞的儀器無法符合 EMC 需求。

請勿移除蓋住儀器的外殼。 如果需要維修儀器，您必須將該儀器退回 Tektronix。

清潔

使用這些程序來清潔您的儀器。 如果需要其他清潔，請將儀器交由合格的服務人員處理。

清潔外部
使用不沾絨質的乾布或軟毛刷，清潔底盤外面。如果還有灰塵，可用沾上濃度 75% 的異丙醇溶劑的布或紗
布。控制項及接頭周圍的狹窄處，可用紗布清潔。 請勿使用有磨蝕性的清潔劑清潔底盤。

使用濕的清潔布來清潔 On/Standby (開啟/待機) 開關。不可以直接弄濕開關。

小心。 不當的清潔劑、方法或施力會損傷儀器。請勿使用可能損傷示波器塑膠部分的化學清潔劑。只可用去
離子水來清潔前面板按鈕。使用濃度 75% 的異丙醇溶劑當做清潔劑，並以去離子水清洗。若要使用其他類型
的清潔劑，請先洽詢 Tektronix 服務中心或業務代表。

清潔外部時為防止弄濕儀器內部，只能以適量液體沾濕布或塗抺器。

調整間隔
儀器內部的電壓和時序參考隨時間變化時非常穩定，且不需要進行日常調整。 

如果儀器無法通過《規格和效能驗證》手冊中的效能測試，則需要進行調整。 此手冊隨附於您的產品，您也
可以從 www.tektronix.com/manuals，透過搜尋您的產品找到該手冊。

如果定期校準是您的其中一個需求，一般而言每操作 2000 小時可驗證效能並進行調整 (僅於需要時)，不常使
用的儀器則為一年一次。
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調整
只有 Tektronix 服務中心才能執行調整。 請參閱本手冊書名頁之後的「聯絡 Tektronix」，以取得聯絡 Tektronix 服
務支援的資訊。 

平板顯示器清潔

顯示器使用軟性的塑膠製成，清潔時請務必謹慎。 

小心。

不適當的清潔劑或方法可能會損壞平板顯示器。

請避免使用會磨蝕的或市面上的玻璃清潔劑來清潔顯示器表面。

請避免將液體直接噴灑於顯示器表面。 請避免太大力刷洗顯示器。

請使用無塵室的擦拭布 (例如 Wypall Medium Duty Wipes，#05701，可從 Kimberly-Clark Corporation 取得) 溫和地擦拭
平板顯示器表面。

如果顯示器很髒，請使用蒸餾水或是濃度 75% 的異丙醇溶劑沾濕擦拭布，再溫和地擦拭顯示器表面。請避免
太大力擦拭，否則可能損壞塑膠顯示器表面。

小心。 清潔外部時為防止弄濕儀器內部，只能以適量液體沾濕布或塗抺器。

將儀器退回維修
重新包裝儀器以進行運送時，請使用原本的包裝。 如果無法使用包裝或包裝不適合該儀器使用，請聯絡當地
Tektronix 業務代表以取得新包裝。 

請使用工業用釘書機或捆紮帶來密封運送紙箱。

將儀器退回維修之前，請聯絡服務中心以取得 RMA (退貨授權) 編號，以及任何可能需要的退貨或運送資訊。

將儀器運送至 Tektronix 服務中心時，請附上下列資訊：

■ RMA 編號。

■ 擁有者地址。

■ 聯絡人姓名和電話號碼。

■ 儀器類型和序號。

■ 退貨原因。

■ 所需維修的完整說明。

請在運送紙箱上的兩處明顯位置註明 Tektronix 服務中心地址和和回郵地址。

附錄 A：維修  
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TekScope 還原報告公用程式
TekScope 還原報告公用程式可收集記錄及其他包含有助於讓 Tektronix 診斷 TekScope 錯誤之資料的檔案，並在
桌面上建立 .zip 檔案以保留所有收集的資料。 您可以輕鬆地將此壓縮檔案從桌面複製到抽取式隨身碟，您也
可以透過電子郵件附件的形式，將檔案傳送至 Tektronix。 

如果您聯絡 Tektronix 尋求診斷 TekScope 錯誤的協助，服務人員可能會要求您執行此公用程式並將 .zip 檔案提
供給 Tektronix。

注意。 公用程式會清除在執行公用程式之使用者帳戶下所建立的暫存資料。 這可讓 TekScope 在下次啟動時
產生全新的檔案。

尋找公用程式

公用程式連結位於「Start\All Programs\Tektronix\TekScope\」(開始\所有程式\Tektronix\TekScope\) 目錄。

執行公用程式

按一下公用程式連結。

如果呼叫公用程式時正在執行 TekScope，公用程式會警告使用者必須停止 TekScope。 此為讓公用程式存取某
些檔案的必要步驟。 公用程式會在查詢儀器序號後自動停止 TekScope。 按一下「Yes」(是) 可讓公用程式停止
TekScope 並收集報告檔案。

如果並未執行 TekScope，還原公用程式仍會執行並收集報告檔案。

 附錄 A：維修
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尋找報告

公用程式執行完成時，壓縮的報告會位於桌面。

1. 如果呼叫公用程式時正在執行 TekScope，在桌面上建立之 .zip 報告檔案的名稱會包含儀器類型和序號。
例如：

TekScope_Recovery_Report_DPO77002SX_123456789.zip。 

2. 但如果呼叫公用程式時並未執行 TekScope，.zip 報告檔案的名稱不會包含序號。例如：

TekScope_Recovery_Report_DPO77002SX.zip

報告中包含的資料

公用程式執行完成時，如果這些檔案存在於儀器中，報告會包含這些特定檔案的複本：

C:\Windows\Sysnative\winevt\logs\Application.evtx

C:\programdata\tektronix\ISD.XML

C:\programdata\Tektronix\TekScope\Calibration\console.log

C:\programdata\Tektronix\TekScope\Calibration\console.logOld

C:\programdata\Tektronix\TekScope\Calibration\calSPCConst.dat

 C:\programdata\Tektronix\TekScope\Calibration\caldiag.log

C:\programdata\Tektronix\TekScope\Calibration\caldiag.logOld

C:\programdata\Tektronix\TekScope\Calibration\error.log

公用程式執行完成時，壓縮的報告檔案也會包含在下列目錄中找到的所有檔案複本：

C:\programdata\Tektronix\TekScope\Internal\*.* 

C:\programdata\Tektronix\TekScope\Calibration\ CalDramDump\*.*

C:\programdata\Tektronix\TekScope\Calibration\ CalDramDumpFact\*.* 

公用程式刪除的資料

執行此公用程式會刪除下列檔案：

C:\users\&lt;目前使用者&gt;\AppData\LocalLow\Tektronix\ tekScope\Internal\*.*

因為 TekScope 發生問題，某些檔案可能已損毀。 刪除這些檔案可讓 TekScope 在下次啟動時重新產生檔案。
刪除這些檔案可以解決問題。

公用程式記錄檔

您可以在下列目錄中查看復原報告公用程式所執行操作的記錄檔：

C:\Temp\TekScopeRecoveryReportUtility_log.txt

附錄 A：維修  
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可更換零件
本節將介紹本儀器的抽換式零件資訊。請使用適當章節中的清單，找到和訂購本產品的替換零件。

標準配件

這些產品的標準配件列於您的使用者手冊中。您可以從 www.tektronix.com/manuals 取得使用者手冊。

可更換零件

索引號碼 Tektronix 料號 有效序號 折扣序號 數量 名稱與說明

1 348-2037-00 4 支腳，背面，角落，安全控制

2 211-1481-00 4 螺絲，機器，10-32X.
500 PANHEAD T25，包含 BLUE
NYLOK PATCH

3 348-1948-00 2 支腳，穩定性，NYLON W/30%
GLASS FILL，安全控制

4 348-1950-00 2 支腳組件，翻轉

5 211-1459-00 2 螺絲，機器，8-32X.312 PANHEAD
T20，包含 BLUE NYLOK PATCH

6 348-1947-00 2 保護墊，接腳；SANTOPRENE，
(4) BLACK 101-80 

7 367-0528-00 1 提把，攜帶 (氣體輔助和射出成
型)，安全控制

8 407-4887-00 1 支架，提把座，安全控制

9 211-1265-00 2 螺絲，機器，8-32 X 1.000L
PNH，黑鐵氧化物，T20，
NYLOK，鋼

10 131-9650-00 2 接頭；SMA 50 OHM，具有傳輸
鏈的終端

零件訂購資訊

可透過當地的 Tektronix 辦事處或代理商，取得更換零件。 

有時我們會改變 Tektronix 產品，以配合改良的可用零件，讓您獲得最大的利益。因此，您在訂購零件時，必
須在訂單中包含下列資訊：

■ 零件編號

■ 儀器類型或型號

■ 儀器序號

■ 儀器更改號碼 (若查詢得到)

若您訂購的零件已經被不同的或改良的零件所替代，您當地的 Tektronix 區辦室處或代理商會與您聯絡，告知
您零件號碼的任何變更。
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附錄 B：版本發行

取得最新的進階分析應用程式和版本發行
和儀器一同訂購的選購應用程式最新版本可能沒有安裝在您的儀器上。下列下載位置是取得最新軟體版本
最快速且最簡單的方法。

若要下載最新的軟體版本，請前往 Tektronix 網站 (www.tektronix.com) 的首頁，並找出該頁面上的「下載」區段。
請在「ENTER MODEL NUMBER」(輸入型號) 文字方塊中，輸入應用程式名稱，並在「Select Download Type」(選
取下載類型) 下拉功能表中選取「Software」(軟體)。 

注意。 網頁上提供的發行通知檔案可能比可下載執行檔案中的 readme.txt 檔案，包含更多最新的資訊。

若要定義搜尋準則，請使用「ENTER MODEL NUMBER」(輸入型號) 文字方塊中的應用程式標題。例如，使用
關鍵字「DPOJET」搜尋並下載最新版的 DPOJET。

如果您一同購買儀器和應用程式，您的 Tektronix 授權金鑰可讓您使用應用程式。

如果您要升級，請遵照 Readme.txt 檔案中關於如何安裝新的 Tektronix 授權金鑰的指示，來啟用應用程式。
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儀器堆疊, 10

入
內插法, 57
全螢幕方格圖樣式,

八
其他量測, 131

刀
分析波形, 129
分段記憶體, 74
前面板

接頭, 34
前置觸發, 79, 80

力
加強 DSP 頻寬, 64
加強型有效位元數, 58
加強型頻寬, 64
功能表, 40

勹
包封擷取模式, 57

匚
匯流排

配置, 73
設定串列匯流排, 70
設定並列匯流排, 71
設定匯流排, 68

十
十字線方格圖樣式,

又
取樣過程

已定義, 56
取樣擷取模式, 57

口
可更換零件, 201
可變持續累積, 106
向量

波形顯示方式,
單次序列, 60
單色綠色調色盤, 112

囗
圖框方格圖樣式,
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土
在模式間切換, 20
垂直位置和自動設定, 49
垂直設定控制視窗

M Chx 索引標籤, 88
增亮樣值

波形顯示方式,

夕
外部時脈輸入, 35
外部監視器, 35
多塊縮放區域, 116
多儀器配置

不提供的功能, 22
在模式間切換, 20
快速重新啟動, 21
時間同步模式, 19, 20
啟動之前, 13
連接順序, 15
開啟電源, 16
儀器堆疊, 10

女
如何

搜尋整個波形並新增標記, 119

宀
安裝, 1
寬度觸發

已定義, 83

寸
將儀器退回維修, 198

山
峰值檢測擷取模式, 57

干
平均擷取模式, 58

平板顯示器清潔, 198

广
底盤接地線

前面板接頭, 34

廴
延伸式桌面, 30, 182
延遲觸發, 80, 85

弓
強制關機, 10
強制觸發, 79

彳
後面板

接頭, 35
後置觸發, 79, 80
復原

Windows 作業系統, 31
產品軟體, 31

復原上一次自動設定, 49
復原自動設定, 49

心
快速重新啟動, 21
快速擷取, 63, 179
快速邊緣, 34
應用軟體, 177
應用範例, 179

手
按鈕

設定/清除標記, 120
振幅量測, 130
捲動模式, 67
捲動模式互動, 67
探棒

校準, 34, 50
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偏移校正, 50
補償, 50

接頭
後面板, 33, 35

接頭保護, 6
接頭清潔, 5
搜尋, 119
操作需求, 2
擷取

取樣, 56
輸入通道和數位器, 55

擷取模式
變更, 59

攴
數學運算

編輯器, 141

方
方格圖方格圖樣式,

日
時脈輸出

後面板, 35
時間同步模式, 19, 20
時間量測, 131
時戳

定義, 74

曰
最大輸入電壓, 4

月
有效位元數

加強型, 58

木
校準, 26, 43
極限測試, 154
標記, 119
標準配件, 1

標籤
匯流排, 68

模式觸發
已定義, 83

欠
次序觸發

Arm-on-A 然後 Trigger-on-B, 87

水
水平位置

和數學運算波形, 143
水平刻度

和數學運算波形, 143
水平模式

選項, 61
波形

分析, 129
使用者標記, 119
搜尋和標記, 119

波形資料庫擷取模式, 58
清潔, 197
清潔外部, 197
游標量測, 137
溫階調色盤, 112

火
無限持續累積, 106

犬
狀態訊息

建議的校準, 26, 43
狀態觸發

已定義, 83

生
產品軟體安裝, 31

矢
矮波觸發
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已定義, 83

穴
突波

擷取, 57, 63, 179
觸發時機, 80

突波觸發
已定義, 83

竹
範例, 179

糸
終端電壓, 66
維修

TekScope 還原報告公用程式, 199
可更換零件, 201
平板顯示器清潔, 198
將儀器退回維修, 198
清潔, 197
清潔外部, 197
零件訂購, 201
調整, 198
調整間隔, 197

線上說明, 39
線性內插法, 108
縮放, 115
縮放方格圖尺寸, 115

耒
耦合

觸發, 80

自
自動設定, 49
自動觸發模式, 79

衣
複製, 174

見
規格

電源, 194
機械, 195
觸發系統, 193

視訊埠, 35
視窗觸發

已定義, 83
視覺觸發, 98

角
觸發

B 事件掃描, 91
pretrigger, 80
串列匯流排, 96
位準, 80
並列匯流排, 94
依觸發傳送電子郵件, 101
延滯, 79
狀態, 84
前置觸發, 79
後置觸發, 79, 80
強制, 79
斜率, 80
視覺觸發, 98
耦合, 80
讀數, 84

觸發位置, 90
觸發事件

定義, 79

言
訊框方格圖樣式,
訊號路徑補償 (SPC), 26, 43
設定/清除標記按鈕, 120
設定∕保持觸發

已定義, 83
說明, 39
說明文件, xvi
調整, 198
調整間隔, 197
讀數

觸發, 84

車

軟體
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版本, 203
最新版本, 203
選項, 177

軟體安裝, 31
輔助前面板, 23
輔助輸入, 34
輸入訊號, 46
輸入接頭保護, 6
輸入檢查, 23, 41
轉態觸發

已定義, 83

辵
通訊

量測, 132
逾時觸發

已定義, 83
遮罩

自動設定, 153
邊際容差, 152

遮罩測試, 151
選擇衰減器, 5
邊緣觸發

已定義, 83

酉
配件, 1

里
量測

已定義, 130
自訂, 133
游標, 137
精確度, 50

金
錯誤偵測器, 147

長
長條圖設定, 139
長條圖量測, 132

門
開始擷取, 60
開啟電源

開啟多儀器電源, 16
閘道寬度和解析度頻寬, 146
關閉電源, 10
關機

強制, 10

阜
隨機雜訊, 58

隹
雙螢幕, 30

雨
電源供應器需求, 3
電源按鈕

指示器, 9
無燈號, 9
黃燈, 9
綠燈, 9

電源線輸入, 35
零件訂購, 201
需求

電源供應器, 3
操作, 2

頁
頻寬限制, 65
頻譜算術運算式

進階, 144
類比輸入

前面板接頭, 34
顯示內容, 25
顯示圖, 36

高
高解析度擷取模式, 57
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黑
點

波形記錄點顯示方式,
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